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WHAT IS PORTFOLIO & RISK
ANALYTICS (PORT)?
PORT empowers you to gain deeper insight into your portfolios by providing the tools to understand the structure of your
portfolios, analyze your positions and active bets, and explain the drivers of historical performance and potential sources of
future risk. PORT provides a streamlined workflow that includes intraday performance monitoring, fundamental characteristics,
historical performance attribution, ex-ante tracking error, scenario analysis, and portfolio optimization.

Note:  For information on PORT's asset coverage, see Supported Asset Types.

CONTROL AREA

PORT is organized into a series of tabs which provide you with expansive portfolio analytical options based on different areas
of portfolio analysis and risk management. You can use the control area at the top of the screen to navigate between tabs as
well as load portfolio, benchmark, and breakdown attributes that remain constant across all tabs. On each tab you can also
deepen your analysis by clicking the available sub-tabs and updating tab-specific analytical tools.
 

 

• Toolbar: Toolbar options allow you to perform deep portfolio analysis (e.g., what-if analysis, portfolio optimization) as well
as customize your portfolio management workflow (e.g., exporting data, generating reports, customizing your views). For
more information, see Trade Simulation and Portfolio Optimization.

• Tabs: You can click the tabs to access high-level portfolio analysis and risk management options, such as value-at-risk or
performance analysis. For more information, see the topics corresponding to tab names, such as VaR Tab or Performance
Tab.

• Sub-tabs: Each tab contains sub-tabs, which allow you to conduct deeper portfolio and risk analysis, such as examining
top and bottom contributors to your portfolio, summarizing portfolio and benchmark characteristics, viewing historical trend
analysis of total active risk and exposures to risk factors, or seeing how a hypothetical scenario may affect your portfolio.

Each tab's default view is the Main View sub-tab (explained below), which contains your primary analysis data as well as
set up options and analytical tools. All other sub-tabs contain different layouts and analytical options, which vary by main
tab. For more information on the sub-tabs, see the topics corresponding to tab names, such as Intraday Tab, Holdings Tab,
Characteristics Tab, etc.
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• Customization Tools: Customization tools allow you to quickly add or remove fields to the currently selected Main View
as well as access more detailed customization options (e.g., choosing portfolio sources and calculation settings). For more
information, see Getting Started.

• Setup Options: Four setup options on the left are the only analytical tools that remain constant across all sub-tabs. Once
you select your portfolio, benchmark, grouping, and currency options, the settings remain constant no matter to which tab
or sub-tab you navigate. For more information on setting up your portfolio analysis, see Getting Started.

• Analytical Tools: The analytical tools on the right allow you to perform tab-specific portfolio and risk analysis, such as
choosing a timeframe for analysis or selecting hypothetical scenarios. For more information on the analytical tools, see the
topics corresponding to tab names, such as Intraday Tab, Holdings Tab, Characteristics Tab, etc.

MAIN VIEW

Each tab in PORT has a Main View and a series of sub-tabs. The Main View, which displays your primary analysis data, is
the default view for each tab. Setup options allow you to choose portfolio, benchmark, grouping, and currency options, which
remain constant across all tabs and sub-tabs. The table displays your portfolio securities and breakdown, updated in real-time,
as well as tab-specific data (e.g., total return, option adjusted duration, factor risk, attribution). The news heat icons on the
far-left allow you to access relevant news stories for securities in your portfolio. At the bottom of the main view, you can access
additional holdings data and zoom into or out of the data table.
 

 

Note:  The intraday monitor chart appears only in the Intraday Main View sub-tab.

For more information on the sub-tabs, see the topics corresponding to tab names, such as Intraday Tab, Holdings Tab,
Characteristics Tab, etc.

Each Main View provides charting options that allow you to visualize your portfolio's performance, attribution, and risk
measures. The chart options vary, depending on the tab. You can click the chart expander to view/hide the charts.
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For more information on using the various charts available in PORT (scatter plots, distribution, and heat maps) as well as basic
charting information, see the Charts Homepage CHAR <Go> and Bloomberg Chart Basics OBGO <Help>.

PORT TABS

PORT is comprised of a series of tabs that allow you to conduct increasingly sophisticated portfolio management and analysis
intraday and over historical timeframes for your portfolio holdings, characteristics, and attributions, as well as conduct risk
measurement, scenario analysis, and other sophisticated analysis.
• Intraday: Track the intraday performance of your portfolio on an absolute basis or against a benchmark using real-time

data. With the Intraday tab, you can stay on top of how the markets are impacting your security weights and return
contributions throughout the day, so you can react quickly to events as they occur. The intraday monitor chart tracks
your portfolio's return in graphical form, so you can easily see your current performance at a glance. Available for equity
portfolios only.

For more information on the analytical options available in the Intraday tab, see Intraday Tab.
• Holdings: View your portfolio's positions and sector weights on a standalone basis, or analyze your over/underweights

relative to a benchmark. With the Holdings tab, you can quickly see your active allocation decisions and confirm whether
the sector weights are in line with your expectations. You can also backdate the analysis to see positions and weights as of
a historical date or as a time series trend. The trends option allows you to see how your portfolio's weighting structure has
changed over time, thus helping you make appropriate allocation decisions going forward.

For more information on the analytical options available in the Holdings tab, see Holdings Tab.
• Characteristics: Analyze the fundamental characteristics of your portfolio as of a specific date or as a time series trend.

For equities, you can obtain valuation ratios as well as dividend yield and earnings growth for your portfolio to obtain
insight into its fundamental characteristics. You can also compare these measures against those of your benchmark for
relative analysis. For fixed income, you can view your portfolio's duration, credit quality, yield, and spread to evaluate the
core investment structure of your portfolio. The Characteristics tab also helps you to understand your current interest rate
exposures, credit risk exposures, liquidity risk, and projected cash flow payments to help you make informed investment
decisions.

bbg://screens/CHAR
bbg://screens/HELP OBGO
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For more information on the analytical options available in the Characteristics tab, see Characteristics Tab.
• Tracking Error: Analyze your portfolio's ex-ante (predicted) risk by using Bloomberg's multi-factor risk models. With

the Tracking Error tab, you can understand your portfolio's exposure to fundamental risk factors, such as growth, value,
momentum, and volatility, and uncover the potential hidden risks that may be impacting your returns so you can quickly
identify the top individual securities which contribute the most to your total active risk. You can also see how your tracking
error and exposures to risk factors have changed over time. The Tracking Error tab provides you with Bloomberg's
sophisticated risk analysis as you consider buy and sell decisions for your portfolio.

For more information on the analytical options available in the Tracking Error tab, see Tracking Error Tab.
• VaR: Use Bloomberg's Value-at-Risk (VaR) calculation to estimate your portfolio's maximum loss as measured at a given

confidence interval. A popular measure of risk due to its intuitiveness and ease of interpretation, VaR helps you gauge
the maximum extent of risk represented by the assets in your portfolio. Bloomberg VaR starts with the foundation of
Bloomberg's multi-factor risk models and supports industry-standard calculation algorithms (algos), including historical
simulation, parametric and Monte Carlo methods. Value-at-Risk can be displayed in P&L or percentage terms to ensure it
fits exactly into the way you think about risk.

For more information on the analytical options available in the VaR tab, see VaR Tab.
• Scenarios: Perform stress tests on your portfolio based on various historical and hypothetical market scenarios. Scenario

analysis is a valuable component of understanding portfolio risk, in which you can "stress" market variables to see the
potential impact of market events on your portfolio's future performance. Use the Scenarios tab to test the impact of
historical events (such as the 2008 Lehman Default) or custom scenarios (such as a massive change in interest rates).
You can evaluate which scenarios would be best or worst for your portfolio and drill down into your portfolio holdings to
see which sectors and securities would most be impacted. Scenario analysis can help you prepare for the next big market
event.

For more information on the analytical options available in the Scenarios tab, see Scenarios Tab. For more information on
creating a stress scenario, see Scenario Manager.

• Performance: View the historical performance of your portfolio on both an absolute basis and relative to a benchmark. You
can analyze the ex-post (realized) risk characteristics of your portfolio based on its historical active returns using measures
such as standard deviation, beta, and Sharpe ratio. You can use this data to understand your historical risk/return trade-off
and determine whether your performance has been achieved at the appropriate level of risk given your investment mandate.
The Performance tab also helps you identify potential trends with period and seasonal analysis, so you can take greater
advantage of bull periods while avoiding bear periods.

For more information on the analytical options available in the Performance tab, see Performance Tab.
• Attribution: Now that you understand how your portfolio performed historically relative to its benchmark, use the

Attribution tab to analyze how the structure of your portfolio contributed to your active performance. You can also
decompose the sources of your portfolio's active return into sector bets (Allocation Effect), security bets (Selection
Effect), and FX rate bets (Currency Effect). For fixed income portfolios, you can further attribute your active performance to
changes in interest rates.

For more information on the analytical options available in the Attribution tab, see Attribution Tab.

LEGAL DISCLAIMER

The Portfolio Optimizer Function (the "Services") is designed to be used as a research tool by professional portfolio managers.
The Services comprise informational and computational tools only and the results presented are based solely on the
application of industry-standard risk management models to inputs provided by the customer. No aspect of the Services is



>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //09

based on the consideration of any customer's individual circumstances. The Services are not an expression of opinion on the
merits or suitability of any investment, and the information available via the Services should not be considered as information
sufficient upon which to base an investment decision. Accordingly, nothing in the Services shall constitute, or be construed as,
investment advice or recommendations by Bloomberg Finance L.P. ("BFLP"), Bloomberg L.P. or their affiliates of an investment
strategy or the suitability of an investment. BFLP and its affiliates do not express an opinion on the future or expected value
of any security or other interest and do not explicitly or implicitly recommend or suggest an investment or other strategy.
Customers should on their own assess the Services and determine whether they agree with the information in the Services.
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USING PORT
The following topics explain how to use PORT's analytics and tools to manage and analyze your portfolio and risks.

For a description of the function, see What Is Portfolio & Risk Analytics (PORT)? .

GETTING STARTED

You can start using PORT immediately by updating just a few fields, and then creating a "view" that saves these settings
for future use. The following topics explain how to initially set up your portfolio and risk analysis by selecting portfolio and
benchmark sources, grouping your instruments, and creating a customizable view.
• Setting Up Analysis

• Creating a View

• Portfolio & Benchmark Sources

• Selecting Classifications

SETTING UP ANALYSIS

You can analyze the portfolios, portfolio groupings, and public funds that you have created or that have been shared with you
against a benchmark, which can be an index, another portfolio, a mutual fund, an ETF, or a custom benchmark. You can also
choose how the instruments are aggregated and the currency in which they are compared.

For more information on uploading and sharing portfolios, see the help pages for the Creating/Updating Portfolios (PRTU) or
Bloomberg Uploader (BBU) functions: PRTU <Help> and BBU <Help>.

To select your portfolio and benchmark:

From any sub-tab, update the Port1 , vs2 , by3, and in4  fields, then press <Go>.
 

1 In general, Port indicates the portfolio being analyzed. The portfolios are created and maintained in PRTU and BBU.
For more information, see PRTU <Help> and BBU <Help>. In the Characteristics - Characteristics Summary sub-tab,
however, Port indicates the weight value of the portfolio.

2 Indicates the benchmark against which you are comparing your portfolio, which can be an index, portfolio, or fund. You
can create and maintain custom benchmarks in the Creating/Updating Portfolios (PRTU) function. For more information
on using PRTU to maintain benchmarks, click here .

3 Allows you to analyze your portfolio and benchmark broken down by various classification schemes, such as by
country/region, industry sector, long/short, and currency. You can also set a default classification for the view you are
customizing. You do not, however, have to choose a classification.

Note:  For more information on breaking down your portfolio analysis by classifications, see Selecting Classifications.
4 Allows you to choose the currency in which the portfolio and benchmark are compared. By default, the currency under

analysis is the portfolio base currency. For a complete list of currencies, see CURR <Help>.

bbg://screens/HELP PRTU
bbg://screens/HELP BBU
bbg://screens/bbg://screens/HELP PRTU
bbg://screens/bbg://screens/HELP BBU
bbg://screens/bbg://screens/LPHP PRTU:0:1 1956077
bbg://screens/bbg://screens/HELP CURR


>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //11

 

Note:  The options that appear in the Port and vs fields depend on your defaults, which you can customize. For more
information on customizing these sources, see Portfolio & Benchmark Sources.

The selected portfolio, benchmark, and grouping selections appear and the data updates. The selections remain available for
analysis across all tabs in PORT.

Note:  You can also analyze a group of portfolios. For more information on how to set up this analysis, see Group-Level
Analytics.

CREATING A VIEW

Creating a view allows you to customize the data that appears for portfolio and risk analysis, including portfolio and grouping
data, calculation defaults (e.g., pricing source), display options (e.g., tab and column orders), and other defaults.

To create a view:

1. From the toolbar, select View > Create New View.
 

 

The Create View window appears. The New option is selected by default.

2. Enter a name in the View Name field.

Note:  Only alphanumeric characters, underscore (_), and dash (-) are allowed.
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3. Choose the type of view:

• If you are creating a new view, click the drop-down menu to the right of the New field and choose Equity View, FI
Desktop, or Balanced View, based on the assets you are analyzing.

• If you want to copy and edit an existing view, select Copy from view, then click the corresponding drop-down and
select the view to copy.

4. Click the Create button.
The Portfolio Analytics & Risk screen (and your view) appears. Your view is now available for future use by clicking the
View button.

You can now add portfolio and benchmark sources to the view. For more information, see Portfolio & Benchmark Sources.

Note:  For more information on choosing the order of tabs, calculation defaults, and other custom options, see Settings.

PORTFOLIO & BENCHMARK SOURCES

Once you have created a view, you can choose which portfolios, portfolio groups, indices, and funds/ETFs/13Fs to analyze,
as well as the benchmarks against which to compare them. You can also make these sources available for quick analysis by
marking them as "favorites."

To configure your portfolio, portfolio groups, indices, funds sources, and benchmarks:

1. From the Port5  or vs6  drop-down menu, select [More Sources...].
 

5 In general, Port indicates the portfolio being analyzed. The portfolios are created and maintained in PRTU and BBU.
For more information, see PRTU <Help> and BBU <Help>. In the Characteristics - Characteristics Summary sub-tab,
however, Port indicates the weight value of the portfolio.

6 Indicates the benchmark against which you are comparing your portfolio, which can be an index, portfolio, or fund. You
can create and maintain custom benchmarks in the Creating/Updating Portfolios (PRTU) function. For more information
on using PRTU to maintain benchmarks, click here .

bbg://screens/bbg://screens/HELP PRTU
bbg://screens/bbg://screens/HELP BBU
bbg://screens/bbg://screens/LPHP PRTU:0:1 1956077
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The Select Portfolio or Select Benchmark window appears and displays a list of your available portfolio and benchmark
sources.

2. To choose sources, under Source select Custom Benchmarks, Portfolios, Portfolio Groups, Indices, or
Funds/ETFs/13Fs.
The corresponding options appear on the right side of the window.

3. Make your source selections:
 

 
• To mark any of the sources as favorites, click the star in the Fav (favorite) column next to the source. Sources marked as

favorite populate the list that appears when you click the Port or vs drop-down menu. To add all items, click the Add All
button.

• To search for a portfolio, index, fund, or benchmark, use the <SEARCH> field. The search results from which you can
select appear.

• To use a source as the default, so it loads each time you access the view in PORT, click the Def column next to the
source.

• If you are selecting benchmark sources and want to use the default benchmark you set up in the Creating/Updating
Portfolios (PRTU) function, select Use Portfolio Default. For more information, see PRTU <Help>.

4. Click the Select button.

bbg://screens/HELP PRTU
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Your view settings are saved. The source selections can be updated any time in the future.

SELECTING CLASSIFICATIONS

Once you have selected your portfolio and benchmark, you can define how you want to break down your portfolio for analysis
by selecting a classification, such as by sector or country. Several standard Bloomberg classifications are available by default.

Custom classifications set up in the Custom Sector Classifications (PCLS) function can be accessed in PORT. For more
information on PCLS, see PCLS <Help>.

To configure the list of portfolio classifications:

1. From any Main View sub-tab, from the by field, select [More Options...].
 

 

The Select Classification window appears.

2. Configure the list of classifications:

• To search for available classifications, enter a keyword in the Name or Creator columns, then press <Go>.
• To mark classifications as favorites, click the star in the Fav column next to the classification.

Note:  The favorites list populates the "by" drop-down menu.

 

 

bbg://screens/HELP PCLS
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• To set a classification as the default so that it is used each time you access the related view in PORT, click the Def
column next to the classification.
 

 

• To see details on the classification, click the Info icon to the right of a classification name.
 

 

3. After choosing a classification, click the Select button.
PORT automatically updates using the selected classification.

Note:  You can create a new custom classification if you want to use a field or series of fields not available in the Select
Classification window. For more information on creating classifications, see Creating New Classifications.

INTRADAY TAB

The Intraday Tab allows you to track the intraday performance (weights, returns, contribution to return, performance attribution,
and P&L) of your equity portfolio on an absolute basis or against a benchmark using real-time data. The intraday monitor chart -
a unique feature of Bloomberg's Portfolio & Risk Analytics tool - tracks your portfolio's performance throughout the day.

The Intraday tab is divided into two sub-tabs:

• Main View: Allows you to monitor alternative intraday performance data on an absolute basis or against a benchmark using
real-time data. Also displays the intraday monitor chart. For more information, see Intraday Monitor Chart.

• Top Holdings: Allows you to analyze returns for your portfolio at the security level based on "top" and "bottom" performers
by contribution to return, absolute performance, or largest position on an intraday basis. For more information, see Intraday
Top Holdings.

For information on monitoring a fixed income or balanced portfolio intraday, see Fixed Income & Balanced Intraday.
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Note:  For information on monitoring % Gross Weight7  performance for long/short portfolios, see Percentage Gross Weight.
For information on calculation assumptions for attribution effects in the Intraday tab, see Attribution Calculation Assumptions.

FIXED INCOME & BALANCED INTRADAY

You can perform intraday analysis on fixed income and balanced fund portfolios. With fixed income portfolio intraday analysis,
security coverage is in line with the rest of the tabs in PORT for the following securities: Corps, Govt, Muni, Mortgages, and
Preferreds. You can conduct intraday analysis on up to 2500 fixed income securities.

Note:  At this time, there is no benchmark analysis for fixed income or balanced fund intraday analysis. Also, multi-portfolio
monitoring for FI/Balanced portfolios is currently unavailable.

Pricing for fixed income and balanced funds is handled in the following ways:

• Close FI Pricing: Bid BVAL price, else custom price

• Intraday FI Pricing: MSG1 > TRAC > EXCH > CBBT > BGN (Bid or Ask). This is a default setting, which you can
change. For more information on customizing this pricing waterfall, see Pricing Source Defaults.

INTRADAY MONITOR CHART

The intraday monitor chart, which appears only on the Intraday Main View sub-tab, is a unique feature of Bloomberg's Portfolio
& Risk Analytics tool. The intraday monitor chart tracks your portfolio's performance throughout the day.
 

 

By default, the monitor shows your portfolio's return (or active return, if you have a benchmark). You can click the Field
drop-down menu above the chart to monitor different intraday activity.

Note:  For information on monitoring multiple portfolios in the intraday monitor chart, see Multiple Portfolios in Intraday Chart.

7 The current gross exposure of the instrument or grouping divided by the total current gross exposure of the portfolio,
expressed as a percentage.
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Depending on portfolio and benchmark selections, your choices vary. Some of the most common options include:

Option Displays

Contribution to Return (Port) The current portfolio P&L divided by the portfolio's market value as of yesterday's close,
expressed in basis points.

Contribution to Return (Bmrk) The current benchmark P&L divided by the benchmark's market value as of yesterday's
close, expressed in basis points.

Contribution to Return (+/-) The difference between your portfolio's current total return and the benchmark current
total return.

Total Return (Port) The current P&L divided by the previous day's closing market value of the instrument or
grouping. Expressed in basis points.

P&L (Port) The difference between the portfolio's current market value and the previous day's
closing market value.

Market Value Last (Port) The current market value of the portfolio.

If you begin monitoring your portfolio after the market opens, the intraday monitor chart automatically backfills your portfolio's
performance in ten minute intervals, starting at 9:30AM EST for the Americas, 8AM GMT for EMEA, and 9AM JST for
Asia-Pacific, and ending at 6PM in each region. Your region is determined by your settings in the Time Zone Defaults (TZDF)
function. For more information on changing your time zone settings, see TZDF <Help>.

To show/hide the intraday monitor chart, from the toolbar, select Settings > Show Intraday Chart.
 

 

INTRADAY TOP HOLDINGS

The Intraday Top Holdings sub-tab allows you to analyze returns for your portfolio at the security level based on "top" and
"bottom" performers by contribution to return, absolute performance, or largest position on an intraday basis. Data in the Top
Holdings sub-tab updates in real time.

To update the data that appears on the Top Holdings sub-tab, click any of the options in the holdings summary section at the
top of the screen.

bbg://screens/HELP TZDF
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The data in the bottom section updates automatically.

The following analytical options are available in the holdings summary section:

Option Displays

Contrib to Return of Top 10
Contributors

The top 10 return contributors, from highest contribution to return to the lowest.

The percentage to the right of the category name in the holdings summary section
sums CTR(P) for the 10 securities.

Avg Return of Top 10 Performers The top 10 performers, from highest intraday total return to lowest.

The percentage to the right of the category name in the holdings summary section
averages percentage price changes (%Px Chg) for the 10 securities.

Contrib to Return of Largest 10
Positions

The top 10 largest positions in your portfolio in terms of % weight, from the highest
percentage to lowest.

The percentage to the right of the category name in the holdings summary section
sums CTR(P) for the 10 securities.

Contrib to Return of Bottom 10
Contributors

The bottom 10 return contributors, beginning with the lowest number of basis points.

The percentage to the right of the category name in the holdings summary section
sums CTR(P) for the 10 securities.

Avg Return of Bottom 10
Performers

The bottom 10 performers, beginning with the lowest intraday total return.
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Option Displays

The percentage to the right of the category name in the holdings summary section
averages %Px Chg for the 10 securities.

HOLDINGS TAB

The Holdings tab provides a basic view of the current positions, weights, and allocations across sector, country, or any custom
grouping model. You can compare your portfolio's sector weights relative to a benchmark, as well as backdate the analysis to
see positions and weights as of a specific date or as a time series trend. You can also analyze your holding allocations by a
time or trend series, and by a specific date.

The Holdings tab is divided into two sub-tabs, which allow you analyze holdings over given time periods and drill down into
your sector allocation data.
• Main View: Allows you to conduct time and trend analysis. For more information, see Time Analysis and Trend Analysis.
• Allocation: Allows you to display your portfolio's allocation (by sector) and view the top ten or bottom ten positions within

the portfolio, as well as chart your allocations. For more information, see Analyzing Holdings.

TIME ANALYSIS

In the Holdings Main View sub-tab, you can analyze your holdings allocations for a specific date.

To display a time analysis:

From the control area, select Date, update As Of8 , then press <Go>.
 

 

The portfolio analysis updates.

Note:  You can access previous calculations of the Main View sub-tab in the Stored Results section. For more information on
analyzing the results monitor, see Analytic Results Monitor.

TREND ANALYSIS

In the Holdings Main View sub-tab, you can analyze your holdings allocations by a trend series. Up to 40 time periods may be
displayed.

To display trend analysis:

1. From the control area, select Trend.
The trend analysis options update.

8 The date for analysis. If the date is set to today, the analysis is based on current position's with the previous day's closing
prices. Analysis may be backdated up to 90 days.
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2. Update your trend options in the Field9 , Time10 , and Freq11  fields, then press <Go>.
 

 
The portfolio analysis updates. If your timeframes exceed 40, the forty most recent periods appear.

Trend analysis is also available in chart form by clicking the chart expander on the right side of the screen. You can select any
grouping level in the portfolio securities and breakdown section to see visual representations of the trend analysis.

ANALYZING HOLDINGS

In the Holdings Allocation sub-tab, you can display your portfolio's allocation and see the top ten or bottom ten positions within
the portfolio, as well as chart your allocations in four different ways.

Note:  Data analysis in the Allocation sub-tab is not available in trend analysis mode.

Allocation data is divided into three sections:
 

 

Section Displays

Portfolio Breakdown The portfolio currently loaded in PORT, broken down by sector.

9 In trend analysis mode, the field for trend analysis. For example: # (PORT), % Wgt (+ / -), or Mkt Val (+ / -).
10 In trend analysis mode, the timeframe for the analysis (e.g., month-to-date [MTD] or year-to-date [YTD]).
11 Allows you to choose the frequency for trend and period analyses (Daily, Weekly, Monthly, etc.).
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Section Displays

Instrument Weights The market value (in percentage terms) of the top ten or bottom ten positions in the
corresponding portfolio.

Allocations Chart Allocation data in four variations: portfolio, benchmark, relative, or combined.

To analyze top or bottom holdings:

Click the Holdings in Portfolio drop-down menu and select whether you want to view data for your Top 10 or Bottom 10
securities.

The portfolio analysis updates automatically.

The following chart variations are available:

Option Displays

Portfolio Portfolio sector percentage weights.

Benchmark Benchmark sector percentage weights.

Combined Sector percentage weights based on the portfolio and benchmark.

Relative Portfolio sector percentage weights relative to the benchmark (portfolio weight – benchmark
weight).

CHARACTERISTICS TAB

The Characteristics tab allows you to analyze the fundamental characteristics of your portfolio as of a specific date or as a time
series trend. For equity portfolios, you can obtain measures such as valuation ratios, dividend yield, and earnings growth. For
fixed income portfolios, you can see your portfolio's duration, credit quality, yield, and spread to evaluate the core structure
of your investments. You can also analyze your portfolio's tenors on the yield curve, observe projected cash flows for your
portfolio, break down the liquidity of your positions, and display key rates in absolute value or relative to a selected benchmark.

The Characteristics tab is divided into three or four sub-tabs, depending on the instruments you are analyzing:

• Main View: Allows you to conduct time and trend analysis by sector. For more information, see Time Analysis and Trend
Analysis.

• Characteristics: Displays a summary of your portfolio's characteristics and allows you view the top ten or bottom ten
instruments within that portfolio, based on each characteristic, as well as chart the characteristics by sector. For more
information, see Summary.

• Cash Flows: Displays income generated by the portfolio over a specified time horizon in chart and table format. For more
information, see Cash Flows.

• Liquidity Risk: Allows you to break down your portfolio's liquidity by security based on average or total days to liquidate,
so you can determine the time horizon and cost needed to liquidate your positions. For more information, see Liquidity Risk.

• Key Rates: Allows you to see graphic depictions of your portfolio's key rate exposures to quickly identify which tenors
contribute the most interest rate risk. For more information, see Key Rates.
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By default, equity measures are aggregated to the portfolio level using either the Weighted Average12  or the Index Method13 ,
which is similar to the approach used by many equity benchmark index providers. Fixed income measures are aggregated using
the Weighted Average method. The aggregation method for most fields may be changed to any of the following options:

• Weighted Average: The mean of the instruments' values weighted by the market value weight of each instrument in the
portfolio or sector grouping. If any instrument is missing the value (shows "blank" or N/A), that instrument is excluded from
the aggregate calculation.

• Harmonic Weighted Average: The reciprocal of the weighted average of reciprocal values. For example, the harmonic
weighted average of P/E is calculated as [1 / (Weighted Average of E/P)]. This option is sometimes preferred to Weighted
Average for price ratios, because it prevents excess weighting of higher values.

• Average: The simple mean of the instruments' values without consideration for the weight of each instrument in the
portfolio or sector grouping.

• Median: The midpoint of the range of numbers that are arranged in order of value.
• Minimum: The lowest individual value in the portfolio or sector grouping.
• Maximum: The highest individual value in the portfolio or sector grouping.

Note:  Index Method is available only for certain equity fields, such as price ratios and growth ratios. With the Index Method,
calculation of the aggregate Price to Earnings ratio includes companies with negative earnings. Calculation of this ratio using
Weighted Average excludes companies with negative earnings. For more information on the Index Method calculation, see
Index Method Aggregation.

The Characteristics tab provides multiple options for handling missing values and outliers. You can also add multiple version
of a field for side-by-side comparison of aggregation calculations. For more information on these options, see Adding Field
Variations and Calculations and Outlier Handling.

TIME ANALYSIS

In the Characteristics Main View sub-tab, you can analyze your portfolio characteristics for a specific date.

To display a time analysis:

From the control area, select Date, update As Of14 , then press <Go>.
 

 

Your portfolio characteristics update.

12 The mean of the instruments' values weighted by the market value weight of each instrument in the portfolio or sector
grouping. If any instrument is missing the value (shows "blank" or N/A), that instrument is excluded from the aggregate
calculation.

13 As an aggregation method, Index Method is available only for certain equity fields, such as price ratios and growth ratios.
With the Index Method, calculation of the aggregate Price to Earnings ratio includes companies with negative earnings.

14 The date for analysis. If the date is set to today, the analysis is based on current position's with the previous day's closing
prices. Analysis may be backdated up to 90 days.
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Note:  You can access previous calculations of the Main View sub-tab in the Stored Results section. For more information on
analyzing the results monitor, see Analytic Results Monitor.

TREND ANALYSIS

In the Characteristics Main View sub-tab, you can analyze your portfolio characteristics by a trend series. Up to 40 time
periods may be displayed.

To display trend analysis:

1. From the control area, select Trend.
The trend analysis options update.

2. Update your trend options in the Field15 , Time16 , and Freq17  fields, then press <Go>.
 

 

The portfolio analysis updates. If your timeframes exceed 40, the forty most recent periods appear.

Trend analysis is also available in chart form by clicking the chart expand on the right side of the screen. You can select any
grouping level in the portfolio securities and breakdown section to see visual representations of the trend analysis.

SUMMARY

The Characteristics Summary sub-tab displays a summary of your portfolio's characteristics and allows you view top ten or
bottom ten instruments within that portfolio, based on each characteristic, as well as chart the characteristics by sector.

Note:  Data analysis in the Summary sub-tab is not available in trend analysis mode.

Data is divided into three sections:
 

15 In trend analysis mode, the field for trend analysis. For example: # (PORT), % Wgt (+ / -), or Mkt Val (+ / -).
16 In trend analysis mode, the timeframe for the analysis (e.g., month-to-date [MTD] or year-to-date [YTD]).
17 Allows you to choose the frequency for trend and period analyses (Daily, Weekly, Monthly, etc.).
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• Characteristics: Displays the portfolio currently loaded in PORT, broken down by characteristic (e.g., modified duration,

yield to maturity). You can click any row to display a breakdown of that characteristic in the chart.
• Instrument Values: Displays the top ten or bottom ten securities based on your selection from the Wgt drop-down menu

at the top of the section.
• Characteristics Breakdown: Illustrates characteristics data in four variations: portfolio, benchmark, relative, or combined.

To analyze top or bottom holdings, click the Wgt drop-down menu and select whether you want to view data for your Top 10 or
Bottom 10 securities. The portfolio analysis updates automatically.

The following chart variations are available:

Option Displays

Portfolio Portfolio sector percentage weights.

Benchmark Benchmark sector percentage weights.

Combined Sector percentage weights based on the portfolio and benchmark.

Relative Portfolio sector percentage weights relative to the benchmark (portfolio weight – benchmark
weight).

CASH FLOWS

The Characteristics Cash Flows sub-tab displays a projection of interim and principal payments over a specified time horizon in
chart or table format.

For equity instruments, interim payments are dividends projected using the Bloomberg Dividend Forecast (BDVD) function.
For fixed income instruments, interim payments include the periodic coupons that are received. For information on BDVD, see
BDVD <Help>.

bbg://screens/HELP BDVD
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The Cash Flows sub-tab displays three months of cash flows by default. However, you can analyze up to sixty cash flow
periods, which can be defined as daily, monthly, quarterly, semi-annually, or yearly. You can see more cash flow periods when
you generate a PDF or Microsoft® Excel report. For information on creating a report, see Creating Report Templates.
|Hint| You can edit your default cash flow projection settings in the View Manager. For more information, see Cash Flow
Calculation Defaults.
 

 

• Cash Flow Projection Filters: Provides the filters and fields available to modify your cash flow projection analysis, such

as Graph Type18  and Workout Conv19 .
• Cash Flow Projection Chart: Displays a bar chart of the cash flow projections, based on your filters. If you select the

Table field, the cash flow projection table appears.

You can adjust your analysis using the following cash flow projection filters:

18 In the Cash Flow Summary sub-tab, allows you to choose the cash flow payments that appear on the chart or table. The
options are:

— Interim Only: Displays only the periodic payments produced by the instrument, i.e., projected dividends for equities
and coupons for fixed income.

— Principal Only: Displays only the principal payments produced by the instrument.
— Cash flow (Total): Displays the sum of the interim and principal cash flows for each period.
— Cash flow (Cumulative): Displays the running total of the interim and principal cash flows received over each period.

19 In the Cash Flow Summary sub-tab, allows you to choose the cash flow projection methodology, which provides an
assumption as to when you are going to recover your principal. The options are:

— To Worst: Selects a workout date that produces the worst yield based on the price of the bond. The date may be a
maturity or call date.

— To Next Call: Assumes the bond is called at its next call date.
— To Maturity: Assumes the bond is called on its maturity.
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Field Allows you to

Per Change the frequency of the projection data and the time horizon.

Filter Limit the projections displayed to only the cash flows paid in a specific currency.

Graph Type Confine the cash flow summary to interim payments only, principal payments only, total cash
flow, or cumulative cash flow.

Workout Conv Select the timeframe in which you assume you are going to recover your principal:

• To Worst: Selects a workout date that produces the worst yield based on the price of the
bond (the date may be a maturity or call date).

• To Maturity: Assumes the bond is called on its maturity.
• To Next Call: Assumes the bond is called at its next call date.

Note:  You can also drill into cash flow projection data for a specific period by clicking the corresponding bar in the chart.

Cash flow data is also available in table format. You can see cash flows for each period by selecting Table. You can select a
period in the table to expose the instruments that pay an interim or principal cash flow during that period.
 

 

LIQUIDITY RISK

The Liquidity Risk sub-tab allows you to measure your portfolio's liquidity risk using four analytical views, including a summary
of the expected transaction costs using the BLOOMBERG PROFESSIONAL® service's proprietary transaction cost model.
You can customize your analysis of liquidity risk based on median or average volume, access all available volume history for
your portfolio positions, calculate the average or median based on daily price volume or VWAP volume, and backdate your
liquidity risk view.

For details on setting up your liquidity risk defaults in PORT, see Liquidity Risk Defaults. For information on Bloomberg's
proprietary transaction cost model, see TCA <Help>.
 

bbg://screens/HELP TCA
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Note:  The units in the Liquidity Summary and Transaction Cost Summary sections are displayed in the upper righthand corner
of each section.

Your selection in the Analytic field determines the type of data that appears in the other sections of the Liquidity Risk sub-tab.
The following views are available:

• Average Days to Liquidate: Displays the average number of days needed to liquidate each position in your portfolio

based on the specified participation rate20  and average volume history21 .

Note:  For an individual position, average days and total days to liquidate (see description below) are identical. For an
aggregation of positions, including a portfolio, the average number of days to liquidate reflects the average liquidity of all
portfolio positions, while the total number of days to fully liquidate matches the number of days required for the most illiquid
position.

• Total Days to Liquidate: Displays the total number of days needed to liquidate 100% of the position or the portfolio using

the specified participation rate22  and average volume history23 .
• Liquidity Profile: Allocates your positions into six user-defined liquidity buckets for a simplified analysis of your portfolio

liquidity. You can use this view to easily identify the concentration of the portfolio's market value in more versus less liquid
securities. You can define the liquidity buckets in the Liquidity Risk settings in the portfolio View Manager. For more
information, see Liquidity Risk Defaults.

• Liquidity Horizon: Displays your portfolio liquidity based on the length of time it will take to liquidate a preset percentage
of the portfolio's total market value. You can use this analysis to compare against anticipated fund redemptions to ensure
that fund can meet them. You can define the liquidity horizon as a percentage of your portfolio's market value in the Liquidity
Risk settings in the portfolio View Manager. For more information, see Liquidity Risk Defaults.

20 The percentage of the average or median daily volume of your position that you are willing to expose into the market.
21 The length of trade history used to calculate the median or average volume.
22 The percentage of the average or median daily volume of your position that you are willing to expose into the market.
23 The length of trade history used to calculate the median or average volume.
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The position Breakdown section updates based on the selected analytic24  and your selection in the Liquidity Summary or
Transaction Cost Summary tables. The breakdown table automatically sorts each data column in descending order, based on
the number of days to liquidate. In the following example, you can see that Tootsie Roll is the least liquid stock in the portfolio
using a 10% participation rate and 30 day average volume. PORT calculates that Tootsie Roll will take 28.33 days to liquidate
and cost 111.7 basis points.
 

 

KEY RATES

In the Characteristics Key Rates sub-tab, you can see graphic depictions of your portfolio's key rate exposures to quickly
identify which tenors contribute the most interest rate risk. You can display portfolio key rates in absolute value or relative to a
selected benchmark, as well as drill-down to the security-level key rate risk of your portfolio holdings.

The Key Rates sub-tab is divided into two main sections:
 

24 The liquidity risk calculation selected for your portfolio analysis within the Characteristics-Liquidity Risk sub-tab. For
descriptions of each available view, see Liquidity Risk.
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• Key Rate Exposures: Displays key rate exposures by option adjusted duration (OAD) and across numerous timeframes.
• Key Rate Chart: Illustrates the interest rate exposure for your portfolio at each tenor on the curve.

You can click any aggregate level (e.g., Corporate Debt) to analyze the instruments within that grouping. The key rate chart
updates to reflect corresponding interest rate exposures.
 

 

Note:  You can right-click any instrument to conduct further analysis in related functions, such as News  (N), Description
(DES), Yield and Spread Analysis (YAS), Fixed Income Price Discovery (FIPX), and more.

TRACKING ERROR TAB

The Tracking Error tab allows you to analyze your portfolio's ex-ante (predicted) risk by using one of Bloomberg's multi-factor
risk models. Tracking errors are annualized volatilities of active returns, expressed in percentages. You can display portfolio risk
statistics in absolute terms or relative to a selected benchmark, either for a specific date or as a time series trend.
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The Tracking Error tab is divided into seven sub-tabs, which allow you to perform more specific risk analysis:
• Main View: Displays risk data that is absolute or relative to a benchmark. Risk models help you analyze your portfolio's

ex-ante (predicted) risk. For more information, see Choosing Risk Models.
• Summary: Displays the portfolio risk/active risk summary, as well as basic risk decomposition statistics. For more

information, see Active Risk & Factor Risk Exposures.
• Factors: Displays the factor table, broken down by factor, exposure, and risk. For more information, see Analyzing Factor

Groups.
• Risk Bets: Displays the largest/smallest portfolio risk bets. For more information, see Analyzing Risk Bets.
• Trends: Allows you to visualize ex-ante risk options and trends for data series variations, such as Risk, Factor Groups,

Style Groups, and more. For more information, see Analyzing Trends Chart.
• Exposures: Displays a table of risk model exposures in your portfolio. For more information, see Analyzing Exposures.
• Factor P&L: Allows you to run factor-based performance attribution analysis for a specific date range either on an absolute

return basis or relative to a benchmark. For more information, see Analyzing Factor P&L.

Note:  For information on comparing portfolio and benchmark returns, see Benchmark Scaling.

CHOOSING RISK MODELS

The Tracking Error Main View sub-tab displays risk data that is absolute or relative to a benchmark. Risk models help you
analyze your portfolio's ex-ante (predicted) risk. Typically, risk models apply to the smallest geographical region that covers your
portfolio holdings.

To choose a risk model, from the control area, click the Model drop-down menu and select from the available options, then
press <Go>.
 

 

Note:  If you want to update the display unit for the risk values, update the Unit25  field.

25 In the VaR and Tracking Error tabs, the units to display potential portfolio loss, which may be displayed as either a market
value (P&L) or percentage return (Return %).
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The portfolio analytics update and the risk model applies across all Tracking Error sub-tabs.

You can also update the As of26  and Horizon27 fields to analyze your data for a different date and timeframe. If you enter
today's date, the analysis is based on current positions using the previous day's closing prices.
 

 

For more information on Bloomberg's risk factor models, see Documents.

ACTIVE RISK & FACTOR RISK EXPOSURES

The Tracking Error Summary sub-tab displays the portfolio risk/active risk summary, as well as basic risk decomposition
statistics. Risk is displayed in terms of both isolated volatility (standard deviation of return) and percentage of contribution.
Data appears in both table and chart form.

The Summary sub-tab is divided into the following sections:
 

26 The date for analysis. If the date is set to today, the analysis is based on current position's with the previous day's closing
prices. Analysis may be backdated up to 90 days.

27 • In the Tracking Error Summary , refers to how the risk numbers are scaled. For example, if Time Horizon is set to one
year, the risk statistics are annualized.

• In the VaR Main View, the risk forecast in number of business days. Bloomberg calculates a one-day VaR and scales
that number by multiplying it by the square root of the number of business days to include additional timeframes.

• In the Scenarios tab, allows you to analyze scenarios over several timeframes: one day, one week, one month, or one
year.
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• Portfolio Summary: Provides the value of the portfolio, the Portfolio Beta (ex-ante)28  value, and the Version29  under
analysis.

• Isolated Risk: Displays risk expressed as isolated volatility.
• Contribution to Risk: Displays the percentage contributions that make up Total Risk30 . It is possible for the Factor Risk

Contribution (%) value for a particular factor group to be greater than 100%. Total Risk Contribution (%) always sums up
to 100%. Factor Risk Contribution can be both positive and negative. If Factor Risk Contribution for a given factor group is
negative, then to get all risk contributions to sum up to 100%, some other factor group risk contribution can be greater than
100%.

• Risk Chart: Displays the risk decomposition of the selected risk value. If a risk factor group is selected, the risk chart
displays individual risk factors that make up a particular factor group.

Risk factors can be seen as Isolated Risk (Std)31 , Contribution to Risk32 , or Factor Exposure33  (factor betas). To analyze the
risk data in chart form, select the value.
 

28 A number describing the relation of returns of portfolio and benchmark.
29 The dated version of the portfolio under analysis.
30 Total risk is broken down into the Factor and non-factor groups. Factor groups are model-specific.
31 The standard deviation of the distribution of returns, expressed as either a percentage return or portfolio profit and loss

(P&L). This measure represents portfolio risk (expressed as the standard deviation of portfolio returns) or active risk
(expressed as the standard deviation of portfolio active returns).

32 Used to determine a fraction of risk that a particular factor/factor group contributes to total risk. Contribution to Risk (%)
is expressed in percentage points so that Total Risk sums up to 100%.

33 The sensitivity of your portfolio to the market. Factor exposure is also known as factor beta.
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Note:  You can click the bars in the chart to drill down into more data.

It is possible to have an absolute value of your style exposure for a given security be greater than 3. Even though most values
should be between +3.5 and -3.5, a value greater than 3 is a direct result of the normalization technique that Bloomberg uses
to calculate style exposures.

If you want to expose factor exposures (available for factor groups when a particular value is selected in the Isolated Risk

table), click Exposure34  above the risk chart.
 

 

ANALYZING FACTOR GROUPS

The Tracking Error Factors sub-tab displays the factor table, which is divided into three sections that allow you to analyze risk
factors at a glance:

34 A portfolio's, security's, or benchmark's sensitivity to a given risk factor.



>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //34

 

 
• Factor: Provides the risk factor broken down across the row.
• Exposure: Lists the risk factor exposures (factor betas) for your portfolio, benchmark, and active return (portfolio exposure

– benchmark exposure).
• Risk: Displays factor risk and active factor risk expressions and exposure data.

Note:  To display more information on the data, including calculations, position your cursor over any column header.

You can analyze factors for further analysis into the risk impacting your portfolio:
• To filter factor data, update the Asset Class35 , Group by36, or Hide zero exposures37  filters, then press <Go>.

 

 
• To gain transparency into the factors impacting your portfolio, click any factor name or data value to access the correlation

or variance/co-variance matrix. For more information on factor transparency, see Factor Transparency.

35 In the Tracking Error sub-tabs, allows you to filter factors by asset class.
36 In the Tracking Error-Factors sub-tab, allows you to filter factors by the factor groups that appear in the Summary

sub-tab: All Factors, Market, Style, Industry, or Greeks.

Note:  For multi-country equity models, style factor exposures for multi-country risk models are neutralized within a given
country. For more information on factor models, see Documents.

37 In the Tracking Error tab, allows you to show or hide factors with zero exposure values.
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• To see total active risk and active exposure in chart form, click the expander bar on the right side of the screen.
• To choose how the data appears in the chart, update the Wedge Size and Coloring function settings.

 

 

ANALYZING RISK BETS

The Tracking Error Risk Bets sub-tab displays the largest/smallest portfolio risk bets (performers) divided into two sections:
 

 
• Top Bets: Displays the five or ten riskiest bets in your portfolio.
• Bottom Bets: Displays the five or ten least risky bets in your portfolio.
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Note:  You can position your cursor over any column header to view more details about that particular column.

To update the data that appears in the either table, update any of the following:
 

 

Option Displays

Top/Bottom 5/10 Bets The top or bottom five or ten risk bets in your portfolio by contribution to risk and exposures.

Categories The sorting criteria (e.g., Active Risk38  or Portfolio Exposure39 ) used in ranking the risk bets
in the portfolio.

Group by The grouping by which the risk bets are aggregated, either by Factors, Securities, or
Groupings.

Note:  While the Categories and Group by fields are embedded in the top bets table, the selections you make are reflected in
both the top bets and bottom bets tables.

ANALYZING TRENDS CHART

The Tracking Error Trends sub-tab allows you to visualize ex-ante risk options and trends for data series variations, such as
Risk, Factor Groups, Style Groups, and more.

The Trends sub-tab is divided into the following sections:
 

38 Expressed as the standard deviation of portfolio active returns. Active risk is also known as tracking error.
39 The portfolio's sensitivity to a given factor.
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• Charting Options: Allows you to specify a date range for analysis in the Time40  fields and the analysis Horizon41.
• Methodology: Allows you to choose the ex-ante risk options for the trend analysis.

— Current Portfolio: Reflects the current security weights in the portfolio, the current security exposures to each factor,
and the current security non-factor risk.

Note:  The historical factor return volatility and the factor return covariances come from historical calibration.
— Historical Risk: Reflects the historical security weights in the portfolio, which are calculated using historical holdings,

historical prices, and FX rates; the historical security exposures to each factor; and the historical security non-factor risk.

Note:  Similar to the Current Portfolio methodology, the factor return volatility and the factor return covariances are
derived from historical calibration.

— Historical Exposure (X100): Reflects how risk factor exposures changed over time, using historical portfolio/benchmark
holdings and historical risk model factor exposures. Risk exposure for a given risk factor is defined as portfolio risk
exposure minus benchmark risk exposure (if applicable) multiplied by 100.

• Indicators: Allows you to choose which data series appear in the chart, such as variations of Risk, Factor Groups, Style
Groups, and more.

• Trends Chart: Allows you to visualize analyze ex-ante risk trends. The chart updates automatically to reflect your choices in
the other sections. If your changes do not appear immediately, press <Go>.

40 In trend analysis mode, the timeframe for the analysis (e.g., month-to-date [MTD] or year-to-date [YTD]).
41 — In the Tracking Error Summary , refers to how the risk numbers are scaled. For example, if Time Horizon is set to one

year, the risk statistics are annualized.
— In the VaR Main View, the risk forecast in number of business days. Bloomberg calculates a one-day VaR and scales

that number by multiplying it by the square root of the number of business days to include additional timeframes.
— In the Scenarios tab, allows you to analyze scenarios over several timeframes: one day, one week, one month, or one

year.
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Note:  To determine how portfolio risk changed over time, historical portfolio holdings must be uploaded in your portfolio. The
Bloomberg Uploader (BBU) and Creating/Updating Portfolios (PRTU) functions are used to load historical portfolio holdings.
For more information on uploading and maintaining your portfolios, see BBU <Help> and PRTU <Help>.

ANALYZING EXPOSURES

The Tracking Error Exposures sub-tab displays a table of risk model exposures in your portfolio. Risk model security exposures
are security-level factor exposures that are generated as part of the model estimation process and are used to estimate
security/portfolio risk.

For equities issued by the same company, including ADRs, multiple share classes, etc., PORT first determines the "parent"
security (which is based on the EQY_FUND_TICKER42  value). Next, PORT calculates all factor exposures for the parent and
copies these exposures to all "children," i.e., other securities issued by the same company.

To analyze exposures:

• To change the data that appears in the table, you can update the Asset Class43 , Display44 , Hide Zero Exposures45 , As

of46 , and Horizon47 fields.
 

 

The data updates automatically. The data in the table differs, depending on your selection. To learn more about the
exposure data, position your mouse over any column header.

• To view risk transparency details for a security, click any cell.
 

42 Specifies the ticker to access equity fundamental data for a company. The price data of the fundamental ticker is used
to compute most financial ratios which combine market data and equity fundamental data. If a company has several
listings/tickers, Bloomberg selects the fundamental ticker based on listing dates, country of domicile, and liquidity.

43 In the Tracking Error sub-tabs, allows you to filter factors by asset class.
44 In the Tracking Error Exposures sub-tab, allows you to filter the factor exposures that appear, such as market or industry.
45 In the Tracking Error tab, allows you to show or hide factors with zero exposure values.
46 The date for analysis. If the date is set to today, the analysis is based on current position's with the previous day's closing

prices. Analysis may be backdated up to 90 days.
47 — In the Tracking Error Summary , refers to how the risk numbers are scaled. For example, if Time Horizon is set to one

year, the risk statistics are annualized.
— In the VaR Main View, the risk forecast in number of business days. Bloomberg calculates a one-day VaR and scales

that number by multiplying it by the square root of the number of business days to include additional timeframes.
— In the Scenarios tab, allows you to analyze scenarios over several timeframes: one day, one week, one month, or one

year.

bbg://screens/HELP BBU
bbg://screens/HELP PRTU
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The information appears in another screen. For more information on risk transparency, see Risk Transparency Screen.
• To further analyze a security in a related function, right-click the name of the security and choose from the available options

in the menu.
 

 

For more information on each related function, see the related Help Page (e.g., EE <Help>, GP <Help>).

ANALYZING FACTOR P&L

In the Tracking Error-Factor P&L sub-tab, you can run factor-based performance attribution analysis for a specific date range
either on an absolute return basis or relative to a benchmark. The factor-based attribution looks at portfolio holdings over time,
calculates its exposures to Bloomberg factors, and then decomposes portfolio return into individual factor components, as well
as the non-factor return component.

Note:  Factor-based performance attribution is now available in the Attribution tab when you enable the Factor Based
attribution model. For more information, see Attribution Summary.

The Factor P&L sub-tab is divided into the following sections:
 

bbg://screens/HELP EE
bbg://screens/HELP GP
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• Charting Options: Allows you to choose the chart display (either cumulative bar or line chart) and specify a date range

for analysis (Time48 ) and the Horizon49. Start and end dates can only be set to the dates for which factor model data is
available. Currently, factor model data is generated on a weekly basis, based on each Wednesday's closing prices.

• Indicators: Allows you to choose which data series appear in the chart, such as variations of Risk, Factor Groups, Style
Groups, and more.

Note:  In some cases, the Unexplained option appears under the Total category. Unexplained is used to reconcile the
difference between PORT's daily calculation of Total Active Return and the weekly calculation of Factor and Non-Factor
Return numbers.

• Factor P&L Chart: Allows you to visualize factor-based performance attribution analysis. The chart updates automatically
to reflect your choices in the other sections. If your changes do not appear immediately, press <Go>.

VAR TAB

The VaR tab lets risk managers and portfolio managers analyze the risk of loss for their portfolios. Three types of VaR are
available:

• Parametric VaR

• Historical VaR

• Monte Carlo VaR

48 In trend analysis mode, the timeframe for the analysis (e.g., month-to-date [MTD] or year-to-date [YTD]).
49 — In the Tracking Error Summary , refers to how the risk numbers are scaled. For example, if Time Horizon is set to one

year, the risk statistics are annualized.
— In the VaR Main View, the risk forecast in number of business days. Bloomberg calculates a one-day VaR and scales

that number by multiplying it by the square root of the number of business days to include additional timeframes.
— In the Scenarios tab, allows you to analyze scenarios over several timeframes: one day, one week, one month, or one

year.
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The VaR methodology utilizes the factor structure provided by the Bloomberg factor models in a way that makes the VaR
consistent with portfolio tracking error and volatility, which are computed using the same factor models. For historical and
Monte Carlo VaR, an array of valuation choices are offered, ranging from linear pricing using the Bloomberg factor models to
Stress Matrix Pricing (SMP) and full valuation.

The VaR tab is divided into five sub-tabs, which allow you to perform more specific value-at-risk analysis:

• Main View: Allows you to break down your portfolio VaR by securities or groups. Data is absolute or relative to a
benchmark. For more information, see VaR Breakdown .

• VaR Comparison: Allows you to compare Monte Carlo, Historical, and Parametric VaR methodologies at different
confidence levels. For more information, see VaR Comparison .

• Distribution: Allows you to see the probability distribution of your portfolio's P&L in graphic and table form, based on
the VaR computation (relevant for Monte Carlo and Historical VaR simulations). For more information, see Analyzing
Distribution.

• VaR Simulations: Allows you to sort all Historical or Monte Carlo simulations by scenario ID, percentile, or P&L. All
simulations appear in table and chart form. For more information, see VaR Simulations .

• Factor Breakdown: Allows you to see all exposures and VaR contribution of individual risk model factors and factor
groups. For more information, see VaR Factor Breakdown.

Note:  For information on comparing portfolio and benchmark returns, see Benchmark Scaling.

VAR BREAKDOWN

The VaR Main View sub-tab allows you to break down your portfolio VaR by securities or groups. Data is absolute or relative to
a benchmark.

You can update the underlying assumptions by which VaR50  analysis is run, such as choosing one of Bloomberg's multi-risk
factor models to analyze your portfolio's ex-ante (predicted) risk. You can also choose a specific time horizon by which to
analyze the data. Data can be measured as P&L51  or % return.

To breakdown your portfolio VaR, update the Model52 , Unit53 , CLvl54 , As Of55 , and Horizon56  fields, then press <Go>.

50 Measured in currency units or as a % of market value, VaR measures the maximum loss projected given inputs for the
time horizon and confidence level. VaR can be measured on the portfolio, benchmark, or active/difference portfolio.

51 The portfolio's current profit or loss position. P&L is calculated as the portfolio's current value – the portfolio's value at
the prior market close.

52 • In the Tracking Error Summary and Trends sub-tabs, refers to multi-factor risk model that is used to estimate the
portfolio, benchmark, and active risk values. The model version is the date on which the model was generated.

• In the VaR and Scenarios tabs, the risk model you want to apply to your portfolio, typically the smallest geographical
region that covers the holdings in your portfolio.

For more information on Bloomberg's risk factor models, see Documents.
53 In the VaR and Tracking Error tabs, the units to display potential portfolio loss, which may be displayed as either a market

value (P&L) or percentage return (Return %).
54 See Confidence Level.
55 The date for analysis. If the date is set to today, the analysis is based on current position's with the previous day's closing

prices. Analysis may be backdated up to 90 days.
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The data updates and applies across all VaR sub-tabs.

VaR analysis is also available in chart form, accessed by clicking the expander bar on the right side of the screen. You can alter
data and graphic depictions by updating the Chart field.
 

 

Note:  When analyzing value-at-risk, there may be occasions when VaR%57  is greater than 100%. For leveraged portfolios,
such as long-short or portfolios with derivative instruments, portfolio VaR can be greater than the portfolio market value.
Thus, VaR% is greater than 100%. Currently, the factor model (and thus scenarios used in Monte Carlo and Historical) are
generated daily.

56 • In the Tracking Error Summary , refers to how the risk numbers are scaled. For example, if Time Horizon is set to one
year, the risk statistics are annualized.

• In the VaR Main View, the risk forecast in number of business days. Bloomberg calculates a one-day VaR and scales
that number by multiplying it by the square root of the number of business days to include additional timeframes.

• In the Scenarios tab, allows you to analyze scenarios over several timeframes: one day, one week, one month, or one
year.

57 VaR divided by portfolio market value. For leveraged portfolios, such as long-short or portfolios with derivative
instruments, portfolio VaR can be greater than the portfolio market value, and thus greater than 100%.
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VAR COMPARISON

In the VaR Comparison sub-tab, you can compare Monte Carlo, Historical, and Parametric VaR methodologies at different
confidence levels.

The VaR Comparison sub-tab is divided into three VaR analysis sections:
 

 

• VaR Summary: Displays the portfolio (or active portfolio if a benchmark is selected) level VaR for each methodology

(Monte Carlo, Historical and Parametric Stressed) at the selected Confidence Level58  (95, 97.5, and 99%). You can
update the Unit field in the control area to display potential portfolio loss in P&L, % return, or basis point values. The
Portfolio Value field displays the total portfolio market value in the reporting currency. You can click any cell to display a
portfolio or active breakdown in the Contributors table.

• Security Coverage: Provides a pie chart of the portfolio data captured by VaR analysis by number of securities (#Pos) or
market value (MV).

• Contributors: Displays a breakdown of the value selected in the VaR Summary section as well as the values for Marginal

VaR59 , Partial VaR60 , and Conditional VaR61. You can click the [+] to display portfolio components.

58 A measure of the degree of confidence for a random variable of interest. A confidence interval of X is defined as the
probability that, given the underlying distribution of the random variable, the set of possible outcomes lies in a range
greater than or equal to a pre-determined value. For example, a confidence level of 95% means that you are 95%
confident that the portfolio will be subject to no more than the maximum loss indicated by the VaR computation.

59 Measures the impact of a one hundred currency unit change in the position within the portfolio. For example, if the
portfolio is denominated in U.S. dollars, Marginal VaR is based on a one hundred dollar change.

60 Measures the impact of removing an entire position or aggregation (e.g., the entire financial sector) on the overall
portfolio VaR. This can be measured in P&L units or in %. If viewed in percent, the partial VaR expressed in P&L is
divided by the active/difference portfolio's market value at that particular node.

61 Abbreviated as CVaR in the VaR tab. Measures the expected loss in the underlying currency of the portfolio when the
confidence level is surpassed. This measure of tail risk is also called Expected Shortfall.
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To analyze VaR values, select a methodology and confidence value in the VaR Summary section. The Contributors table
updates.
 

 

ANALYZING DISTRIBUTION

In the VaR Distribution sub-tab, you can see the probability distribution of your portfolio's P&L in graphic and table form, based
on the VaR computation (relevant for Monte Carlo and Historical VaR simulations). Options at the bottom of the screen allow
you to choose which probability distribution information appears in the P&L distribution charts (Portfolio, Benchmark, and
Active data) as well as the data for corresponding levels in the confidence level table.

The Distribution sub-tab is divided into two main sections that allow you to quickly update distribution graphics:
 

For VaR methodologies Monte Carlo and Historical, the average of the P&L generated for each scenario located in the
tail of the distribution is used. This can be expressed in P&L and % terms. If expressed in percentage, the conditional
VaR in P&L is divided by the active/ difference portfolio market value at that node.
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• P&L Distribution Charts: Displays data for three probability distribution options, including the currently loaded portfolio

and benchmark and, depending on your Unit62  selection, active P&L63  or return.
• Confidence Level Table: Provides a spectrum of VaR scenarios proximal to the selected confidence level, as well as

related portfolio, benchmark, and active statistics (e.g., mean, standard deviation). The Pick Percentile drop-down menu
allows you display different scenarios for a selected percentile (e.g., 2.5%), which appears shaded white.

VAR SIMULATIONS

The VaR Simulations sub-tab allows you to sort all Historical or Monte Carlo simulations by scenario ID, percentile, or P&L. All
simulations appear in table and chart form.

If Historical VaR is selected and the sort is set-up to rank by scenario ID, you can see the P&L generated going back 1, 2, or 3
years, depending on the VaR method selected in the calculation defaults. For more information on setting your VaR calculation
defaults, see Risk Factor Calculation Defaults.

You can use the chart's zoom features to narrow your scenario analysis.
 

62 In the VaR and Tracking Error tabs, the units to display potential portfolio loss, which may be displayed as either a market
value (P&L) or percentage return (Return %).

63 The portfolio's current profit or loss position. P&L is calculated as the portfolio's current value – the portfolio's value at
the prior market close.
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If you sort by the P&L column, you can see all scenario level P&L numbers sorted from worst to best performing. With this
view, you can get a better sense of the symmetry - or lack of symmetry - in the distribution. P&L is the percentage return or
P&L generated on the portfolio for the corresponding scenario ID.

To sort by percentile or P&L, click the P&L column header.
 

 

VAR FACTOR BREAKDOWN

The VaR Factor Breakdown sub-tab allows you to see all exposures and VaR contribution of individual risk model factors and
factor groups.
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The Factor Breakdown sub-tab is divided into two factor analysis sections:
 

 

• Factor Navigator: Provides the factor breakdown at the portfolio level. You can select a factor value to see how it affects
your portfolio in the Portfolio Navigator section, or you can click a factor to access the correlation and variance/co-variance
matrix providing transparency into factors. For more information on factor transparency, see Factor Transparency. To see a
definition of the factor column, position your mouse over column header.

• Portfolio Navigator: Provides the portfolio breakdown of the selected factor value. You can click the expander bar to
show or hide this section.

In both sections, you can click the [+] to display more choices.

SCENARIOS TAB

The Scenarios tab allows you to stress-test your portfolio to see how your portfolio is impacted, determine which scenarios
are best or worst for your portfolio, and drill down into your portfolio holdings to see numerical and graphical depictions of how
holdings perform within a given scenario.

The Scenarios tab is divided into four sub-tabs, which allow you to perform increasingly deeper analysis of your portfolio's
performance under different stress scenarios:

• Main View: Allows you to choose the scenario against which to stress your portfolio. For more information, see Stressing
Scenarios.

• Scenario Summary: Allows you to see your portfolio's summary values across every scenario, including P&L, P&L
percentage, stressed market value, convexity, duration, and more. For more information, see Scenario Summary.

• Best & Worst: Displays the best/worst scenarios as well as the best/worst securities and groups in your portfolio across
all scenarios. For more information, see Best & Worst.

• Scenario Navigator: Displays a matrix of all scenarios and their impact on your portfolio's P&L. For more information, see
Scenario Navigator.
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STRESSING SCENARIOS

The Scenarios Main View sub-tab allows you to choose the scenario against which to stress your portfolio. Bloomberg
provides pre-defined historical and hypothetical stress scenarios, such as the Lehman Brothers default of 2008 (historical), a
sharp decline (10% of value) of equities (hypothetical), or a 25 to 200 bps shift on interest rates (hypothetical).

To stress a scenario, update your stress parameters in the Model64 , Set65 , Show66 , As Of67 , and Horizon68  fields, then
press <Go>.
 

 

The columns adjacent to the Name column update to reflect the selected scenarios and parameters.

If you want to stress your own hypothetical or historical scenario, you must first create the scenario using the Scenario
Manager, which can be accessed from the Set field. For more information on the Scenario Manager, see Scenario Manager.
 

64 • In the Tracking Error Summary and Trends sub-tabs, refers to multi-factor risk model that is used to estimate the
portfolio, benchmark, and active risk values. The model version is the date on which the model was generated.

• In the VaR and Scenarios tabs, the risk model you want to apply to your portfolio, typically the smallest geographical
region that covers the holdings in your portfolio.

For more information on Bloomberg's risk factor models, see Documents.
65 The set (group) within which your scenario resides. Bloomberg Stress Scenarios provides a default set of stress

scenarios.
66 Allows you to show the valuation columns calculated for all scenarios in the set or for one scenario as selected in the

adjacent field.
67 The date for analysis. If the date is set to today, the analysis is based on current position's with the previous day's closing

prices. Analysis may be backdated up to 90 days.
68 • In the Tracking Error Summary , refers to how the risk numbers are scaled. For example, if Time Horizon is set to one

year, the risk statistics are annualized.
• In the VaR Main View, the risk forecast in number of business days. Bloomberg calculates a one-day VaR and scales

that number by multiplying it by the square root of the number of business days to include additional timeframes.
• In the Scenarios tab, allows you to analyze scenarios over several timeframes: one day, one week, one month, or one

year.
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Note:  You can access previous calculations of the Main View sub-tab in the Stored Results section. For more information on
analyzing the results monitor, see Analytic Results Monitor.

SCENARIO SUMMARY

The Scenario Summary sub-tab allows you to analyze scenario summary values for factor model and full valuation methodology
scenarios. Depending on the type of scenario you are running, the sub-tab calculates the portfolio's profit and loss, P&L
percentage, stressed market value, cash flow, option adjusted spread, duration, or convexity across each scenario.

The Scenario Summary sub-tab is divided into two scenario analysis sections:
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• Scenario Summary: Displays the list of scenarios selected in the Set field and their associated summary values. If the

scenario uses the factor model methodology, the summary values include P&L69 , P&L %70 , and Stress MV71 . If the

scenario uses the full valuation methodology, the summary values include P&L72 , P&L %73 , Stress MV74 , Cashflow75 ,
Option Adjusted Spread (OAS)76 , Duration77 , and Convexity78 .

69 The portfolio's current profit or loss position. P&L is calculated as the portfolio's current value – the portfolio's value at
the prior market close.

70 In the Scenario Summary sub-tab, the profit or loss generated on the portfolio (or active portfolio if a benchmark is
selected) in the stated portfolio currency expressed as a percent of market value, given the applied scenario.

71 In the Scenario Summary sub-tab, the new market value of the portfolio (or active portfolio if a benchmark is selected)
taking into account any profit or loss generated, given the applied scenario.

72 The portfolio's current profit or loss position. P&L is calculated as the portfolio's current value – the portfolio's value at
the prior market close.

73 In the Scenario Summary sub-tab, the profit or loss generated on the portfolio (or active portfolio if a benchmark is
selected) in the stated portfolio currency expressed as a percent of market value, given the applied scenario.

74 In the Scenario Summary sub-tab, the new market value of the portfolio (or active portfolio if a benchmark is selected)
taking into account any profit or loss generated, given the applied scenario.

75 The cash flow for the portfolio attributed to the scenario as of the horizon date.
76 The option adjusted spread. The flat spread that must be added to the yield curve in a pricing model to discount a

security payment to match its market price.
77 The first order derivative measurement of the sensitivity of bond price to changes in interest rate. In general, the higher

the duration, the more sensitive the bond price is to interest rate movements. Duration is calculated by holding the base
case option adjusted spread (OAS) constant while the par swap curve is shifted up or down 25 bps and the price is
recomputed.

78 The second derivative of a security's price with respect to its yield, divided by the security's price. A security exhibits
positive convexity when its price rises more for a downward move in its yield than its price declines for an equal upward
move in its yield.
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• Scenario Chart: Displays the given scenarios' P&L% in a chart. You can annotate the chart for further analysis. The chart
is not affected if you sort the data in the Scenarios Summary section.

BEST & WORST

The Scenarios Best & Worst sub-tab displays the best/worst scenarios as well as the best/worst securities and groups in your
portfolio across all scenarios. The filters allow you to conduct deeper stress analysis in the Best & Worst table:
 

 

• Best/Worst Filters: Allows you to choose the filter in the Position field and compare the best or worst performing sectors
or securities against the applied Set, which you select in the Level field.

• Scenarios / Positions: Displays the list of scenarios selected in the Set field and the associated best or worst positions.
• Positions Details: Provides an in-depth view into the best or worst performing aggregation or security across each of

the scenarios in your set. This allows you to quickly identify trends and spot securities that may consistently underperform,
given the variety of scenarios in your set.

SCENARIO NAVIGATOR

The Scenario Navigator sub-tab displays a matrix of all scenarios and their impact on your portfolio's P&L. The sub-tab is
divided into two main sections that provide the portfolio impact at a quick glance:
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• Portfolio Navigator: Provides a sector breakdown of your portfolio, reflecting the impact of the selected scenario.

When you choose a scenario from the Scenario Set Navigator, the Portfolio Navigator section calculates the impact of the
scenario on the P&L attributed to each sector represented in your portfolio.

• Scenario Set Navigator: Displays the scenario breakdown at the portfolio level (displayed immediately below the
Scenario Set Navigator text; e.g., Top). You can select a value in the table to see its portfolio breakdown. The Market Value
displays the market value of the portfolio at the selected level.

Example: In the image above, we can see that, stressed against the Greek Financial Crisis of 2010, the P&L79  for the
portfolio on the whole increased by 1,780 points, thanks mostly to financial holdings. On the whole, however, the industrial
holdings in the portfolio declined by over 3,500 points in the face of a Greek economic calamity.

PERFORMANCE TAB

The Performance tab allows you to view the historical performance of your portfolio with multiple total return periods as of a
specific date, such as 1-day return, 1-month return, and YTD return. You can also analyze historical risk/return behavior with
measures, including standard deviation, beta, and tracking error.

The Performance tab is divided into five tabs, which allow you to perform more specific performance analysis:
• Main View: Displays a breakdown of your portfolio historical performance and realized risk by securities and groups. For

more information, see Performance Analysis by Date.
• Total Return: Displays charts of cumulative, absolute, and relative performance data of your portfolio over an historical

timeframe. For more information, see Total Return.
• Period Analysis: Displays the frequency and persistence of the positive/negative return behavior of the fund over a

selected timeframe. For more information, see Period Analysis.
• Seasonal Analysis: Displays the monthly absolute or relative performance return of the portfolio over an historical

timeframe. For more information, see Seasonal Analysis.

79 The portfolio's current profit or loss position. P&L is calculated as the portfolio's current value – the portfolio's value at
the prior market close.
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• Statistical Summary: Displays compilations of return, risk, and risk/return calculations for your portfolio and benchmark (if
applicable) across various time periods. For more information, see  Statistical Summary.

You can analyze historical returns using the holdings-based or transactions-based method. For more information on historical
returns methodologies, see Historical Returns.

PERFORMANCE ANALYSIS BY DATE

The Main View sub-tab displays a breakdown of your portfolio historical performance and realized risk by securities and
groups. You can choose a date for which you want to see data by updating the As Of field.
 

 

To display definitions of the performance valuation, position your mouse over column headers.

You can add P&L indicators to your Main View sub-tab analysis, so you can analyze your portfolio's profit & loss80  during the
analysis period. For information on adding field indicators to the portfolio display, see Adding/Removing Fields.

Note:  You can access previous calculations of the Main View sub-tab in the Stored Results section. For more information on
analyzing the results monitor, see Analytic Results Monitor.

TOTAL RETURN

In the Performance Total Return sub-tab, you can see two charts of cumulative, absolute, and relative performance data of your
portfolio over an historical timeframe.

If you have a benchmark loaded, two charts appear. To analyze performance total return data, update the timeframe options

(Time81 , Freq82 , and the date range) and the Total Return %83  and Value84 fields. The top chart displays both portfolio and
benchmark performance data, while the bottom chart displays portfolio and benchmark relative performance data.
 

80 The estimated amount earned or lost on positions held in the portfolio over the stated timeframe, as of the date of
analysis. P&L is calculated using end of day prices and is expressed in the portfolio currency.

81 In trend analysis mode, the timeframe for the analysis (e.g., month-to-date [MTD] or year-to-date [YTD]).
82 Allows you to choose the frequency for trend and period analyses (Daily, Weekly, Monthly, etc.).
83 The total return over the stated timeframe as of the date of analysis, expressed as a percentage.
84 The value of specific components. In various tables, this is the percentage weight of the security in the portfolio.

InTracking Error Exposures , a composite value metric that differentiates between “rich” and “cheap” stocks. Bloomberg
combines fundamental and analyst consensus data for this factor.
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Note:  If you do not have a benchmark loaded, a single chart of your portfolio's performance appears.

PERIOD ANALYSIS

The Performance Period Analysis sub-tab displays the frequency and persistence of the positive/negative return behavior of
the fund over a selected timeframe. You can analyze either absolute or relative total return data.

The Period Analysis sub-tab is divided into the following analytic sections:
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• Period Analysis: Displays the frequency and persistence of the positive/negative return behavior of the fund over the
selected timeframe.

• Best-Worst: Displays the three best/worst performance return(s) and corresponding date(s) of occurrence for the fund
over the selected timeframe.

• Period Chart: Displays your total return or relative total return data in graphical form.

To analyze period analysis data, update the Time85  field and select whether you want to evaluate the Total Return %86  or the

Relative Total Return %87 .
 

 

Note:  If you select Relative Total Return, you can select the Relative Chart option above the total return chart to enhance the
relative total return data.

 

 

Depending on whether you are analyzing total return or relative total return, the columns that appear in the Period Analysis and
Best-Worst tables vary. The tables below list the fields and their corresponding definitions.

Period Analysis: If you select Total Return, the following columns may appear:

85 In trend analysis mode, the timeframe for the analysis (e.g., month-to-date [MTD] or year-to-date [YTD]).
86 The total return over the stated timeframe as of the date of analysis, expressed as a percentage.
87 Portfolio Total Return - Benchmark Total Return over the stated timeframe, expressed as a percentage.
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Field Definition

Up Represents the periods where the fund experienced positive returns.

Down Represents the periods where the fund experienced negative returns.

Total Displays the total for each analytic during the fund's up and down periods.

If you select Relative Total Return, the following columns may appear:

Field Definition

Winning The positive returns of the fund against the index benchmark.

Losing The negative returns of the fund against the index benchmark.

Coherent The instances when the fund and the index benchmark both return positive or negative.

Incoherent The instances when the fund returns negative and the index benchmark returns positive and
vice versa.

Best-Worst: If you select Total Return, the following columns appear:

Field Definition

Performance The best and worst three total return values for the fund.

Date The date of the best and worst three total return values for the fund.

If you select Relative Total Return, the following columns appear:

Field Definition

Difference Represents the top three dates on which the portfolio's return outperformed the benchmark's
return and the bottom three dates on which the portfolio's return underperformed the
benchmark's return.

Portfolio Perf The total return of the portfolio on the three top and bottom dates for portfolio versus
benchmark analysis.

Bench Perf The total return of the benchmark on the three top and bottom dates for portfolio versus
benchmark analysis.

Date The date of the top and bottom three comparisons between the portfolio and benchmark
values.
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SEASONAL ANALYSIS

The Performance Seasonal Analysis sub-tab displays the monthly absolute or relative performance return of the portfolio over a
selected timeframe.

The Seasonal Analysis sub-tab is divided into two main sections that display seasonal returns at a glance:
 

 

• Return Values: Provides return values, broken down by years and months. Three colors appear in the data table:

— Red: The minimum (lowest) number for the period under analysis.
— Green: The maximum (highest) number for the period under analysis.
— White: Averages of all values in that month.
 

 

• Seasonal Returns Chart: Provides a graphical depiction of the return values. An upward bar in the chart indicates a
positive return while a downward bar indicates a negative return.
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To analyze seasonal analysis data, update the Time88 , Total Return %89 , and Relative Total Return %90  fields.

 STATISTICAL SUMMARY

The Performance Statistical Summary sub-tab displays compilations of return, risk, and risk/return calculations for your
portfolio and benchmark (if applicable) across various time periods.

Note:  For historical equity portfolios, return attribution is enabled.

The Statistical Summary sub-tab is divided into the following statistical sections:
 

88 In trend analysis mode, the timeframe for the analysis (e.g., month-to-date [MTD] or year-to-date [YTD]).
89 The total return over the stated timeframe as of the date of analysis, expressed as a percentage.
90 Portfolio Total Return - Benchmark Total Return over the stated timeframe, expressed as a percentage.
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• Portfolio Statistics: Allows you to analyze risk and return statistics.
— Return: Total Return91 , Relative Total Return92 , Maximum Drawdown93 , Maximum Increase94 , among others.
— Risk: Standard Deviation (Annualized)95 , Kurtosis96 , Skewness97 , Bear Tracking Error (Annualized)98 , among

others.
— Risk/Return: Sharpe Ratio99 , Jensen Alpha100 , Treynor Measure101 , R-Squared102 , Capture Ratio103 , among

others.
For more information on the data points in the Portfolio Statistics column, see Definitions.

• Time Periods: Displays portfolio and benchmark (if applicable) data for set time periods: 3 Months, 6 Months, Year to
Date, and a custom option. If no benchmark is selected, no Bench column appears.

91 The total return over the stated timeframe as of the date of analysis, expressed as a percentage.
92 Portfolio Total Return - Benchmark Total Return over the stated timeframe, expressed as a percentage.
93 The largest drop from a peak to a bottom in a sub-period over the stated timeframe. It measures the magnitude of the

worst loss an investor could have incurred by investing in the portfolio or benchmark.
94 The largest gain from a bottom to a peak in a sub-period over the stated timeframe. It measures the magnitude of the

best gain an investor could have incurred by investing in the portfolio or benchmark.
95 A measure of the volatility of the daily total returns over the stated timeframe, expressed as an annualized percentage. It

measures how widely spread the daily returns are within the period. Larger values suggest greater risk.
96 Kurtosis measures the peakedness or flatness of the daily return distribution over the stated timeframe. In a flat

distribution, the average value is more likely to occur.
97 Skewness measures the degree of asymmetry of the daily return distribution over the stated timeframe. If the left tail

(tail at small end of the distribution) is more pronounced than the right tail (tail at the large end of the distribution), the
return is said to have negative skewness. If the reverse is true, it has positive skewness. If the two are equal, it has zero
skewness.

98 The standard deviation of the daily excess returns relative to the benchmark over the stated timeframe, only on days
when the benchmark return was negative, expressed as an annualized percentage.

99 A risk-adjusted measure that calculates the excess return over the risk free rate (3-month yield linked to the currency),
per unit of volatility. [(Annualized Mean Return - Risk Free Rate) / Annualized Standard Deviation of Returns]. The higher
the Sharpe ratio, the better the portfolio's historical risk-adjusted performance. Calculated using daily returns over the
stated timeframe.

100 A risk-adjusted measure that calculates the actual return of the portfolio over and above the return predicted by the
Capital Asset Pricing Model (CAPM), given the portfolio's beta and the benchmark return. [ Portfolio Return - ( Risk Free
Rate + Beta x ( Benchmark Return - Risk Free Rate ) ) ]. Calculated using the annualized mean of daily returns of the
portfolio and benchmark over the stated timeframe.

101 A risk-adjusted measure that calculates the excess return over the risk free rate (3-month yield linked to the currency),
per unit of Beta relative to the benchmark. [(Annualized Mean Return - Risk Free Rate) / Beta]. The higher the Treynor
ratio, the better the portfolio's historical risk-adjusted performance. This is useful for assessing the excess return from
each unit of systematic risk. Calculated using daily returns over the stated timeframe.

102 A measure of how well the portfolio's performance correlates with the performance of the benchmark, and thus
a measure of what portion of its performance may be explained by the performance of the benchmark. Values for
R-Squared range from 0 to 1, where 0 indicates no correlation and 1 indicates perfect correlation. Calculated using daily
returns over the stated timeframe.

103 A measure of how well the portfolio is performing relative to the benchmark. Defined as the ratio of the portfolio return to
the benchmark return, calculated on a daily basis and averaged over the selected timeframe.
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You can analyze statistical summary data:
• To change the time period in the last column, click the timeframe drop-down menu and select from the available options

(e.g., 2 Years).
 

 

If you select Custom, the Edit Timeframe window appears where you can specify the number of days, weeks, months,
quarters, or years (e.g., 9 months, 5 years).

The last column in the table updates to reflect your changes.
• To see expanded lists of corresponding performance data, click the Return, Risk, or Risk/Return category in the Portfolio

Statistics column.

In the Statistical Summary sub-tab, the following indicators are annualized by default:

Annualized Indicators Annualized Indicators

Mean Return Bull Mean Excess Return

Mean Excess Return Bear Mean Excess Return

Semivariance Bull Tracking Error

Standard Deviation Bear Tracking Error

Tracking Error Downside Risk

ATTRIBUTION TAB

The Attribution tab allows you to deconstruct the sources of your portfolio's historical return on an absolute or relative basis.

Depending on whether you are analyzing an equity or fixed income portfolio, the Attribution tab is divided into two or three
sub-tabs, which allow you to perform more specific attribution analysis:
• Main View: Allows you analyze attribution data over a given timeframe. You can also monitor the statuses of analysis

reports, as well as retrieve previously run reports. For more information, see Attribution Analysis.
• Summary: Displays a summary of the attribution of your portfolio's active returns (for both equities and fixed income). You

can deconstruct the sources of your portfolio's historical return on an absolute or relative basis. For more information, see
Attribution Summary.

• Curve Return: Allows you to analyze return contributions due to yield curve bets for fixed income portfolios. For more
information, see Curve Return.

• Trends: Provides a visualization of the factor-based attribution of the portfolio return for the selected timeframe. For more
information, see Trends Analysis.
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You can analyze historical returns using the holdings-based or transactions-based method. For more information on historical
returns methodologies, see Historical Returns.

ATTRIBUTION ANALYSIS

In the Attribution Main View sub-tab, you can analyze attribution data over a given timeframe.

Attribution analysis is partly determined by the attribution methodology (Model) and unit expression (Unit) selections, which
you can choose when customizing your attribution calculation defaults.
 

 

Note:  For more information on customizing your attribution methodology and return unit expressions, see Attribution
Calculation Defaults.

To analyze attribution data:

From the control area, click the Time drop-down menu and select an option (e.g., quarter to date - QTD), then press <Go>.

The data updates.
|Hint| If you select Custom, you can enter a start and end date for your analysis in the calendar fields.

PORT provides full transparency into exactly how total return is calculated for any time period. To display data transparency,
right-click the portfolio or benchmark and select Explain Return Calculation.
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A complete day-by-day breakdown of total return calculations appears in another window.

Note:  You can access previous calculations of the Main View sub-tab in the Stored Results section. For more information on
analyzing the results monitor, see Analytic Results Monitor.

ATTRIBUTION SUMMARY

The Attribution Summary sub-tab displays a summary of the attribution of your portfolio's active returns. You can deconstruct
the sources of your portfolio's historical return on an absolute or relative basis.

By default, the Attribution tab uses the Brinson-Fachler Total Return Attribution model. Depending on the type of portfolio
(e.g., equity or fixed income) and the selected attribution model (e.g., Brinson, Excess Return, Factor Based), the Summary
sub-tab displays different data. This topic describes the possible screen elements that may appear.

Note:  For more information on setting up your attribution calculation method, see Attribution Calculation Defaults.

Attribution Summary for Equity Portfolios: For equity portfolio analysis using most models, the Summary sub-tab is
divided into the following sections.
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• Portfolio Summary: Displays a summary of inputs to the analysis, including the selected benchmark (if any), attribution
method (Model), and date range, all of which you can update. You can position your cursor over the fields to display
definitions.

• Return Summary: Displays total return values for your portfolio and benchmark, active return (Portfolio Return minus
Benchmark Return), and the contribution of different effects on the active return. You can position your mouse over each
field to display an explanation. For detailed definitions of the terms, see Definitions.

• Excess Return Chart: Displays excess return results broken down by average active weight (left) and total attribution
(right) over the course of the selected timeframe. The charts are further broken down by your breakdown selection (e.g.,
GICS sectors). At the bottom of the chart, you can choose to display Allocation Effect104 , Selection Effect105 , Currency

Effect106 , and/or Interaction Effect107 . You can position your cursor over the bars in the chart to display more details of the
data.

 

104 The active return attributed to asset allocation decisions (e.g., sectors, countries, or market caps) that differ from the
benchmark. The allocation is generally positive when the fund is overweight for a sector in which the benchmark return
exceeds the total benchmark return.

105 The active return attributed to security selection decisions that differ from the benchmark. When the portfolio sector
returns exceed the benchmark return, a positive number is posted.

106 The active return due to currency exposures that differ from the benchmark.
107 The interaction between the weighting and the selection effects, which does not represent an explicit decision of the

investment manager.
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To see attribution effects in the total attribution chart, select the appropriate checkbox at the bottom of the screen.

Attribution Summary for Fixed Income Portfolios: Depending on which attribution calculation method you have loaded
for fixed income analysis, the Summary sub-tab displays different data. The selected calculation method appears in the
portfolio summary section.
 

 

If you are using the Total Return (Brinson) model, the sub-tab is divided into the same sections as that of an equity portfolio
analysis (portfolio summary, return summary, and excess return chart). For more information, see above.

If you are using the Excess Return or Spread Return models, the following sections appear:
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• Portfolio Summary: Displays a summary of the inputs to your analysis, including the selected benchmark, attribution
method, pricing source (e.g., BVAL else Custom), type of curve, and date range, all of which you can update. You can
position your cursor over the fields to display definitions.

• Return Summary: Displays total return values for your portfolio and benchmark, active return (Portfolio Return minus
Benchmark Return), and the contribution of different effects on the active return. You can position your mouse over each
field to display an explanation. For detailed definitions of the terms, see Definitions.

• Duration Statistics: Displays your portfolio and benchmark contributions to duration and their difference, as well as yield
curve changes (in percentage) over each tenor.

• Excess Return Chart: Displays excess return data. You can click the drop-down menu in the top-right corner of the chart
to see a breakdown of each contribution to excess return (such as allocation or selection effect). You can position your
cursor over the bars in the chart to display more details.

If you are using the Factor Based model, the following sections appear:
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• Portfolio Summary: Displays a summary of the inputs to your analysis, including the selected benchmark, attribution
method, risk model, and date of analysis, all of which you can update. You can position your cursor over the fields to display
definitions.

• Return Summary: Displays total return values for your portfolio and benchmark, active return (Portfolio Return minus
Benchmark Return), and the contribution of different effects and factors on the active return. You can position your mouse
over each field to display an explanation. For detailed definitions of the terms, see Definitions.

• Factor Returns Chart: Provides a chart of the factors and factor groups contributing to your portfolio active return, either
positive or negative. You can drill down into each factor group, so you can visualize the contribution of individual factors.

• Factor Contributions: Allows you to review the top or bottom six factors contributing to your portfolio active return.
The top factors have the highest positive contribution to your portfolio return, while the bottom factors have the lowest
contribution to your portfolio return (this may be negative or positive). You can select a factor in the table to access
the Factor Transparency window, where you can analyze and validate factor risk values. For more information on factor
transparency, see Factor Transparency.

CURVE RETURN

The Attribution Curve Return sub-tab allows you to analyze return contributions due to yield curve bets for fixed income
portfolios.

Note:  Curve return is computed only for a portfolio vs. benchmark attribution using an Excess Return or Spread Return
attribution model.

The Curve Return sub-tab is divided into the following sections, which help you analyze curve return at a glance:
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• Portfolio Summary: Displays a summary of your portfolio analysis, including the selected benchmark, attribution method,

pricing source (e.g., BVAL else Custom), type of curve, and date of analysis, all of which you can update. You can position
your cursor over the fields to display definitions.

• Active Curve Change: Displays the currency being analyzed (in white), parallel and non-parallel shift options (if
applicable), tenors of different bonds, and Convexity108  (at the bottom of the column). Measures the change at each
maturity point on the yield curve and correspondingly how much you out- or underperformed the index, based on your
relative interest rate exposure at each point on the curve.

Note:  For more information on including or removing a parallel shift for analysis, see Attribution Calculation Defaults.
• Active Curve Carry: Measures the risk-free income you earned versus the benchmark, based on your relative exposure

at each maturity point on the yield curve. The last column, Curve Return, is calculated by adding Curve Change + Curve
Carry. The curve change and curve carry values appear in the final column of the Active Curve Change and Active Curve
Carry sections, respectively.

• Curve Return Chart: Displays the curve return values (minus convexity).

To analyze a different currency in your fixed income portfolio, from the Curve Return Currency drop-down field, select a
currency.
 

108 The second derivative of a security's price with respect to its yield, divided by the security's price. A security exhibits
positive convexity when its price rises more for a downward move in its yield than its price declines for an equal upward
move in its yield.
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TRENDS ANALYSIS

The Attribution Trends sub-tab allows you to see how returns and return attribution has changed over time. This tab appears if
your portfolio analysis uses the Factor Based attribution model.

The Trends sub-tab is divided into a side panel on the left where you can select the indicators that appear in the chart on the
right. The portfolio summary provides details on the portfolio you are analyzing and allows you to update chart parameters.
 

 

• Portfolio Summary: Displays a summary of the inputs to your analysis, including the selected benchmark, attribution
method, risk model, and date range, all of which you can update. You can position your cursor over the fields to display
definitions.

• Indicators Side Panel: Allows you to select the return indicators you want to illustrate in the trends chart. You can
compare the contribution to return amongst all the factors affecting portfolio return. By default, the Total indicators are
selected, along with the top five contributors to factor returns based on absolute value.

• Trends Chart: Provides a visualization of the factors contributing to your overall portfolio return over time. By default, the
highest contributing factors appear in the trends chart, so you can quickly see your general portfolio return attribution. You
can update the chart analysis timeframe in the portfolio summary section, so you can compare the historical movements of
factor contribution.

To select a different factor to compare in the chart, from the side panel, drill down into the Indicators list and select the factors
you want to analyze.

TRADE SIMULATION

PORT's Trade Simulation functionality allows you to select and edit hypothetical trading positions for your portfolio to assess
the impact these moves may have on your portfolio. You can save and modify these portfolios at a later date.

Note:  Trade Simulation is not available for PORT Launchpad.
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You can also exclude a portion of your portfolio and benchmark from analysis, such as cash, a sector, or a specific instrument,
to see how the performance or characteristics of the portfolio would differ with these exclusions. For more information, see
Excluding Securities.

When Trade Simulation is enabled, "TRADE SIMULATION ENABLED" appears in the top-left corner of the screen and new
menu and column options appear. For more information on enabling/disabling Trade Simulation, see Enabling Trade Simulation
and Customizing Trade Simulation.

The Trade Simulation menu appears just below the toolbar. The following menu options appear:
 

 

• Optimizer: Quickly access the Portfolio Optimization tool. For more information, see Portfolio Optimization.
• Trades: Access the trades you are simulating.
• Add Holdings: Add new securities to your portfolio, edit existing holdings, and recalculate (to refresh the analytics). For

more information, see Managing Positions & Cash.
• Save/Trade: Save your Trade Simulation scenario as a portfolio, commit or clear trades, show trades only, or export trades.

For more information on these options, see Saving Simulated Trades, Saving Simulated Trades As, and Clearing Simulated
Trades.

• Settings: Customize certain settings of Trade Simulation, taking advantage of additional flexibility of the tool. For example,
if you regularly use Trade Simulation, you can automatically enter into Trade Simulation mode each time you access PORT.
You can also control which columns appear by default, as well as fund recalculations from your cash (as allocated in PRTU)
or from your holdings. For more information, see Customizing Trade Simulation.

•
: Exit Trade Simulation mode, returning to your original portfolio holdings. Trade Simulation trades that have not been

cleared or committed will reappear next time you enable Trade Simulation.

Depending on your settings, the second column is either Simulated Wgt (%) or Orig Wgt (%). The image below illustrates the
new Trade Simulation columns in the Holdings tab.
 

 

The following table describes the available Trade Simulation columns:
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Column Allows you to

Inc (Security Inclusion) Select securities to include in a rebalance. Securities not selected are not targeted and do
not change in a sector-level rebalance or in a rebalanced fund from holdings.

Simulated Wgt Enter a new weight for rebalancing to generate hypothetical trades and analyze in the
resulting portfolio.

Orig Pos Enter a new position (number of holdings) for recalculation to generate hypothetical trades
and analyze the resulting portfolio.

Orig Wgt (%) See the market weight of a security in the original portfolio without Trade Simulation Enabled
trades applied. This column should be used as a reference, as Trade Simulation analytics
change.

Wgt +/- (%) See the difference in market value weight when Trade Simulation trades are applied to the
original portfolio. This column should be used as a reference, as Trade Simulation analytics
change. This value updates only when the portfolio is recalculated and does not update
immediately when targets are changed.

Buy/Sell See Trade Simulation trades that result from specified targets. This column should be used as
a reference as Trade Simulation analytics change. This value updates only when the portfolio
is recalculated and does not update immediately when targets change.

For more information on setting up the second column, see Customizing Trade Simulation.

At the bottom of the screen, the Turnover109 field indicates, in percentage terms, the difference between the original portfolio
and the portfolio with Trade Simulation trades applied.
 

 

The value is calculated as:

(mktval of buys + mktval of sells) / (2 * portfolio mktval)

109 The value of simulated buys plus the value of simulated sells excluding cash, divided by the original portfolio value. This
is expressed in percentage terms.

Note:  Turnover is only available within Trade Simulation and Portfolio Optimization. In Trade Simulation mode, Turnover
appears at the bottom of each tab's Main View sub-tab. In Portfolio Optimization, Turnover can be used as either a goal
or a constraint in the Optimization Setup, and the resulting Turnover value appears on the Trades results tab after the
Optimization task has been run.
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ENABLING TRADE SIMULATION

You can enable or disable Trade Simulation analysis from any tab in PORT.

To enable Trade Simulation analysis:

• From the toolbar, select Trade Simulation > Simulate Trades.

The Trade Simulation menu appears at the top of the screen, just below the toolbar. You are now in Trade Simulation mode.
 

 

To disable Trade Simulation analysis:

•
Click the remove ( ) icon on the far right of the Trade Simulation menu.

- or -
• From the toolbar, deselect Trade Simulation > Simulate Trades.

— If all of your target edits are saved or recalculated, the Trade Simulation menu disappears. You are no longer in Trade
Simulation mode.

— If your target edits are not saved or have not been recalculated, a Warning window appears indicating that targets have
been edited without rebalancing.

CUSTOMIZING TRADE SIMULATION

You can customize certain settings of your Trade Simulation analysis, taking advantage of additional flexibility of the tool. For
example, if you regularly use Trade Simulation Analysis, you can automatically enter into Trade Simulation mode each time you
access PORT. You can also control which columns appear by default.

To customize Trade Simulation analysis settings:

1. With Trade Simulation analysis enabled, click the Settings button.
 

 

The Trade Simulation Settings window appears and displays a list of customizable options.

2. Select any of the following options:
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• Target: Choose to enter hypothetical target Weights or Positions for your portfolio to assess how these moves would
impact your portfolio.

Note:  Depending on your settings, the second column will either be Orig Wgt (%) or Orig Pos. The column
immediately to the right of the Orig Wgt (%) or Orig Pos column displays the original weight percentage (Wgt %) or
position for your reference.

• Fund from: Choose to fund recalculations from cash (as allocated in PRTU) or from your portfolio holdings.
— Cash: Indicates that cash holdings in the portfolio are used to purchase the target quantity of each security as

specified in the Orig Wgt (%) or Orig Pos column. If the total of all targets in the portfolio exceeds the value of the
portfolio, the cash position will be negative to maintain the market value of the portfolio. Analytics refresh using the
new Trade Simulation portfolio holdings.

— Holdings: Indicates that portfolio holdings are sold off to purchase the target quantity of each security as specified
in the Orig Wgt (%) column. Securities will be sold off based on current market weight (heaviest first). If the target
holdings are lower than the previous holdings, securities will be purchased to compensate. Analytics refresh using
the new Trade Simulation portfolio holdings.

Note:  This option is not available if your Target is set for Positions.
• Enable Trade Simulation on Startup: Select to enable Trade Simulation analysis mode each time you access PORT.
• Show Additional Trade Simulation Columns: Select to see columns specific to Trade Simulation, such as Orig Wgt

(%) or Orig Pos, by default. For more information on Trade Simulation columns, see the table in Trade Simulation.
• Rebalance against Reporting Currency: Select to indicate that all cash generated from sells (or required for buys) is

taken from the reporting currency110  specified in the PORT analysis, not the local currency111  of the portfolio.

110 The currency used in the analysis, as indicated by the selection in the Curr drop-down menu of any Main View sub-tab.
By default, the currency under analysis is the portfolio base currency.

111 Generally, Currency indicates the currency of the portfolio being analyzed. In the Attribution Summary sub-tab, Currency
indicates the active return due to currency exposures that differ from the benchmark.
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• Clear Simulated Trades Overnight: Remove simulated trades from your portfolio at the end of the trading day.

Note:  You can only clear Trade Simulation trades that have NOT been saved to your portfolio. Once Trade Simulation
trades are saved (using the Save option), trades can only be removed using the Creating/Updating Portfolios (PRTU)
function. For more information, see PRTU <Help>.

• Simulate Trades on Current-Day Only: Limit Trade Simulation to the current day, meaning no historical trades can
be simulated. When Trade Simulation is enabled and this option is selected, existing historical trades are automatically
cleared. For more information, see Simulating Historical Trades.

• Equity Round Lots: Enter the round lot shares in which you want to trade equities. Round lots usually involve at least
100 shares of stock or five bonds. A deal involving less than 100 shares is considered an odd lot transaction.

• Derivative Round Lots: Enter the round lot shares in which you want to trade derivatives. Round lots usually involve at
least 100 shares of stock or five bonds. A deal involving less than 100 shares is considered an odd lot transaction.

• FI Min Piece: Enter the minimum initial fixed income position that can be purchased.
• Increment: Enter the number of positions that can be added to the FI Min Piece.

3. Click the Save button.
Your Trade Simulation analysis settings are saved.

For more information on managing your positions and Trade Simulation trades, see Managing Positions & Cash, Saving
Simulated Trades, Saving Simulated Trades As, and Clearing Simulated Trades.

MANAGING POSITIONS & CASH

You can add hypothetical positions or edit current positions for your what-if portfolio.

To add or edit positions:

1. From the Trade Simulation menu, click the Add Holdings button.
 

 

The Add/Edit Simulated Trades window appears.

2. Update your holdings and/or cash infusions:

 

bbg://screens/HELP PRTU
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• Ticker: Allows you to enter the name of the security that you want to add/edit.

The ticker appears in the table below the ticker field. The corresponding Weight or Position field is activated (depending
on your settings).

Enter a weight/position for the security, then press <Go>.

Note:  Alternatively, you can enter new values in the corresponding highlighted fields with the portfolio loaded on
screen, then press <Go>.

Repeat this step until all tickers are added.
• If you are editing securities with weight values, choose whether you want to fund the holding from cash or from your

holdings. If you select Fund from Cash, enter the cash amount in the Infuse Cash field.

Note:  The cash amount should be provided in units of the portfolio's reporting currency.

Trade Simulation trades remain until they are committed or cleared.

SIMULATING HISTORICAL TRADES

You can enter simulated trades as of a historical date, so you can evaluate the "what-if" performance of your portfolio for a
specific forward period. You can select the original portfolio as a benchmark for the simulated historical trades, so you can
compare and analyze actual versus "what-if" performance.

Note:  Simulated historical trades are supported in all PORT analysis tabs except the Intraday tab.

To set up a historical performance analysis of simulated trades:

1. With Trade Simulation analysis enabled, click the Settings button.

Note:  For more information on enabling Trade Simulation, see Enabling Trade Simulation.
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The Trade Simulation Settings window appears and displays a list of customizable options.

2. Deselect Simulate Trades on Current-Day Only, then click the Save button.
Your Trade Simulation analysis settings are saved, and the As Of112  field in PORT analysis tabs activates.

3. Select the tab in which you want to enter simulated trades and analyze your portfolio.
The tab appears.

4. In the As Of field, click the calendar icon to choose a date or enter a date historically, then press <Go>.
 

 

The portfolio updates based on the selected historical date.

5. Reweight or rebalance the portfolio for your trade simulation.
The columns in the Trade Simulation view update based on your reweighting.

6. If you want to benchmark the portfolio with simulated trades to the original portfolio, from the vs113  field, select Original
Portfolio.
 

112 The date for analysis. If the date is set to today, the analysis is based on current position's with the previous day's closing
prices. Analysis may be backdated up to 90 days.

113 Indicates the benchmark against which you are comparing your portfolio, which can be an index, portfolio, or fund. You
can create and maintain custom benchmarks in the Creating/Updating Portfolios (PRTU) function. For more information
on using PRTU to maintain benchmarks, click here .

bbg://screens/bbg://screens/LPHP PRTU:0:1 1956077
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The Bmrk columns in the Trade Simulation view update based on your selection.

7. Select the Performance tab.
The Corporate Actions window appears, prompting you to apply corporate actions to the simulated trades.

8. If you want to apply historical corporate actions to the simulated trades, click the Yes button.
The Performance tab appears with data on the simulated trades compared to the selected benchmark.

9. Analyze the historical performance of the simulated trades. For information on analyzing portfolios in the Performance tab,
see Performance Tab.

10.If you want to save the historical simulated trades as a new portfolio, from the Trade Simulation menu, select Save/Trade >
Save As. For more information on saving simulated trades, see Saving Simulated Trades As.

Note:  Once you rebalance the portfolio as of a specific date, you cannot select a new as of date. To restart the historical
performance analysis, from the Trade Simulation menu, select Save/Trade > Clear Simulated Trades, then in the Warning
window, click the Yes button. The simulated trades are cleared, and you can select a new as of date and rebalancing method.

SAVING SIMULATED TRADES

You can save trades entered in Trade Simulation Analysis as a snapshot of the original portfolio.

Note:  You can only save trades to a portfolio you own or are permitted to update.

To save Trade Simulation trades in the original portfolio:

1. From the Trade Simulation menu, select Save/Trade > Save.
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The Warning window appears.

2. Click the Yes button.
The Trade Simulation trades are saved in your portfolio.

SAVING SIMULATED TRADES AS

You can also save trades entered in Trade Simulation Analysis as a new portfolio or as a snapshot of another existing portfolio,
which is similar to simply saving the simulated trades, except you are saving the trades in a different, already existing portfolio,
not in the original portfolio.

To save Trade Simulation trades as a new portfolio or as a different existing portfolio:

1. From the Trade Simulation menu, select Save/Trade > Save As.
 

 

The Save Portfolio As window appears.

2. Save the simulated trades:

• To save the simulated trades as a new portfolio, update the new portfolio settings:
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— Portfolio Name: Enter a name for the new portfolio.
— Position Type: Choose how positions are valued in the new portfolio by selecting Shares / Par Amount114 , Fixed

Weight115 , or Drifting Weight116 .
• To save the simulated trades as a current-day snapshot of a different existing portfolio, update the existing portfolio

settings:
 

114 In Trade Simulation, indicates position values are defined explicitly by the number of shares in each security.
115 In Trade Simulation, indicates positions are valued with a set percentage (%) weight. This weight is rebalanced at the

market close each day back to the original weight. The default overall market value of the portfolio is 100,000,000. Fixed
weights remain fixed until you update them.

116 In Trade Simulation, indicates the percentage (%) weights drift with changes in the market each day. No rebalancing
assumptions are made.



>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //79

 

— Save to Existing Portfolio: Select if you want to save the trades to a different, existing portfolio.
— Select Portfolio from Favorites: Choose the portfolio by selecting an option from the drop-down menu.

3. Click the Save As button.
The portfolio is created or saved and is available in your list of saved portfolios.

For more information on accessing portfolios, see Setting Up Analysis.

CLEARING SIMULATED TRADES

You can remove trades that you have added to your portfolio in Trade Simulation Analysis.

To clear Trade Simulation Trades:

1. From the Trade Simulation menu, select Save/Trade > Clear Simulated Trades.
 

 

The Warning window appears.

2. Click the Yes button.
The Trade Simulation trades are removed from your portfolio.
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Note:  You can only clear Trade Simulation trades that have NOT been saved to your portfolio. Once what-if trades are saved
(using the Save As option), trades can only be removed using the Creating/Updating Portfolios (PRTU) function. For more
information, see PRTU <Help>.

PORTFOLIO OPTIMIZATION

You can use the Portfolio Optimization tool to construct, hedge, and re-balance portfolios with tailored risk, return, and
exposure characteristics, so you can see how the portfolio analytics change after these trade ideas are incorporated. For
example, you may want to change the portfolio composition or hedge some portfolio exposures without changing portfolio
holdings. Examples include:
• Index replication with liquid instruments
• Stock picking and hedging market exposure
• Maximizing portfolio expected return subject to sector constraints
• Choosing 10 trades from a given list that lower portfolio Tracking Error117

Note:  Portfolio Optimization is currently not available for PORT Launchpad.

|Hint| To see related white papers and examples of Portfolio Optimization application, see 5. Portfolio Construction.

The Portfolio Optimization tool is accessed from the toolbar by selecting Trade Simulation > Launch Optimizer.
 

117 Tracking errors are annualized volatilities of active returns, expressed in percentages. Tracking error on security level
shows the contribution to the portfolio level tracking error. This would be the annualized volatility x (relative) weight x
correlation. It is important to keep in mind that there is a difference between the total tracking error and the security level
track error.

Total track error is the standard deviation of the active portfolio (which is the portfolio minus the benchmark), and it can
never be negative. However, when the tracking error is shown broken up in securities or sectors, what is actually shown
is a marginal contribution to tracking error. Then, the security level tracking error shows how sensitive is the total tracking
error when increasing a given position. Usually that number is positive: increasing a given position would make the
returns of the portfolio less alike the returns of the benchmark, thus increasing the total track error.

It can happen due to correlations, however, that increasing a position will make the portfolio more similar to the
benchmark (decreasing the tracking error). In that case, the security contribution to tracking error would be negative.

bbg://screens/HELP PRTU
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The Portfolio Optimization screen is divided into four tabs:

• Setup: Allows you to set portfolio optimization parameters, such as goals, universe, constraints, and security properties.
For more information, see Optimization Setup.

• Frontier: Allows you to generate a set of optimal portfolios based on a range of values for a given constraint field. The
efficient frontier reflects the plotting of goal versus constraint range values. For more information, see Optimization Frontier.

• Backtest: Displays the progress and results from the backtesting process, so you can quickly evaluate the results of your
backtest. The tab provides a chart with the analytic results of the backtest, where you can click data points to see the
trades suggested by the Optimizer for a specific date. For more information, see Backtesting Optimization.

• Trades: Displays the results of your portfolio optimization settings and lets you export trade data. For more information, see
Optimization Trades.

OPTIMIZATION SETUP

The Setup tab allows you to set portfolio optimization parameters, such as goals, universe, constraints, and security properties.
This section provides detailed information about the numerous parameters available in the Setup tab.

The Setup tab is divided into the following sections:
 

 

• Control Area: Displays information for the portfolio being optimized, including the portfolio (Port118 ), benchmark

(Bmrk119), and selected Risk Model120 . Allows you to run and refine optimizations as well as enable backtesting. For
information on backtesting, see Backtesting Optimization.

118 In general, Port indicates the portfolio being analyzed. The portfolios are created and maintained in PRTU and BBU.
For more information, see PRTU <Help> and BBU <Help>. In the Characteristics - Characteristics Summary sub-tab,
however, Port indicates the weight value of the portfolio.

bbg://screens/bbg://screens/HELP PRTU
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• Goals: Allows you to define the goals of the portfolio optimization by specifying which fields should be minimized or
maximized. If more than one goal variable (e.g., Active Total Risk) is selected, then a trade-off between the variables must
be specified to determine their relative worth.

Examples of the fields for which you can define optimization include Turnover, LT Debt to Total Capital, and Active Total

Risk. You can also build a custom formula to calculate a value to minimize or maximize. The Trade-Off121  field defines how
different goal and constraint fields are evaluated relative to each other. For more information on setting goal definitions, see
Optimization Goals.

• Trade Universe: Allows you to choose which securities can be included in the optimization. For more information on
creating a trade universe, see Optimization Universe.

Securities in the original portfolio can be bought and sold, but securities in the benchmark may not be bought or sold
unless they are also present in the original portfolio or the universe.

• Constraints: Allows you to determine the constraints on the optimal portfolio for any aggregate field available in PORT.
You can also build a custom formula to calculate a value to constrain. These constraints can be applied to the entire
portfolio or to a subset of the portfolio specified by the aggregation bucket. For more information on defining constraints,
see Optimization Constraints.

The first line in this section is used to define the default value for all securities which are not specified individually below this
line. For more information on specifying constraints for securities, see Security Properties.

• Security Properties: Allows you to limit the amount of trading to a fixed percentage of average daily volume (ADV). You
can also incorporate Bloomberg-provided round lot values into your optimization. For more information on limiting trading by
these parameters, see Limiting Amount of Trades.

• Stored Results: Appears after optimizations are run. Displays optimization requests that may take a while to process, the

time it was submitted, and the Status122  of the request. You can click any stored result to run that optimization again.

119 Indicates the benchmark against which you are comparing your portfolio, which can be an index, portfolio, or fund.
— In the Characteristics - Characteristics Summary sub-tab, the benchmark indicator value.
— In the View Manager, allows you to choose which fields appear in the benchmark column (for each tab).

120 See Model.
121 In the Setup tab of the Portfolio Optimization screen, the Trade-Off field defines how different goal and constraint fields

are evaluated relative to each other. The trade-off can be understood in two contexts:

— Multiple Goal Terms: As an example, specifying two goal terms may look like:

• Minimize Active Total Risk (Unit: %, Trade-off = 0.2)
• Maximize Current Ratio (Unit: number, Trade-off = 1)
This means that a .2% increase in Active Total Risk is worth the same as an increase of 1.0 in Current Ratio, and
vice-versa.

— Soft Constraints: In the context of constraints, the trade-off applies to the value in excess of the minimum and
maximum bounds specified. As an example:

• Goal: Maximize Current Ratio (Trade-off = 1)
• Constraint: Active Total Risk (Maximum = 10, Trade-off = 0.5)
This means that every 0.5% that Active Total Risk goes above 10% is worth an increase of 1 in Current Ratio. If
trade-off is not specified for a constraint, then the constraint can never be violated.

122 Indicates whether the optimization request is pending, failed, or a success.



>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //83

|Hint| You can position your mouse over fields and column headers to display definitions.

OPTIMIZATION FRONTIER

The Frontier tab allows you to generate a set of optimal portfolios based on a range of values for a given constraint. For
example, you can minimize portfolio active total risk while allowing maximum portfolio turnover to vary from 10% to 20%. The
plotting of the goal versus constraint values is called the "efficient frontier."

The Frontier tab is activated when you click the Add Frontier button in the Setup tab, add constraints, then click the Run
toolbar button. For instructions, see Adding a Frontier.

The Frontier tab is divided into the following sections:
 

 
• Control Area: Displays information for the portfolio being optimized, including the portfolio (Port123 ), benchmark

(Bmrk124), and selected Risk Model125 . Allows you to run and refine optimizations as well as enable backtesting. For
information on backtesting, see Backtesting Optimization.

• Efficient Frontier Chart: Displays the upper, middle, and lower linear division of the optimal portfolios that fit within the
range of your frontier constraint and optimization goal.

• Optimal Portfolios: Displays five optimal portfolios that match your frontier constraint and optimization goal. You can click
any portfolio to display suggested trades and related information in the Trades tab.

123 In general, Port indicates the portfolio being analyzed. The portfolios are created and maintained in PRTU and BBU.
For more information, see PRTU <Help> and BBU <Help>. In the Characteristics - Characteristics Summary sub-tab,
however, Port indicates the weight value of the portfolio.

124 Indicates the benchmark against which you are comparing your portfolio, which can be an index, portfolio, or fund.
— In the Characteristics - Characteristics Summary sub-tab, the benchmark indicator value.
— In the View Manager, allows you to choose which fields appear in the benchmark column (for each tab).

125 See Model.
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• Stored Results: Displays optimization requests that may take a while to process, the time it was submitted, and the

Status126  of the request. You can click any stored result to run that optimization again.

OPTIMIZATION GOALS

The Goal Definition section on the Setup tab on the Portfolio Optimization screen allows you to define the goals of the
portfolio optimization. If more than one goal variable (e.g., Active Total Risk) is selected, then a trade-off between the variables
must be specified to determine their relative value worth.

If you define more than one indicator for a specific goal, you must provide trade-off127  coefficients, which allow the optimizer
to combine multiple goals together. For example, suppose you want to maximize dividend yield and minimize active total risk.
If you set the trade-off coefficients to 1 and 0.25 respectively, this denotes that for an extra 1% dividend yield in the optimal
portfolio, you are willing to incur an additional 0.25% of Active Total Risk.

To define portfolio optimization goals:

1. From the field below the Action header, choose whether you want to maximize or minimize the selected field.
 

 

Note:  Depending on your optimization attribute selection, the minimize or maximize setting may be automatically set.

2. To select the optimization field you want to minimize/maximize, click the pencil icon adjacent to the Field.
 

126 Indicates whether the optimization request is pending, failed, or a success.
127 In the Setup tab of the Portfolio Optimization screen, the Trade-Off field defines how different goal and constraint fields

are evaluated relative to each other. The trade-off can be understood in two contexts:

• Multiple Goal Terms: As an example, specifying two goal terms may look like:

— Minimize Active Total Risk (Unit: %, Trade-off = 0.2)
— Maximize Current Ratio (Unit: number, Trade-off = 1)
This means that a .2% increase in Active Total Risk is worth the same as an increase of 1.0 in Current Ratio, and
vice-versa.

• Soft Constraints: In the context of constraints, the trade-off applies to the value in excess of the minimum and
maximum bounds specified. As an example:

— Goal: Maximize Current Ratio (Trade-off = 1)
— Constraint: Active Total Risk (Maximum = 10, Trade-off = 0.5)
This means that every 0.5% that Active Total Risk goes above 10% is worth an increase of 1 in Current Ratio. If
trade-off is not specified for a constraint, then the constraint can never be violated.
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The Add Goal Term window appears.

3. Select the field you want to minimize or maximize:

• Browse the Select Field column to find the field.

Note:  Scenarios available on the Scenarios tab can be added as optimization goals. They are located under Scenario
(P&L %). Multiple scenarios can be added as goals.

• Enter a search term in the Search field.
• Create a custom equity formula to calculate a value to minimize or maximize. To create a custom formula, select Equity

Formulas > Create Formula. The Formula Builder (FORM) function appears, where you can create and manage
custom formulas using Bloomberg's proprietary formula language. For information on creating formulas and for details
on formula syntax, see the Bloomberg Formula Language Guide and the Bloomberg Formula Language Quick Start
Guide.

Note:  You must be enabled for FORM to access this option. For more information, contact your Bloomberg account
representative.

• If you want to see more options, click the More Equity Fields button. The Select Field window appears where you can
search for additional options.

|Hint| You can click any field option to see a definition in the Description column.
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4. Click the Select button.

The selection appears in the optimization field.
5. If you select more than one optimization field, you must also specify trade-off values. The Trade-Off128  field defines how

different goal and constraint fields are evaluated relative to each other.
 

 

128 In the Setup tab of the Portfolio Optimization screen, the Trade-Off field defines how different goal and constraint fields
are evaluated relative to each other. The trade-off can be understood in two contexts:

• Multiple Goal Terms: As an example, specifying two goal terms may look like:

— Minimize Active Total Risk (Unit: %, Trade-off = 0.2)
— Maximize Current Ratio (Unit: number, Trade-off = 1)
This means that a .2% increase in Active Total Risk is worth the same as an increase of 1.0 in Current Ratio, and
vice-versa.

• Soft Constraints: In the context of constraints, the trade-off applies to the value in excess of the minimum and
maximum bounds specified. As an example:

— Goal: Maximize Current Ratio (Trade-off = 1)
— Constraint: Active Total Risk (Maximum = 10, Trade-off = 0.5)
This means that every 0.5% that Active Total Risk goes above 10% is worth an increase of 1 in Current Ratio. If
trade-off is not specified for a constraint, then the constraint can never be violated.
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Note:  For more information on the two contexts for trade-off selection, see Optimization Setup.

The goal fields are reset.

Now that your optimization goals are set, you can establish your trade universe, portfolio constraints, security-level constraints,
and an efficient frontier. For more information, see Optimization Universe, Optimization Constraints, Adding a Frontier, and
Security Properties.

For more information on running your optimization, see Running Optimization. For an example of running an optimization, see
Example: Maximize Expected Returns.

OPTIMIZATION UNIVERSE

The Trade Universes section of the Setup tab allows you to choose which securities are included in the optimization. An
optimization universe can be a portfolio, a benchmark, or an index. Securities in the original portfolio can be bought and sold,
but securities in the benchmark may not be bought or sold unless they are also present in the original portfolio or the universe.

To determine the portfolio optimization universe, update the Rule129 , Source130 , and Security List131  fields.
 

 
|Hint| You can select two sources and two destinations.

Note:  If you want to keep the weights of some securities in your portfolio constant, you can create a portfolio comprised of
these securities and set the list rule to No Trade for that portfolio. You can also set up a No Sell list for securities you do not
want to sell or decrease weight, a No Buy list for securities you do not want to buy or increase weight, or a Liquidate list for
securities you want to liquidate or set weight to zero.

When your optimization goals and universe are set, you can establish your portfolio constraints, security-level constraints, and
a frontier. For more information, see Optimization Constraints, Adding a Frontier, and Security Properties.

129 When optimizing a portfolio, allows you to set the rule that applies to the trade universe. The following options are
available:

• No Trade List: A list of securities in your portfolio that you do not buy or sell (trade).
• No Sell List: A list of securities in your portfolio for which you do not reduce weights (cannot sell).
• No Buy List: A list of securities in your portfolio for which you do not increase weights (cannot buy).
• Liquidate (No Hold): Sets security weights to zero.
• No Short: A list of securities you cannot have short.
• No Long: A list of securities you cannot have long.

130 The source of trades you want to optimize, either Portfolio, Equity Index, Favorites, or Benchmark.
131 The destination portfolio, equity index, benchmark, or favorite source, depending on the Source selection.
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For more information on running your optimization, see Running Optimization. For an example of running an optimization, see
Example: Maximize Expected Returns.

OPTIMIZATION CONSTRAINTS

The Constraints section of the Setup tab allows you to determine the rules the optimizer follows in order to construct the
optimal portfolio. These constraints can be applied to the entire portfolio or to a subset of the portfolio (including security-level)
specified by the aggregation bucket.

To set portfolio and group constraints:

1. Click the Add Constraint button.
 

 

The Add Constraint window appears.

2. Select the field you want to constrain:

• Browse the Select Field column to find the field.
• Enter a search term in the Search field.
• Create a custom equity formula to calculate a value to constrain. To create a custom formula, select Equity Formulas

> Create Formula. The Formula Builder (FORM) function appears, where you can create and manage custom
formulas using Bloomberg's proprietary formula language. For information on creating formulas and for details on
formula syntax, see the Bloomberg Formula Language Guide and the Bloomberg Formula Language Quick Start Guide.

Note:  You must be enabled for FORM to access this option. For more information, contact your Bloomberg account
representative.

• If you want to see more options, click the More Equity Fields button. The Select Field window appears where you can
search for additional options.

|Hint| You can select any field option to see a definition in the Description column.
Constraint level options appear at the bottom of the window. Depending on your selection, the fields and the
corresponding options vary.

3. Define constraint parameters by updating constraint fields, then click the Add Constraint button.
• Example: If you select to constrain the Number of Trades, you can then choose to constrain the variable relative to

another portfolio or benchmark (Relative) as well as set the minimum (Min) and maximum (Max) number of trades. You
cannot, however, determine the Trade-Off value for this selection.
 

bbg://screens/IDOC #2071336
bbg://screens/IDOC #2071631


>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //89

 

• Example: If you select to constrain the Trade Size (%), you can only determine the trade size relative to another
portfolio/benchmark and/or the minimum trade value.

• Example: When you add a constraint for a given category (e.g., Dividend Yield in BICS Technology Sector), you
can define the Aggregation type as either Contribution (meaning you are applying the constraint to the sum product

of security weights of the indicator's value) or Gross Value (meaning only the indicator's value, set in the Min132  and

Max133  fields). When shorts are allowed, in addition to Contribution and Gross Value, you can also select Long Value
and Short Value aggregation methodology.
 

132 In the Setup tab of the Portfolio Optimization screen, specifies a minimum constraint in order to shape your optimal
portfolio.

133 In the Setup tab of the Portfolio Optimization screen, specifies a maximum constraint in order to shape your optimal
portfolio.
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Note:  Scenarios that are available on the Scenarios tab can be added as constraints. They are located under Scenario
(P&L %). Multiple scenarios can be added as constraints.

The constraints appear in the Portfolio and Group Constraints Definition section.

4. Add as many constraints as needed by clicking the Add Constraint button, then click the Close button.
The constraints appear in the Constraints section of the Setup tab.

5. If you want to add an efficient frontier, see the instructions in Adding a Frontier. Adding a frontier allows you to generate a
set of optimal portfolios based on a range of values for a given constraint.

6. If you want to apply UCITS compliance rules, from the toolbar select Settings > UCITS Compliance Rules.

In the UCITS Compliance Rules window that appears, select the Enable UCITS Compliance Rule checkbox, enter the
threshold value (the default value is 5%), then click the Save button.
 

 

Note:  UCITS compliance rules are applicable to European portfolio manager who are subject to UCITS regulations.



>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //91

Two constraints are added to the Portfolio and Group Constraints Definition section: UCITS Rule (5 sum 40 rule)134  and

Issuer Constraint135 . When you run the optimization, the UCITS constraints are enforced.

7. If you want to edit a constraint, update the Relative136 , Min137 , Max138 , and/or Trade-Off139  fields, then press <Go>.
 

 

Your changes are saved. If you want to delete a constraint, select the row and click the Delete button.

Now that your optimization goals, universe, and constraints are set, you can establish your security-level constraints, or choose
to add a frontier. For more information, see Adding a Frontier and Security Properties.

For more information on running your optimization, see Running Optimization. For an example of running an optimization, see
Example: Maximize Expected Returns.

134 The UCITS rule ensures that the sum of issuer weights greater than the specified threshold is not greater than the Max
value (default is 40%).

135 Ensures that no single issuer has the weight of greater than Max value (default is 10%) in the optimal portfolio.
136 In the Setup tab of the Portfolio Optimization screen, specifies whether the corresponding constraint is calculated

relative to another portfolio, benchmark, or nothing (none).
137 In the Setup tab of the Portfolio Optimization screen, specifies a minimum constraint in order to shape your optimal

portfolio.
138 In the Setup tab of the Portfolio Optimization screen, specifies a maximum constraint in order to shape your optimal

portfolio.
139 In the Setup tab of the Portfolio Optimization screen, the Trade-Off field defines how different goal and constraint fields

are evaluated relative to each other. The trade-off can be understood in two contexts:

• Multiple Goal Terms: As an example, specifying two goal terms may look like:

— Minimize Active Total Risk (Unit: %, Trade-off = 0.2)
— Maximize Current Ratio (Unit: number, Trade-off = 1)
This means that a .2% increase in Active Total Risk is worth the same as an increase of 1.0 in Current Ratio, and
vice-versa.

• Soft Constraints: In the context of constraints, the trade-off applies to the value in excess of the minimum and
maximum bounds specified. As an example:

— Goal: Maximize Current Ratio (Trade-off = 1)
— Constraint: Active Total Risk (Maximum = 10, Trade-off = 0.5)
This means that every 0.5% that Active Total Risk goes above 10% is worth an increase of 1 in Current Ratio. If
trade-off is not specified for a constraint, then the constraint can never be violated.
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SECURITY PROPERTIES

The table in the Security Properties section of the Setup tab allows you to specify properties for individual securities (rather
than an aggregation of many securities). The first line in this section is used to define the default value for all securities which
are not specified individually below this line.

To set security-level properties and constraints, update any of the following fields:

Note:  You can specify as many security-specific constraints as necessary.

• Min % / Max %: Enter the minimum and maximum weight of cash in the portfolio.
• Long/Short Settings (unlabeled): Refine long/long/short positions. Choose from the following:

— Long Positions Only: The default selection, which does not allow for short positions in the portfolio optimization.
— Long/Short Positions: Allows both long and short positions in the portfolio optimization.
— Long/Short with No Crossover: By selecting this option, the optimizer does not go short a security for which you are

long, and does not go long a security for which you are short.

Note:  Your selections may affect other options in the Portfolio and Group Constraints Definition section.
• Security: To specify constraints for a particular security, enter the ticker symbol in the first-available Security field.

Example: You want to set the optimal maximum weight for IBM US <Equity> to be 10%. Therefore, enter IBM US
<Equity> in the first-available field in the Security column, then enter 10 in the corresponding Max Weight column.

Example: If you want to apply global constraints (applied to all securities in the portfolio), enter the values in the
corresponding rows with "Default for all securities" selected in the Security column.
 

 

• Relative: Choose whether the security should be calculated relative to the portfolio (Init. Portfolio), benchmark, or neither
(None).

• Lot Size: Enter the smallest increment in number of shares traded or held

• Min Weight: The minimum Weight Bounds (%)140 .
• Max Weight: The maximum Weight Bounds (%)141 .

Note:  You can also limit the amount of trading to a fixed percentage of average daily volume (ADV). You can also incorporate
Bloomberg-provided round lot values into your optimization. For more information on limiting trading by these parameters, see
Limiting Amount of Trades.

140 In the Portfolio Optimization screen, the portfolio weights in the optimal portfolio between a specified range (minimum
and maximum).

141 In the Portfolio Optimization screen, the portfolio weights in the optimal portfolio between a specified range (minimum
and maximum).
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Now that your optimization goals, universe, portfolio constraints, and security-level constraints are set, you can run a portfolio
optimization. For more information on running your optimization, see Running Optimization. For more information on running
your optimization, see Running Optimization. For an example of running an optimization, see Example: Maximize Expected
Returns.

RUNNING OPTIMIZATION

After you set your optimization goals, trade universes, portfolio and group constraints, and security-level properties and
constraints in the Setup tab, you can run a portfolio optimization.

To run a portfolio optimization, from the toolbar, click the Run button.
 

 

Depending on your optimization parameters, either action may occur:

• A Warning window appears confirming that existing Trade Simulation trades will be overwritten. Click Yes.
• An Optimization Error window appears describing any errors in your optimization. For example: "Please Specify the Trading

Universe." Click Close and address errors as appropriate.

When the portfolio optimization is successful, the results appear in the Trades tab, which displays the results of your portfolio
optimization settings and lets you export trade data. For more information, see Optimization Trades. For more information on
troubleshooting optimization errors, see Troubleshooting.

For more information on running your optimization, see Running Optimization. For an example of running an optimization, see
Example: Maximize Expected Returns.

OPTIMIZATION TRADES

The Trades tab displays the results of your portfolio optimization settings and allows you to export trade data.

The Trades tab is divided into the following sections:
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• Control Area: Displays information on the portfolio being optimized, including the portfolio (Port142 ), benchmark

(Bmrk143), and selected Risk Model144 . Allows you to run and refine optimizations as well as enable backtesting. For
information on backtesting, see Backtesting Optimization.

• Optimization Summary: Displays the success/failure status of portfolio optimization and trade summary results. The
Status, either Success or Failed, may have a corresponding warning, such as "Round lots have been relaxed for some
securities." You can click the Warnings button to see details for any errors and recommended actions. Trade summary

data may include: Turnover (%)145 , Number of Buys146 , Number of Sells147 , Trades Value148 , Value of Buys149 , and

Value of Sells150 . For more information on errors, see Troubleshooting.
• Goal Summary: Displays the initial and final values for each goal that was part of the optimization. For example, if in the

Goal Definition section of the Setup tab, you chose to minimize Active Total Risk, the Goal Summary section displays the
value of Active Total Risk for the initial portfolio (Initial Value: e.g., 39.61%) and the optimized portfolio (Final Value: e.g.,
34.13%).

142 In general, Port indicates the portfolio being analyzed. The portfolios are created and maintained in PRTU and BBU.
For more information, see PRTU <Help> and BBU <Help>. In the Characteristics - Characteristics Summary sub-tab,
however, Port indicates the weight value of the portfolio.

143 Indicates the benchmark against which you are comparing your portfolio, which can be an index, portfolio, or fund.
— In the Characteristics - Characteristics Summary sub-tab, the benchmark indicator value.
— In the View Manager, allows you to choose which fields appear in the benchmark column (for each tab).

144 See Model.
145 The turnover, in percentage terms, incurred from the initial portfolio to the optimal portfolio.
146 The number of portfolio positions bought.
147 The number of portfolio positions sold.
148 The combined market value of the trades.
149 The buy values associated with the Trades Value (in the reporting currency).
150 The sell values associated with the Trades Value (in the reporting currency).

bbg://screens/bbg://screens/HELP PRTU
bbg://screens/bbg://screens/HELP BBU
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• Proposed Trades: Displays a list of the proposed trades that need to be implemented in order to get from the initial
portfolio to the optimal portfolio. The table displays the name of the instrument (Name), a proposal to Buy or Sell (Trade),
the quantity of shares to buy/sell (Quantity), the weight (in percentage terms) for the initial portfolio (Init. Weight (%)), the
optimized weight (Opt. Weight (%)), and the difference between the initial and optimal weight (Wgt Diff).

You can click any row to access more analytical functions for the instrument, such as Historical Pricing (HP), security
Description (DES), and Company News and Research (CN). The corresponding <Help> pages display more information.

Above the Proposed Trades table, you can click the Export Trades button to export trades to a spreadsheet.

If there are exceptions in the optimized portfolio, you can click the Exceptions (#) button to view these instruments.
The number in parentheses indicates the number of exceptions in the portfolio. Exceptions are viewed in the Exceptions
window.

• Portfolio and Group Constraint Results: Displays summary of how each constraint field performed in the optimization,
including the name of the constraint, the minimum and maximum constraint values, and the constraint for the initial and
optimal portfolios. The data directly corresponds with your optimization setup in the Constraints Definitions  section of the
Setup tab.

For more information on defining constraints, see Optimization Constraints.
• Stored Results: Displays optimization requests that may take a while to process, the time it was submitted, and the

Status151  of the request. You can click any stored result to run that optimization again.

ANALYZING IN PORT

Once you have optimized a portfolio in the Portfolio Optimization screen and are satisfied with the results, you can analyze the
optimal portfolio in PORT.

To analyze the optimal portfolio in PORT, from the toolbar, click the Analyze in PORT button.
 

 

The optimal portfolio appears in PORT. Trade simulation mode is enabled. The Trade Simulation menu appears at the top of the
screen, just below the toolbar.
 

 

For more information on Trade Simulation mode, see Trade Simulation.

For an example of using the optimizer to maximize user-supplied expected returns, see Example: Maximize Expected Returns.

151 Indicates whether the optimization request is pending, failed, or a success.
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SETTING UP TASKS

In the Portfolio Optimization screen, you can define optimization tasks. A task is a problem definition that includes the goal
definition, portfolio/group constraint definitions, and security constraint/property definitions. Once set up, you can save the task
so you can quickly reuse the optimization in the future.

To set up a task:

1. Establish your portfolio optimization parameters, as outlined in the following topics:

• Optimization Goals

• Optimization Universe

• Optimization Constraints

• Security Properties

2. From the toolbar, select Tasks > Save Task As...
 

 

The Save Task As... window appears.

3. Enter a name in the Task Name field, then click Save.

The task is saved and can be accessed by selecting, from the toolbar, Tasks > My Tasks.

For more information on predefined tasks, task defaults, and saving, sharing, and deleting tasks, see Predefined Tasks,
Task Defaults, Saving Tasks, Sharing Tasks, and Deleting Tasks.

SCENARIO MANAGER

You can use the Scenario Manager to create and define historical and hypothetical scenarios for market variable movements.
You can then stress test your portfolios against these scenarios in PORT to observe and analyze performance.

The Scenario Manager screen is divided into a control area and two main sections for accessing and creating scenarios.
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• Control Area: Allows you to choose if the scenario uses the factor model152  or full valuation153  methodology, and
provides a toolbar you can use to create, edit, and delete scenarios, update your settings for full valuation scenarios, and
launch PORT to analyze the scenario.

• Scenario Repository: Allows you to navigate to specific groups of scenarios.
• Scenario Group Details: Displays details on the scenario group and provides access to details on the scenarios.

The Scenario Manager screen allows you to create four different stress scenarios:

Stress Scenario Allows you to

Historical Returns Replay a historical event by applying changes in market variables from an explicit
historical period that you specify. Historical data is available from 2008. For more
information, see Historical Scenarios.

Explicit Factor Shocks without
Propagation

Define explicit shocks to all the changes in market variables that you want to see. For
more information, see Factor Model Scenarios.

Explicit Factor Shocks with
Propagation

Specify some changes in market variables, then propagate these changes to other
market variables based on the correlations among the historical returns of the variables.
For more information, see Propagation Options.

152 Allows you to shock your portfolio by shifting macroeconomic factors, interest rates, foreign exchange rates, and model
factors in a scenario analysis.

153 Allows you to evaluate your portfolio on a forward horizon date by shifting interest rates, option adjusted spreads, credit
curves, and many more variables in a scenario analysis.
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Stress Scenario Allows you to

Full Valuation Shocks Evaluate a scenario on a forward horizon date, which simulates moving the valuation
date to a future date and revaluing the portfolio as if that future date is today. For more
information, see Full Valuation Scenarios.

Each scenario can stress different variables, so you can analyze your positions using the methodology appropriate to your
portfolio composition.
• For information on the shift variables available for a factor model scenario, see Factor Model Shifts.
• For information on the shift variables available for a full valuation scenario, see Full Valuation Shifts.

The following topics explain how to create historical scenarios, explicit factor model scenarios, and full valuation scenarios. This
section also explains how to edit your propagation options, display scenarios created by your colleagues, and create scenario
groups.

ACCESSING SCENARIOS

To access the Scenario Manager:

In the Scenarios tab, from the Set drop-down menu, select Edit / Create New....
 

 

Note:  The scenario group that is currently loaded appears in yellow in the menu.

The Scenario Manager screen appears.

For information on creating different types of scenarios, see Historical Scenarios, Factor Model Scenarios, and Full
Valuation Scenarios.
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HISTORICAL SCENARIOS

You can define a historical scenario against which you can stress your portfolio. Historical data is available from 2008.

To set up a historical scenario:
1. In the Scenario Manager screen, from the Scenario Methodology field, select Factor Model.

 

 

Note:  For more information on accessing the Scenario Manager screen, see Accessing Scenarios.
2. From the toolbar, select Actions > New Scenario.

 

 
The Scenario Details section appears.

3. In the Name field, enter a name for your scenario.

Note:  If you want to add notes or a description of the scenario, select the Properties link and complete the Notes field,
then click the Apply button.

4. In the Main - Summary tab, select Use historical factor returns from, then choose the start date and end date for the
historical scenario analysis.
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Note:  Propagation and macro factor shocks are not available when creating historical scenarios.

5. If you want to stress interest rates, update the swap or treasury curve fields on the IR tab:

a) From the IR tab, select the Swap Curve Shift or Treasury Curve Shift sub-tab.

b) From the Currency dropdown menu, select the currency of the curves to shock.

Note:  If you want to shock all currency curves, complete the first row, which defaults to ALL.
The Type and Value fields activate.

c) In the Type field, choose the type of shift you want to apply to the curves.

Note:  If you want to customize the interest rate shock, select Custom, then enter the shift parameters in the
Curve Shift window. For more information on customizing shifts, see Custom IR Curve Shifts.

d) In the Value field, enter the shift amount. The shift can be positive or negative.
|Hint| You can shift as many curves as needed. To remove a curve, click the corresponding red (X).

6. If you want to stress exchange rates relative to the base currency, update the currency shift options on the FX tab:

 

 

a) From the Counter/CCy2 dropdown menu, select the currency for which you want to override historical FX rates.
The Value field activates and the Mode field is automatically set to Percent.

b) Enter the spot exchange rate in the Value field, then press <Go>.
The value applies a relative shock and can be positive or negative.
|Hint| You can add as many currency rate overrides as needed. To remove a currency override, click the corresponding
red (X).

7. If you want to stress model factors, update the factors you want to override in the ModelFactor tab:
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a) In the All Factors column, select the individual market factor(s) you want to stress, then click the >> button.

Note:  You can filter the model factors by keyword by entering the term(s) in the field below the All Factors
column heading and pressing <Go>.

The factors appear in the Risk Factors column, and the corresponding % Change fields activate.

b) In the % Change field, enter the percentage change by which the risk factor should move.

Note:  Shifts should be entered in percentage terms. For example, enter -10 to shift a factor down by 10%.
Equivalently, this sets the instantaneous arithmetic return on the factor to -10%. Changes made to higher
aggregate levels apply to all factors within that category. For example, a percentage change applied to
"Commodity" also applies to each factor (commodity) under that category.

c) If you want to remove a factor from your scenario, click the item in the Risk Factors column (your selection is shaded in
blue), then click the << button.

8. To review the parameters of your historical scenario, return to the Main - Summary tab.

9. To save your scenario, from the toolbar, select Actions > Save.
The Scenario Details window appears.

10.If you want to add notes to the scenario, enter those in the Notes field.

11.In the Add to/Remove from Scenario Group section, add the scenario to a group.

12.Click Save.
The Scenario Manager appears and displays a list of your saved scenarios. Your newly created historical scenario appears
at the end of the list of scenarios in your selected group.

For more information on editing, copying, and deleting scenarios, see Editing Scenarios, Copying Scenarios, and Deleting
Scenarios.
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FACTOR MODEL SCENARIOS

You can define an explicit factor model scenario or a propagating factor model scenario against which you can stress your
portfolio.

To set up a factor model scenario:

1. In the Scenario Manager screen, from the Scenario Methodology field, select Factor Model.
 

 

Note:  For more information on accessing the Scenario Manager screen, see Accessing Scenarios.

2. From the toolbar, select Actions > New Scenario.
 

 

The Scenario Details section appears.

3. In the Name field, enter a name for your scenario.

Note:  If you want to add a description of or notes about the scenario, select the Properties link and complete the Notes
field, then click the Apply button.

4. If you want to stress macro factors, update the factor fields on the MacroFactor tab:
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a) In the All Factors column, browse for the individual macro factor(s) you want to stress, then click the >> button. You
can select individual factors (e.g., Gold) or all factors within an aggregate category (e.g., Commodity).

Note:  You can filter the macro factors by keyword by entering the term(s) in the field below the All Factors
column heading and pressing <Go>.

The factors are added to the Risk Factors column, and the corresponding % Change fields activate.

b) In the % Change field, enter the percentage change by which the risk factor should move.

Note:  Entries in the % Change field at higher aggregate levels apply to all factors within that category. For
example, a percentage change applied to "Commodity" also applies to each factor (commodity) under that
category.

c) If you want to remove a factor from your scenario, click the item in the Risk Factors column (your selection is shaded in
blue), then click the << button.

5. If you want to stress interest rates, update the swap or treasury curve fields on the IR tab:
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a) From the IR tab, select the Swap Curve Shift or Treasury Curve Shift sub-tab.

b) From the Currency dropdown menu, select the currency of the curves to shock.

Note:  If you want to shock all currency curves, complete the first row, which defaults to ALL.
The Type and Value fields activate.

c) In the Type field, choose the type of shift you want to apply to the curves.

Note:  If you want to customize the interest rate shock, select Custom, then enter the shift parameters in the
Curve Shift window. For more information on customizing shifts, see Custom IR Curve Shifts.

d) In the Value field, enter the shift amount. The shift can be positive or negative.
|Hint| You can shift as many curves as needed. To remove a curve, click the corresponding red (X).

6. If you want to stress exchange rates relative to the base currency, update the currency shift options on the FX tab:

 

 

a) From the Counter/CCy2 dropdown menu, select the currency to override.
The Value field activates and the Mode field is automatically set to Percent.

b) Enter the override spot exchange rate in the Value field.
The Value applies a relative shock and can be positive or negative.
|Hint| You can add as many currency rate overrides as needed. To remove a currency override, click the corresponding
red (X).

The Value field activates and the Mode field is automatically set to Percent.

7. If you want to stress model factors, update the factors you want to override in the ModelFactor tab:
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a) In the All Factors column, select the individual market factor(s) for which you want to override historically observed

returns, then click the >> button.

Note:  You can filter the model factors by keyword by entering the term(s) in the field below the All Factors
column heading and pressing <Go>.

The factors are added to the Risk Factors column, and the corresponding % Change fields activate.
b) In the % Change field, enter the percentage change by which the risk factor should move.

Note:  Shifts should be entered in percentage terms. For example, enter -10 to shift a factor down by 10%.
Equivalently, this sets the instantaneous arithmetic return on the factor to -10%. Changes made to higher
aggregate levels apply to all factors within that category. For example, a percentage change applied to
"Commodity" also applies to each factor (commodity) under that category.

c) If you want to remove a factor from your scenario, click the item in the Risk Factors column (your selection is shaded in
blue), then click the << button.

8. If you want to propagate the shifts to other variables in the scenario, in the Main - Summary tab, choose a propagation
option. For more information on each of the propagation options, see Propagation Options.
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Note:  If you do not select a propagation option, the stresses you define to auxiliary (macro) variables will have no impact.

9. To review the parameters of your factor model scenario, return to the Main - Summary tab.

10.To save the scenario, from the toolbar, select Actions > Save.
 

 

The Scenario Details window appears.

11.Choose a Scenario Group Name in which to save the scenario(e.g., My Factor Model Set).

Note:  For information on creating scenario groups, see Creating Scenario Groups.

12.Click the Save button.
 

 

The scenario saves, and the Scenario Manager screen appears. Your newly created explicit scenario appears at the end of
the list of scenarios in your selected group.

For more information on editing, copying, and deleting scenarios, see Editing Scenarios, Copying Scenarios, and Deleting
Scenarios.
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PROPAGATION OPTIONS

When you create an explicit factor model scenario, you have the option to propagate the shocks you created to the rest of the
market.

Note:  Propagation is not available with historical or full valuation scenarios.

Propagation allows you to create scenarios based on other variables, which may not be directly used in re-pricing the
securities in your portfolio. For example, you may want to know how your portfolio might move if inflation goes up, based on the
relationship between inflation and the factors that drive your portfolio.

The mechanics of stressing auxiliary (macro) variables are identical to the mechanics of stressing equity factors. If you are
stressing auxiliary variables, make sure that you select one of the propagation variables in the Main - Summary tab of a factor

model154  scenario:

• No Propagation: Allows you to specify that only the variables you have explicitly stressed will move.
• Use correlations defined by date range: Allows you to keep the shocks applied to particular factors fixed over time

and/or model correlations from a particular historical period (e.g., a market crisis).
• Use correlations defined within Bloomberg Factor Models: Allows you to specify a propagation technique based

on the same covariance matrix that is used to calculate current risk statistics, like Tracking Error155 and VaR156 . This
covariance matrix changes over time, so the shocks applied to particular factors change as well.

If you do not select a propagation option, the stresses you define to auxiliary (macro) variables will have no impact.

For more information on creating explicit factor model scenarios, see Factor Model Scenarios.

FULL VALUATION SCENARIOS

You can define a full valuation scenario that evaluates a portfolio on a forward horizon date, so you can assess potential
performance over a given future timeframe. In essence, horizon analysis (i.e., time shift) simulates moving the valuation date to
a future date, and then revalues the portfolio on that future date.

154 Allows you to shock your portfolio by shifting macroeconomic factors, interest rates, foreign exchange rates, and model
factors in a scenario analysis.

155 Tracking errors are annualized volatilities of active returns, expressed in percentages. Tracking error on security level
shows the contribution to the portfolio level tracking error. This would be the annualized volatility x (relative) weight x
correlation. It is important to keep in mind that there is a difference between the total tracking error and the security level
track error.

Total track error is the standard deviation of the active portfolio (which is the portfolio minus the benchmark), and it can
never be negative. However, when the tracking error is shown broken up in securities or sectors, what is actually shown
is a marginal contribution to tracking error. Then, the security level tracking error shows how sensitive is the total tracking
error when increasing a given position. Usually that number is positive: increasing a given position would make the
returns of the portfolio less alike the returns of the benchmark, thus increasing the total track error.

It can happen due to correlations, however, that increasing a position will make the portfolio more similar to the
benchmark (decreasing the tracking error). In that case, the security contribution to tracking error would be negative.

156 Measured in currency units or as a % of market value, VaR measures the maximum loss projected given inputs for the
time horizon and confidence level. VaR can be measured on the portfolio, benchmark, or active/difference portfolio.
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In a full valuation scenario, spreads are calculated for instruments in the portfolio, then the underlying curve is shifted and the
instrument is re-priced. The shifts within a full valuation scenario are considered independent from each other. If one parameter
is shifted, the rest of the market data remains constant unless specified otherwise within the full valuation global settings.
For more information on full valuation scenario analysis, see the document Scenario Analysis for Fixed Income & Balanced
Portfolios.

Note that full valuation only works for instruments that can be priced using a model.

Prior to creating a full valuation scenario, you can modify the default global settings for full valuation scenarios. For more
information, see Full Valuation Scenario Settings.

To set up a full valuation scenario:

1. In the Scenario Manager screen, from the Scenario Methodology field, select Full Valuation.
 

 

Note:  For more information on accessing the Scenario Manager screen, see Accessing Scenarios.
2. From the toolbar, select Actions > New Scenario.

 

 
The Scenario Details section appears.

3. In the Name field, enter a name for your scenario.

Note:  If you want to add a description of or notes about the scenario, select the Properties link and complete the Notes
field, then click the Apply button.

4. If you are shifting interest rates or equity prices, select the Main tab, then choose the Settings sub-tab and update your
local settings:
 

bbg://screens/BPS L#2291453
bbg://screens/BPS L#2291453
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• Shifting VCUB underlying curves based on Curve Shifts: Indicates that volatility shifts will be based on shifted
swap curve values instead of original (not shifted) curves.

• Honor Global Settings: Indicates that the global equity price shift settings are respected in the scenario analysis. If
unchecked, the default global settings are used.

Note:  Global settings are accessible from the toolbar by clicking the Settings button. For more information on global
settings, see Full Valuation Scenario Settings.

5. If you want to stress interest rates by shifting currencies or changing the shape of the swap or treasury curve, select the IR
tab, then update the settings in the Swap Curve Shift or Treasury Curve Shift sub-tab:

 

 

a) From the Currency drop-down menu, select the currency of the curves to shock.

Note:  If you want to shock all currency curves, complete the first row, which defaults to ALL.
The Curve, Mode, Type and Value fields activate.

b) In the Curve field, select the specific curve to shock.
c) In the Mode field, choose whether you want to perform an Absolute Shift or Percentage Shift on the curve, or enter

an Override Value.
d) In the Type field, choose whether the shock is a Parallel, Flatten/Steepen, or Custom shift.

Note:  If you want to customize the interest rate shock, select Custom, then enter the shift parameters in the
Curve Shift window. For more information on customizing shifts, see Custom IR Curve Shifts.
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e) In the Value field, enter the extent of the shift, which can be positive or negative.
|Hint| You can shift as many currency curves as needed. To remove a curve, click the corresponding red (X).

6. If you want to perform a parallel shift on the implied volatility calculated for listed and OTC options, select the IR tab, then
update the settings in the IR Vol Shift sub-tab:
 

 

a) From the Currency drop-down menu, select the currency of the curves to shock.

Note:  If you want to shock all currency curves, complete the first row, which defaults to ALL.
The Mode and Value fields activate.

b) In the Mode field, choose whether you want to perform an Absolute Shift or Percentage Shift on the implied
volatility.

c) In the Value field, enter the extent of the shift, which can be positive or negative.
7. If you want to shift the option adjusted spread (OAS)157  based on a sector or specific reference name, select the Credit

tab, then update the settings in the CDS/OAS Shift sub-tab:
 

 

a) In the OAS/ZDM Shift section, from the Controller field, choose whether the shift is applied according to Sector or
Ticker.

157 The option adjusted spread. The flat spread that must be added to the yield curve in a pricing model to discount a
security payment to match its market price.
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The Sector/Ticker, Mode, and Value fields activate. If you select Ticker, the Propagate to field also activates.
b) In the Sector/Ticker field, choose a sector or enter a bond ticker.
c) In the Propagate to field, select a propagation option for the shift.
d) In the Mode field, choose whether you want to perform an Absolute Shift or Percentage Shift on the curve, or enter

an Override Value.
e) In the Value field, enter the extent of the shift, which can be positive or negative.

8. If you want to shift CDS curves, select the Credit tab, then update the settings in the CDS/OAS Shift sub-tab:
 

 

a) In the CDS Curve Shift section, from the Controller field, choose whether the shift is applied according to Sector or
CDS Curve.
The Sector/CDS, Mode, Type, Quote, Value, and Rec. Rate fields activate.

b) In the Sector/CDS field, choose a sector or enter the name of a CDS curve.
c) In the Mode, Type, Quote, and Value fields, choose how you want to the type and extent of the shift you want to apply to

the curve.
d) In the Rec. Rate field, enter the recovery rate for the curve.
e) If you want to apply the CDS shift to the option adjusted spread (OAS)158  of the corresponding bonds, check the OAS

option.
9. If you want to perform other shifts as part of your full valuation scenario analysis, specify the shifts you want to apply from

the available tabs. For more information on each of the tabs described below, see Full Valuation Shifts.
 

 

• IR - Bond Recovery Rate: Allows you to explore the impact of recovery rate changes on credit default swap and
convertible bond valuation.

158 The option adjusted spread. The flat spread that must be added to the yield curve in a pricing model to discount a
security payment to match its market price.
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• Equity: Allows you to shift underlying price, volatility, and dividend yield for equity instruments.
• Comdty: Allows you to shift the underlying future price and implied volatility for commodities.
• Inflation: Allows you to shift the inflation swap curve rates available in the Inflation Bond/Swap Settings (SWIL)

function.
• FX: Allows you to shift foreign exchange spot rates and volatilities.
• Mortgages: Allows you to perform scenario analysis on the main factors of the Bloomberg Prepayment model (BPM)

for mortgage instruments.
10.To review the parameters of your full valuation scenario, return to the Main - Summary tab.
11.To save the scenario, from the toolbar, select Actions > Save.

 

 
The Scenario Details window appears.

12.Choose a Scenario Group Name in which to save the scenario (e.g., My Full Valuation Set).

Note:  For information on creating scenario groups, see Creating Scenario Groups.
13.Click the Save button.
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The scenario saves, and the Scenario Manager screen appears. Your newly created full valuation scenario appears at the
end of the list of scenarios in your selected group.

For more information on editing, copying, and deleting scenarios, see Editing Scenarios, Copying Scenarios, and Deleting
Scenarios.

DISPLAYING SCENARIOS

You can display and review the scenarios that others in your firm have created.

To see scenario details:

1. In the Scenario Repository section of the Scenario Manager screen, click the group in which the scenario you want to
display resides (e.g., Interest Rate & Credit Shifts).

Note:  For more information on accessing the Scenario Manager screen, see Accessing Scenarios.

 

 

Your selection is shaded in blue and associated scenarios appear in the Scenario Group Details section.

2. Click the info icon (i) to the right of the scenario you want to display (e.g., IR -25bps).
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The Scenario Details section appears, defaulting to the Main - Summary tab, which explains the shifts enabled in this
scenario. To see corresponding scenario information, click through the subsequent tabs.

For information on copying existing scenarios, see Copying Scenarios.

CREATING SCENARIO GROUPS

PORT displays stress testing results in terms of scenario groups, which are families of scenarios that can be viewed
simultaneously. To be able to see results for a scenario, you need to include the scenario in at least one scenario group. You
can also include individual scenarios in multiple scenario groups.

To create a new scenario group:

1. From the toolbar in the Scenario Manager screen, select New > New Scenario Group.

Note:  For more information on accessing the Scenario Manager screen, see Accessing Scenarios.
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The Scenario Group Details section appears.
2. In the Name field, enter a name for your group.
3. In the table, select the corresponding checkboxes for the scenarios you want to include in the scenario group, then click the

-> button to insert the scenario into the group.
 

 
|Hint| If you want to search for scenarios, enter the keyword(s) in the search field at the top of the Name column, then
press <Go>. The corresponding search results appear.

4. If you want to modify the order of scenarios in the group, press the Move Up and Move Down buttons.
 

 
5. If you want to remove scenarios from the group, in the Selected Scenarios tab, select the checkboxes next to the scenarios

you want to remove, then click the <- button.
6. From the toolbar, select Actions > Save.

The Scenario Group Details window appears.
7. Click the Save button.

Your newly created group appears in the My Scenario Groups section in the Scenario Repository.

For information on editing, copying, and deleting scenario groups, see Editing Scenario Groups, Copying Scenario Groups,
and Deleting Scenario Groups.

REPORTING
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You can generate reports of portfolio data from the Actions menu in PORT, so you can quickly generate summaries of PORT
data for offline analysis.

For more information on generating reports, see Using Bloomberg Reports.

USING BLOOMBERG REPORTS

You can access standard reports maintained by Bloomberg, so you can quickly generate an on-demand summary of portfolio
attribution or characteristics.

To generate a Bloomberg report, from the toolbar, select Actions > Generate Report (Bloomberg) > (Option).
 

 

The table below explains the available reports:

Report Generates

Attribution Template (PDF) A PDF report of attribution information, including the top 20 and bottom 20 securities
in the portfolio in terms of contribution to return, total return, relative weight, and
relative return, plus holding-level details and a summary of the portfolio. This report also
displays exceptions to each attribution calculation.

Attribution Template (xls) A Microsoft® Excel report of attribution information displayed within separate tabs,
including the top 20 and bottom 20 securities in the portfolio in terms of contribution
to return, total return, relative weight, and relative return, plus holding-level details and
a summary of the portfolio. This report also displays exceptions to each attribution
calculation in separate tabs.

Characteristics Summary (PDF) A PDF report including a one-page summary of portfolio characteristics, which are
dependent on the securities represented in the portfolio.
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You can also customize the standard reports and save the customizations as new templates. For example, you can customize
the Characteristics Summary report to include a % Weights pie chart or field details. For more information on customizing
reports and saving templates, see Creating Report Templates.

GENERATING REPORTS

You can generate reports for holdings, performance, and other data in either PDF or spreadsheet form. Reports are specific to
the currently selected tab.

You can also create custom report templates, which allow you to combine different tabs into one report. For more information,
see Creating Report Templates.

Note:  You cannot download funding data.

From the toolbar, select Actions > Generate Report (Bloomberg) > (Excel / PDF Option).
 

 

A message appears at the top of the screen indicating that your report is running. The report is generated using the Retrieve
and Monitor Reports (RPT) function. If you want to check the status of your report, enter RPT <Go>. When the report is
complete, the corresponding spreadsheet or PDF appears on your computer. For more information on RPT, see RPT <Help>.

SETTINGS

The Settings toolbar button provides access to function settings that control the calculation defaults for your selected view,
manage the appearance of the portfolio, and enable look-through functionality.
 

bbg://screens/HELP RPT
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Note:  Some of the settings available in PORT do not appear in the Settings tool.

• Calculation Defaults: For more information on updating the basic calculation defaults for your current view, see Setting
Calculation Defaults.

• Show Benchmark Securities: For more information on showing or hiding the benchmark to which your portfolio is
compared, see Showing/Hiding Benchmarks.

• Show Intraday Chart: For more information on working with the intraday chart, see Intraday Monitor Chart.
• Portfolio Look-Through: For more information on enabling look-through functionality for the funds or ETFs in your

portfolio, so you can better understand your sector exposures and generate meaningful performance attribution analysis,
see Enabling Look-Through.

• Benchmark Look-Through: For more information on enabling look-through functionality for the funds or ETFs in your
benchmark, so you can better understand your sector exposures and generate meaningful performance attribution analysis,
see Enabling Look-Through.

For information on additional settings, including excluding or including specific securities in your analysis, displaying security
exceptions, and setting up proxies, see Excluding Securities, Displaying Exceptions, Setting Up Proxy Assets.

SETTING CALCULATION DEFAULTS

When analyzing positions in PORT, you must select a view that controls the default appearance, calculations, methodology,
sources, and units for the selected portfolio. You can select and update all view settings in the View Manager, or you can
modify the calculation defaults only in the Calculation Settings window.

To update your calculation defaults:

1. From the toolbar, select Settings > Calculation Defaults.
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The Calculation Settings window appears.

2. Update your calculation defaults:

• Pricing Sources: Customize the prices and sources used for specific instruments in the portfolio analysis. For more
information on setting your pricing source defaults, see Pricing Source Defaults.

• Attribution Defaults: Customize the attribution default settings for equity and fixed income/balanced portfolios. For
more information on setting your attribution defaults, see Attribution Calculation Defaults.

• Risk Defaults: Customize the risk factor calculation defaults, including your default risk model, for VaR and tracking
error calculations. For more information on setting your risk defaults, see Risk Factor Calculation Defaults.

3. If you want to access all settings available for the view, click the Advanced button.
The View Manager appears. For more information on using the view manager to update the advanced defaults, see
Advanced View Defaults.

4. To save your changes, click the Save button.
 

 

Your changes are saved and incorporated in future portfolio calculations.
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ENABLING LOOK-THROUGH

If your portfolio or benchmark contains funds or ETFs, you can optionally "look through" them to their underlying holdings.
Enabling fund look-through can give you a more accurate understanding of your sector exposures and can also generate more
meaningful performance attribution analysis.

Note:  For more information on exposure and attribution analysis, see Analyzing Exposures and Attribution Tab.

To enable look-through for portfolios and/or benchmarks:
From the toolbar, select Settings > (Portfolio / Benchmark) Look-through.
 

 
The analysis is re-calculated. Using this option temporarily replaces the funds or ETFs in your portfolio (or benchmark) with
their underlying securities while maintaining the same total market values and weights relative to the rest of your portfolio.

You can also enable portfolio and/or benchmark look-through in your view by default in the View Manager. For more
information, see Advanced View Defaults.

SHOWING/HIDING BENCHMARKS

Across all of PORT's tabs, you can choose to hide or display the benchmark securities against which you are comparing your
portfolio.

From the toolbar, select Settings > Show Benchmark Securities.
 

 
The securities appear or are hidden based on your selection.



>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //121

EXCLUDING SECURITIES

You can exclude a portion of your portfolio or benchmark from analysis in PORT, which allows you to see how the performance
or characteristics of your portfolio would differ without a given sector or instrument, or without excess trading cash. The
exclusions tool also allows you to include only a specific portion of the portfolio or benchmark in the analysis.

Once the exclusion or inclusion is applied, the remaining instruments in the portfolio and benchmark are re-weighted to 100%
for the analysis.

To exclude or include securities:
1. From the toolbar, select Actions > Exclude Securities.

 

 
The Choose Action window appears.

2. From the first drop-down menu, select Exclude or Include Only to determine the exclusion action type:
 

 
• Exclude: Removes all securities that meet the selected criteria from the portfolio.
• Include Only: Removes all securities from the portfolio, except those that meet the selected criteria.

3. From the second drop-down menu, select the exclusion or inclusion, such as cash or a specific sector (e.g., Energy
{GICS}).
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4. If you want to exclude individual securities or a custom classification, click the Exclusion Editor button.
The Custom Sector Exclusions (PXCL) function appears, where you can set up a custom exclusion rule. For more
information, see PXCL <Help>.

5. If you want to remove the exclusions, from the first drop-down menu, select None.

6. Click the Select button.
The portfolio and benchmark are re-weighted based on your selections. Your exclusions appear in parentheses next to the
portfolio name, e.g., BBDEX (Including Only: Energy {GICS}).

DISPLAYING EXCEPTIONS

If security exceptions are present in your portfolio, a red warning message appears at the bottom of tab informing you of the
number of exceptions. An exception is a security that is not covered by PORT analytics. An example of an exception reason is
“This instrument is no longer active." As such, it cannot be factored into the overall calculation of your portfolio.
|Hint| You can create a proxy for a security exception, so it can be included in risk and characteristic analysis and reporting.
For more information, see Setting Up Proxy Assets.

To see exceptions:

1. At the bottom of the Main View sub-tab, click the red (!) # Notices warning.
 

 

The Exceptions window appears and displays the ticker number, security identification, and reason for all exceptions.

2. Select the filters for the exceptions list:

 

bbg://screens/HELP PXCL
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• Filter by Portfolio: Filter the list of exceptions by the relevant portfolio.
• Filter by the Origin: Filter the list of exceptions by the source, i.e., All, Portfolio, or Benchmark.

3. If you want to perform further analysis on an exception, right-click the security and select from the available options (e.g.,
Description (DES), Company News and Research (CN), or Historical Table (HP).
The information appears in another window. For more information on an option, see the associated Help Page, e.g., HP
<Help>.

4. If you want to create a proxy for the exception, which allows you to effectively evaluate your portfolio as a whole, click the
corresponding Proxy button. For complete instructions on setting up a proxy, see Setting Up Proxy Assets.

5. If you want to export the list of exceptions to a Microsoft® Excel spreadsheet, click the Export button.
The list of exceptions appears in an Excel spreadsheet.

SETTING UP PROXY ASSETS

You can set up proxy assets for security exceptions, so you can effectively evaluate your portfolio as a whole. PORT allows you
to proxy the risk attributes and security level characteristics of one security to another.

Once proxied, the security is no longer considered an exception and is included in your risk and characteristic analysis and
reporting. Proxied securities apply across all tabs. Descriptive data and classifications of the original security are maintained for
more accurate reporting.
|Hint| You can also set up a proxy in the Creating/Updating Portfolios (PRTU) function. For more information on using PRTU to
set up and manage proxies, click here .

To set up proxy assets in PORT:
1. At the bottom of the Main View sub-tab, click the (!) # Notices warning.

 

bbg://screens/HELP HP
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The Exceptions window appears with a list of security exceptions that you can proxy.

2. For the exception you want to proxy, click the Proxy button.
 

 

The Personal Proxy Configuration window appears. The security being proxied appears (greyed out) in the Original
Security field. The currency for the security and the security type also appear.

3. In the Proxy Security field, enter the proxy security, or click the Search button to search for securities that meet similar
criteria as the original security.

Note:  The smart search tool is available when setting up proxies for fixed income securities only.
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The associated Currency and Type fields update, so you can see if the parameters match the original security.

4. Set up your proxy preferences:

 

 

• Proxy Security Risk Factor Exposures: The original security takes on the exposure of the proxy security to its risk
factors. Enter a multiplier in the adjacent field to apply to the risk factors if the proxy represents different exposure values
than the original.

• Proxy Security FX Exposure: The original security takes on related FX exposure if the original and proxy securities are
denominated in different currencies.

• Proxy Security Characteristics: The original security takes on the characteristics of the proxy security.
• Proxy Security Price: The original security uses the price of the proxy security. Applies to equities only.
• Price Multipliers: Enter a multiplier to apply to the proxy and/or prices. This may be required if the proxied stock

represents multiple shares of another security. Applies to equities only.

5. Click the Save button.
PORT refreshes with analytics for the newly created proxy. The security is no longer listed as an exception. An asterisk
next to the security in the Name column indicates the security has an assigned proxy.

The proxy also applies to other portfolios in which the security resides, so you do not have to repeat the proxy setup for
each portfolio. This is true for both equity and fixed income assets.

Complete management of proxy assets is available in the Creating/Updating Portfolios (PRTU) function. In PRTU, you can
share proxies with other users, remove a proxy, and display an audit of changes to the proxy. For more information on using
PRTU to manage proxies, click here .

bbg://screens/LPHP PRTU:0:1 1956080
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CALCULATIONS

GENERAL

FUTURES & OPTIONS

PORT supports the following listed equity derivatives: Equity Index Futures, Single Stock Futures & Futures Options, Listed
Equity Options, Listed Index Options, Commodity Futures, Listed Options on Equity Index & Commodity Futures.

Market Value of Futures Contracts: The market value of futures contracts in your portfolio may equal zero (0) at the close
of day. Because futures contracts are settled daily, any P&L added to the margin (the market value) at the close of business is
zero.

To calculate weight and, in turn, contribution to return (CTR), PORT uses the nominal contract value as the basis for exposure.
The nominal value of a futures contract is obtained by multiplying the futures value of one point by the traded price.

Market Value of Options Contracts: PORT calculates the market value of options contracts as:

• Number of Contracts * Contract Size * Price of Option Contract

% Weight of an options contract is calculated as the market value of the contract divided by the total market value of the
portfolio. PORT Intraday also supports delta-adjusted exposure for options.

Economic Cash: Economic cash appears when the market value of an instrument is not equal to its nominal exposure value.
When exposure is not equal to market value, in the case of a leveraged instrument, economic cash can be generated to ensure
that the portfolio notional exposure is equal to the portfolio market value, and that all weights sum to 100%.

For long/short portfolios, portfolio weights do not need to add up to 100%. In this case, you can disable the automatic
economic cash generation process in your portfolio view. For more information, see General Calculations.

Portfolio Return Including Futures: To calculate weight and, in turn, contribution to return (CTR), PORT uses the nominal
contract value as the basis for exposure. The nominal value of a futures contract is obtained by multiplying the futures value of
one point by the traded price.

The contribution to portfolio return of a futures contract is calculated as follows:

• CTR = % Weight * (Futures P&L / Nominal Contract Value)

Where:

• % weight is the nominal contract value / total market value of the portfolio

• nominal contract value = the futures value of one point * the price.

FX FORWARDS

PORT allows you to hedge your foreign currency positions into the base currency of the portfolio, and to close out those
hedges by either letting them expire, or by entering an offsetting position. PORT supports this by allowing you to book foreign
exchange forwards that will mitigate or damper the currency risk of holding foreign securities.
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FX forwards are treated as special hedging vehicles that impact the return of any security of the hedged currency. Currently
FX forwards can only be used to hedge exposure in a currency other than the portfolio currency back to the portfolio currency
(or the inverse to take off the hedge). To book a hedge, use the following sample syntax in the Bloomberg Uploader (BBU)
function:

PID Ticker Quantity Date Cost

FX_HEDGED F equity 1000 20081231
 

FX_HEDGED BMW GY equity 100 20081231
 

FX_HEDGED EUR/USD 12/31/2010
curncy

-2200 20081231 1.3953

         

FX_HEDGED F equity 1000 20091231
 

FX_HEDGED BMW GY equity 75 20091231
 

FX_HEDGED EUR/USD 12/31/2010
curncy

-2200 20091231 1.3953

FX_HEDGED USD/EUR 12/31/2010
curncy

-3150 20091231 0.6984

Note:  For more information on BBU, see BBU <Help>.

In the above example, on the last day of December 2008, the portfolio held a position in BMW valued at 2,200 Euros. To
hedge this exposure on the above USD portfolio, 2,200 Euros were sold forward for dollars at a rate of 1.3953 Dollars per
Euro.

One year later, the hedge was taken off by selling 3,150 dollars for Euros at the then prevailing rate of .6984 Euros per Dollar.
At this point the portfolio is exactly equivalent to a portfolio with only the long positions in Ford (F equity) and BMW (BMW GY
equity).

As an alternative the initial hedge could have been booked by purchasing 3,070 Dollars for Euros (e.g. USD/EUR 12/31/2010
curncy at a rate of .7167) and then closed out at end of 2009 (e.g. EUR/USD by buying 2,144 Euros for Dollars at a rate of
1.4318).

You can use the Historical Fund Analysis (HFA) function to analyze the effects of hedging by comparing the un-hedged
portfolio to the hedged portfolio. For more information on HFA, see HFA <Help>.

INDEX METHOD AGGREGATION

In the Characteristics tab, some fields are aggregated using the "Index Method," which closely matches the approach used
by many equity benchmark index providers. The following general groups of fundamental indicators are supported for Index
Method aggregation in PORT:
• Price Ratios (e.g., Price to Earnings, Price to Cash Flow)
• Growth Ratios (e.g., Year on Year Net Income Growth)
• Other Compound Ratios and Indicators (e.g., ROE, Current Ratio)

bbg://screens/HELP BBU
bbg://screens/HELP HFA
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Per-share fundamentals and estimates (e.g., Earnings per Share, Book Value per Share) are not aggregated on PORT.

Price Ratios: The index level aggregation formula for price ratios is:
 

 

Thus:
 

 

The same approach can be applied to portfolios:
 

 

For example, the aggregated Price to Earnings Ratio is calculated as:

Total Portfolio Market Value / Total Portfolio Earnings

Conceptually, the denominator is the sum of all the earnings “owned” in the portfolio, by owning a number of shares of each
company.

Growth Ratios: In general, the growth ratio of a fundamental/estimate measure is computed as the growth of the aggregated
portfolio-level measure, assuming the portfolio has been constant over the analysis period. In other words, the growth of:
• the aggregated measure computed with:

— security-level measures at the end of the period
— portfolio holdings at the end of the period,

and
• the aggregated measure computed with:

— portfolio holding at the end of the period
— security-level measures at the beginning of the period

More formally:
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For example, the aggregated Earnings Growth is calculated as:
 

 

Other Compound Ratios and Indicators: Other ratios are computed at the portfolio level by combining aggregated
components. The same formula used for security-level ratio computation is applied on aggregated measures. In this way, any
ratio which combines valid portfolio aggregates can be computed.

For example, the Current Ratio is calculated as:

Total Portfolio Current Assets / Total Portfolio Current Liabilities

PRICING & FX SOURCES

PORT provides several options for pricing and FX.

Equity Pricing: For intraday performance monitoring, PORT uses primary exchange prices with an option to use composite
prices. For historical performance and attribution, PORT provides the option to use composite, primary exchange, and MSCI
prices.

Custom prices can be provided for private equities or funds created using the Equity Custom Security (EQPL) function. The
custom prices can be provided by typing them into the corresponding portfolio via the Creating/Updating Portfolios (PRTU)
function, uploading them with the portfolio via the Bloomberg Uploader (BBU) function, or uploading prices or net asset value
into a custom field in the Custom Data Editor (CDE) function, with the Content Type set as "Price". The Data Source you
specify for the "Price" field can then be selected as part of the Fixed Income & Private Equity Historical Data price waterfall.
For more information on customizing your price waterfall, see Customizing Price Waterfall.

Fixed Income (all tabs except Intraday): Fixed income instruments include sovereigns, corporates, agency debentures,
securitized bonds, convertible bonds, and loans. The following sources are currently available for fixed income instruments in
PORT:
• Index Provider: The prices from the index provider you are benchmarked against. This only applies when you compare your

portfolio to the benchmark in PORT.
• BVAL: Close-of-day (bid-side) 4PM price snapshot by region.
• Local: Local pricing sources, such as MICX and MICB (Russia), ANBE (Brazil), PIPV (Mexico), BMA / PBMA (South

Africa), and KCMP (South Korea).
• Custom (Portfolio-Linked): Client-supplied prices. You can provide your own prices by typing them into the portfolio via

PRTU or uploading them with the portfolio via BBU. For more information on these functions, see PRTU <Help> and BBU
<Help>.

bbg://screens/HELP PRTU
bbg://screens/HELP BBU
bbg://screens/HELP BBU
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|Hint| When providing prices within a portfolio (either via PRTU or BBU), the prices are specific to that portfolio.
• Custom (Portfolio-Independent): Client-supplied prices. If you want to upload one or more sets of custom prices

independent of a specific portfolio, you can upload prices to a field of Content Type "Price" via CDE. Each price field must
be specified with a different Data Source. For more information on using CDE, see CDE <Help>.

You can also choose to capture portfolio-linked prices uploaded with a portfolio into a portfolio-independent source by
creating a field in CDE of Content Type "PRTU Price" (the field is automatically assigned a Data Source of "Portfolios"). If
you price the same bond on the same day in two different portfolios, only one price is stored (the last one uploaded) in the
"PRTU Price" field.

Note:  The Data Sources you use to specify the "Price" fields as well as the "PRTU Price" field can then be selected
as part of your custom price waterfall. For more information on customizing your price waterfall, see Customizing Price
Waterfall.

• AIM (available to AIM Analytics clients only): Custom prices from Bloomberg's Asset and Investment Manager (AIM). For
more information, see AIM <Help>.

PORT offers several price waterfall159  permutations of the above-mentioned pricing sources for portfolios and benchmarks,
such as Index Provider else BVAL else Portfolio. You can also create your own customized waterfall, which can include any set
of available pricing sources. Price waterfalls are available in the Fixed Income & Private Equity Historical Data section of the
Pricing Source defaults window. For more information on setting up and customizing price waterfalls, see Customizing Price
Waterfall.

Fixed Income Intraday: For fixed income intraday, PORT offers the following sources to track intraday indicative P&L
changes:
• MSG1: Intraday prices automatically scraped from your Bloomberg Messages
• TRAC: TRACE bond prices
• EXCH: Exchange prices
• CBBT: FIT Composite (average of executable prices on FIT)
• BGN: Bloomberg Generic Prices
• BVAL: BVAL prices

FX Rates: For multi-currency portfolios, PORT offers the following options for FX rates when converting prices from one

currency to the Reporting Currency160 :
• Use the FX rate provided by the index vendor of the benchmark utilized, else the Bloomberg FX fixing rate from London at

4PM, else the Bloomberg composite rate from London at 6PM.
• Use the Telegraphic Transfer Middle (TTM) rate, else the Bloomberg composite rate from London at 6PM.

Note:  TTM is the industry standard FX rate used for Japanese Investment Trusts.
• Create a customized FX rate waterfall using all available sources, including BFIX at a variety of snap times, several index

vendor provider sources, TTM, the Index Provider source (which is a wildcard source defined as the source associated with
the benchmark chosen at the time of analysis), and custom rates uploaded to a field of type "Price" to a currency spot ticker
(e.g., EUR <Crncy>) via BBU. For more information on custom FX rates, see Using Custom FX Rates.

159 A hierarchy of sources used to specify the priority of pricing sources you want to use. For each day in the analysis,
instruments are priced by checking for a price from the first source in the hierarchy. If not found, the next price source on
the list is checked. The process continues until a price is found. For historical analysis such as performance attribution,
PORT looks back up to 10 business days to find prices for the start date of the analysis. From that day forward, if the
price source hierarchy fails to find a price for a given day, the last known price is carried forward.

160 The currency used in the analysis, as indicated by the selection in the Curr drop-down menu of any Main View sub-tab.
By default, the currency under analysis is the portfolio base currency.

bbg://screens/HELP CDE
bbg://screens/HELP AIM
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The table below describes the FX rate sources supported in PORT and their earliest date of availability.

FX Rate Source Earliest Available Date

Bloomberg 4PM London January 2009

Bloomberg 12PM London January 2009

Bloomberg Composite (6PM London) January 2000

MSCI 4PM London January 1999

FTSE 4PM London January 1999

Dow Jones 4PM London January 1999

S&P 4PM London January 1999

Telegraphic Transfer Middle (TTM) January 2009

CDE Sources (User-defined) Unique to user upload

HSBC January 2011

MSCI Index Prices: MSCI indices and prices are generally updated by 3AM EST for T-1 data. If your historical pricing source
is set to MSCI under Calculation Defaults, PORT does not show returns for T-1 until this update is complete.

PORT supports up to 7 years of MSCI analysis. When using MSCI, typically you can only see month-end data when going
back beyond the first year. Thus, with an MSCI index (on either the portfolio or benchmark side), you cannot enter mid-month
dates beyond the first year. For example, you can only select 12/31/2009, not 12/15/2009. For more information on setting
MSCI index prices as a pricing source, see Pricing Source Defaults.

FIXED INCOME PRICE LOOKBACK

PORT looks back up to 10 days to identify fixed income security prices to use on a particular day. This section describes the
fallback method for single date and historical portfolio analyses.

When conducting a single date portfolio analysis (e.g., in the Holdings, Characteristics, and Tracking Error tabs), PORT
attempts to identify a price from any of the sources specified in your price waterfall, which is configured in the pricing source
defaults section of your view. If a price on the analysis date is not found, PORT looks for a price by examining the price source
waterfall for up to 10 days in the past. If a price is identified, it is carried forward to the requested analysis date. If no price is
found using this fallback method, an exception occurs.

When conducting an historical portfolio analysis (e.g., in the Performance and Attribution tabs), PORT first attempts to identify
a price for the start date of the analysis from any of the sources specified in your price waterfall. If a price on the start date is
not found, PORT looks for a price by examining the price source waterfall for up to 10 days in the past. If a price is identified,
it is carried forward until an explicit price is found using the specified price waterfall. If no starting price is found using this
fallback method, an exception occurs.
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• For information on setting up your price waterfall, see Customizing Price Waterfall.
• For information on configuring your pricing source defaults, see Pricing Source Defaults.
• For information on addressing security exceptions, see Displaying Exceptions.

OVERRIDING FIXED INCOME ANALYTICS

PORT generates instrument-specific analytics based on prices derived from your chosen price waterfall. These analytics are
then used to derive portfolio-level characteristics, performance, and risk measures. You can override these analytical fields with
your own values, so you can supplement PORT's coverage of fixed income securities, leverage your firm's internal models, or
feed analytics from another licensed index vendor.

To set up your analytical overrides, you must create a custom data field of the content type you want to override using the
Custom Data Editor (CDE) function, associate it with a specific data source, then upload the override values to the field using
the Bloomberg Uploader (BBU) function. For information on creating custom data fields in CDE, click here . You can also
quickly create custom data fields on the fly when uploading data via BBU. For information on uploading analytic values to a
new custom field using BBU, click here .

To enable your custom analytics for a portfolio, you must select the data source with which you associated the custom data
field in the Portfolio Waterfall window. For information on setting up your price waterfall and selecting an override data source,
see Customizing Price Waterfall.

Note:  To see a video on overriding fixed income analytics in PORT, click here.

Minimum Requirements: In order to successfully include a bond in performance attribution (except when using the Brinson

Model), you typically need to provide at least one Key Rate161 , an Option Adjusted Duration (OAD)162  that is the sum of all

the key rates you provide (missing key rates are set to zero), and an Option Adjusted Convexity (OAC)163 . The spread-based

models and risk analytics also require Option Adjusted Spread (OAS)164 , Option Adjusted Spread Duration (OASD)165 , and

Modified Duration166 .

The following analytical fields support user-defined overrides:

Field Measures

6mo Key Rate The sensitivity of the portfolio to a single basis point shift at the six-month rate.

1yr Key Rate The sensitivity of the portfolio to a single basis point shift at the one-year rate.

2yr Key Rate The sensitivity of the portfolio to a single basis point shift at the two-year rate.

161 A measurement of the sensitivity of the portfolio to a single basis point shift at a specific rate.
162 A measurement of the bond duration considering embedded options (e.g., dynamic cash flows due to change rates).
163 A measurement of the convexity of the bond considering embedded options (e.g. dynamic cash flows due to change

rates).
164 The option adjusted spread. The flat spread that must be added to the yield curve in a pricing model to discount a

security payment to match its market price.
165 A measurement of the sensitivity of price to a one percent change in option adjusted spread.
166 A measurement of the percentage change in price for a given change in yield.

bbg://screens/LPHP CDE:0:1 813306
bbg://screens/LPHP BBU:0:1 2545198
bbg://screens/PLYR VOD 201690179
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Field Measures

3yr Key Rate The sensitivity of the portfolio to a single basis point shift at the three-year rate.

5yr Key Rate The sensitivity of the portfolio to a single basis point shift at the five-year rate.

7yr Key Rate The sensitivity of the portfolio to a single basis point shift at the seven-year rate.

10yr Key Rate The sensitivity of the portfolio to a single basis point shift at the 10-year rate.

20yr Key Rate The sensitivity of the portfolio to a single basis point shift at the 20-year rate.

30yr Key Rate The sensitivity of the portfolio to a single basis point shift at the 30-year rate.

Modified Duration The percentage change in price for a given change in yield.

OAD (Option Adjusted
Duration)

The bond duration considering embedded options (e.g., dynamic cash flows due to change
rates).

OAS (Option Adjusted
Spread)

The spread relative to the standard swap or sovereign curve in the denomination currency of
the bond. The spread specified for the OAS field is added to a specific curve based on your
selection in the Discount Curve field in your General Calculation Settings.

For performance calculations, the following security types follow a specific spread behavior
(ignoring your selection in the Discount Curve field):
• Municipal Bond: always spread to the muni curve

• Cash Instruments: always zero spread

• Convertibles: always spread to the credit curve

• Preferreds, Loans, Options on Bond Futures: always spread to the swap curve

OASD (Spread Duration) The sensitivity of price to a one-percent change in option adjusted spread.

Modified Convexity The sensitivity of the modified duration of a bond to changes in interest rates.

OAC (Option Adjusted
Convexity)

The convexity of the bond considering embedded options (e.g. dynamic cash flows due to
change rates).

Yield-to-Maturity The percentage rate of return paid if the security is held to its maturity date.

Yield-to-Worst The lowest yield a buyer can expect among the reasonable alternatives.

Average Life The length of time the principal of a debt issue is expected to be outstanding.

Composite Rating A rating for a bond not rated via the Bloomberg Composite Rating field.
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Field Measures

Accrued Interest The daily accrued interest on a position in decimal format (e.g., 0.03 equals a three-percent
accrual). To generate custom cash flows, you must enter the accrued interest each day;
otherwise, the PORT engine defaults to the daily accrual data maintained by Bloomberg.

Income Cash Flow The coupon payment in decimal format (e.g., 0.03 equals a three-percent coupon).

Factor For amortizing bonds, the amortization factor in decimal format (e.g., 0.99 represents
99-percent).

Note:  In order to mitigate extreme risk estimations, analytical overrides for option adjusted spread (OAS) and spread duration
(OASD) are capped within a percentile range among the overall population of the instrument's asset class. The minimum and
maximum caps range between the 1st and 10th percentiles and between the 90th and 99th percentiles, respectively, based
on the asset class of the security.

RETURN ON CASH

PORT supports multiple ways for you to generate a return on your portfolio's cash positions in their local currency. The cash
return method is set in your general calculation settings for a specific portfolio view.

Note:  For complete instructions on how to set the return on cash option, see General Calculations.

The following options are available when determining your preferred portfolio or position-level return on cash method:
• Portfolio Fixed Rate: Uses a fixed rate of return for portfolio-level cash in the portfolio currency. To use this option, you

must first select the Enable Fixed Rate Return on Cash option in the PRTU Advanced Settings window for a specific
portfolio. Once you save this selection, the Return on Cash field appears on the PRTU security editing screen for you to
enter your custom rate of return for the portfolio cash. For more information on PRTU, see PRTU <Help>.

Note:  The rate can change over time as you update the Return on Cash field.
• Pre-Defined Money Market Program: Simulates an investment in a money market to see a return on cash in your

portfolio analysis. PORT uses a pre-defined money market program for each currency, as listed in the table below. The
Bloomberg pre-defined money market programs are linked to the one-month EURIBOR for EUR and to the corresponding
one-month LIBOR for other currencies.

• Custom: Uses a set of custom cash returns uploaded or entered in the Custom Data Editor (CDE) function for any
currency cash you have in your portfolio, rather than only at the portfolio level. To upload custom cash returns, create a field
of content type "Cash Return" in CDE and associate it with a specific source, then upload or enter the relevant currency
cash returns to a cash currency security (e.g., GBP <Crncy>, CHF <Crncy>). Then, in PORT, select the source name
from the Return on Cash drop-down menu. For more information on uploading custom data via CDE, see CDE <Help>.

• None: Specifies that there is no return on cash in the portfolio.

The following table displays related money market programs:

Currency Code Pre-Defined Money Market Program

Argentine Peso ARS ARS CASH M-Mkt

Australian Dollar AUD AUD CASH M-Mkt

Brazilian Real BRL BRL CASH M-Mkt

bbg://screens/HELP PRTU
bbg://screens/HELP CDE
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Currency Code Pre-Defined Money Market Program

British Pound GBP GBP CASH M-Mkt

Canadian Dollar CAD CAD CASH M-Mkt

Chilean Peso CLP CLP CASH M-Mkt

Chinese Renminbi CNY CNY CASH M-Mkt

Colombian Peso COP COP CASH M-Mkt

Czech Koruna CZK CZK CASH M-Mkt

Danish Krone DKK DKK CASH M-Mkt

Egyptian Pound EGP EGP CASH M-Mkt

Euro EUR EUR CASH M-Mkt

Hong Kong Dollar HKD HKD CASH M-Mkt

Hungarian Forint HUF HUF CASH M-Mkt

Indian Rupee INR INR CASH M-Mkt

Indonesian Rupiah IDR IDR CASH M-Mkt

Israeli Shekel ILS ILS CASH M-Mkt

Japanese Yen JPY JPY CASH M-Mkt

Malaysian Ringgit MYR MYR CASH M-Mkt

Mexican Peso MXN MXN CASH M-Mkt

New Romanian Leu RON RON CASH M-Mkt

New Zealand Dollar NZD NZD CASH M-Mkt

Nigerian Naira NGN NGN CASH M-Mkt

Norwegian Krone NOK NOK CASH M-Mkt

Peruvian New Sol PEN PEN CASH M-Mkt

Philippine Peso PHP PHP CASH M-Mkt
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Currency Code Pre-Defined Money Market Program

Polish Zloty PLN PLN CASH M-Mkt

Russian Ruble RUB RUB CASH M-Mkt

Serbian Dinar RSD RSD CASH M-Mkt

Singapore Dollar SGD SGD CASH M-Mkt

South African Rand ZAR ZAR CASH M-Mkt

South Korean Won KRW KRW CASH M-Mkt

Sri Lankan Rupee LKR LKR CASH M-Mkt

Swedish Krona SEK SEK CASH M-Mkt

Swiss Frank CHF CHF CASH M-Mkt

Taiwanese Dollar TWD TWD CASH M-Mkt

Thai Baht THB THB CASH M-Mkt

Turkish Lira TRY TRY CASH M-Mkt

Ukrainian Hryvnia UAH UAH CASH M-Mkt

Uruguayan Peso UYU UYU CASH M-Mkt

US Dollar USD USD CASH M-Mkt

Zambian Kwacha ZMW ZMW CASH M-Mkt

Details about pre-defined Money Market Programs used for Return on Cash in PORT are available in the related Description
(DES) page. To access this information:

1. Enter (Currency Code) CASH <M-Mkt> DES <Go>.

2. Click the (yellow) pre-defined MMP.

3. To see historical rates, use the <Pg Fwd> key.

To see data transparency, in the Attribution Main View sub-tab, right click the currency and select Explain Return
Calculation.
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The data appears on the Performance Data Dashboard screen in another window.

YIELD CURVES

The table below displays the sovereign curves and swap curves (by currency) PORT utilizes for yield curve-based analytics
(e.g., effective duration, option adjusted spread).

Note:  You can analyze the curves in greater detail by inputting any of the curve tickers into the Graph Curves (GC) function.
For more information on GC, see GC <Help>.

Currency Sovereign Curve Ticker Swap Curve Ticker

AUD F127 S1

CAD F101 S4

CHF F256 S21

CLP F990 S193

CNY F20 S181

COP F477 S191

CZK S37 S37

DKK F267 S5

EUR F960 S45

GBP F110 S22

bbg://screens/HELP GC
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Currency Sovereign Curve Ticker Swap Curve Ticker

HKD F125 S10

HUF F114 S124

IDR F132 S38

INR F123 S46

JMD F998 NA

JPY F105 S13

KRW F232 S57

MXN F476 S83

MYR F128 S39

NOK F266 S16

NZD F250 S15

PKR F983 S160

PLN F119 S48

RON F489 S225

RUB F496 S179

SEK F259 S20

SGD F124 S44

THB F122 S172

TRY F965 S164

TWD F126 S41

USD CMT S23

MUNI (Tax-Exempt) M49 M49

ZAR F262 S18
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RETURNS ANALYSIS

CONTRIBUTION TO RETURN

Contribution to return (CTR) in PORT is the weighted total return of every instrument in the portfolio or benchmark.

The CTR of every instrument in the portfolio is designed to add up to the Total Return167  of the portfolio. CTR is calculated

independently for the portfolio and benchmark, and a relative CTR is also available. These typically appear as CTR (Port)168 ,
CTR (Bench)169 , and CTR (+/-)170 .

On the Intraday tab, CTR for any instrument is calculated as the portfolio's current P&L / the market value of the portfolio
at the previous close. On the Attribution tab, CTR for any instrument is the daily total return multiplied by the daily weight,
compounded over the attribution timeframe. For long/short portfolios, CTR may represent a margin-adjusted contribution to
return, depending on the short margin settings.

HISTORICAL RETURNS

By default, PORT is a holdings-based analytic system that calculates historical returns using daily positions and end-of-day
market prices. Actual transaction prices and costs associated with trading activity are considered in historical performance
only if transactions-based analytics is explicitly enabled and transactions data is uploaded daily by clients. For equity portfolios,
dividends are factored into the return calculation on the ex-dates. Historical return in PORT is displayed in the Performance
and Attribution tabs.

Note:  For a comparison of the holdings-based versus transactions-based methodology, see the "Holdings vs.
Transactions-Based Return Attribution" section below.

General Methodology: In general, if the holdings of the portfolio are unchanged over the course of an analysis period
extending from time (0) to time (T), R (return) can be defined simply as:

• R = Value Portfolio (T) / Value Portfolio (0)

Alternatively, if the return of each security in the portfolio over the analysis period is defined as ri(T) and the weight of each
security at the beginning of the analysis period is defined as wi(T-1), then R, the return of the portfolio is also equivalent to:

• R = w1(T-1) * r1(T) + w2(T-1) * r2(T) + … + wi(T-1) * ri(T)

However, since the portfolio holdings do change over a typical analysis period (e.g. year to date), this simplified view of returns
only holds true for the sub-period (t) where the holdings remain unchanged. Hence the returns over the period (T) covering
sub-periods t1 through tn is defined as:

• R = R(t1) * R(t2) * R(t3) * … * R(tn)

167 The total return over the stated timeframe as of the date of analysis, expressed as a percentage.
168 Contribution to return of the security or grouping in the portfolio. This can generally be interpreted as the total return of

every instrument multiplied by its weight in the portfolio. The sum of CTR (Port) for all instruments is equal to the Total
Return of the portfolio.

169 Contribution to return of the security or grouping in the benchmark. This can generally be interpreted as the total return
of every instrument multiplied by its weight in the benchmark. The sum of CTR (Bench) for all instruments is equal to the
Total Return of the benchmark.

170 Calculated as CTR (Port) – CTR (Bench).
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For PORT, these sub-periods are daily. The daily returns are linked geometrically to form the overall return of the portfolio
over the entire period (T). While the daily return is defined by the size of the starting and ending portfolio values every day, the
return over the entire period (T) is not affected by adding or removing capital into the portfolio on any given day.

This methodology provides an improvement on the Dietz and Modified Dietz methods for maximum accuracy.

Portfolio Return Including Futures: To calculate weight and, in turn, contribution to return (CTR), PORT uses the nominal
contract value as the basis for exposure. The nominal value of a futures contract is obtained by multiplying the futures value of
one point by the traded price.

The contribution to portfolio return of a futures contract is calculated as follows:
• CTR = % Weight * (Futures P&L / Nominal Contract Value)

Where:
• % weight is the nominal contract value / total market value of the portfolio
• nominal contract value = the futures value of one point * the price.

Return for Daily Accrual and Money Market Funds: PORT computes the daily return for daily accrual funds, including
money market funds, using accrued interest, coupons, and clean price. The calculation is defined as:
 

 

where:
• Rt = Daily return on day t
• AIt = Accrued interest on day t
• CPt = Coupons on day t (this includes monthly income coupons and other types of coupons like long-term coupons,

short-term coupons, and special cash)
• Pt = Clean price on day t

Holdings vs. Transactions-Based Return Attribution: PORT offers two approaches to calculating total return for a
portfolio: daily holdings-based returns and transactions-based returns. The sections above each describe aspects of the
holdings-based returns method.

The daily holdings-based return model assumes that all buys and sells occur at the close-of-day market price. This approach
tends to be the most popular because it requires relatively low integration support (only holdings are required), and if the
portfolio has low turnover, these returns should track official returns reasonably well.

For clients that have high portfolio turnover or are exposed to high market volatility, the holdings-based return can significantly
deviate from the official return. In these circumstances, it is preferable to upload transactions to incorporate the actual buy and
sell prices to improve the accuracy of the total return calculation in PORT.

For more information on the transactions-based method and setting up this returns analysis, see Transactions-Based Method.

INTRADAY RETURNS (EQUITIES)

The following items affect calculation of Intraday Return analysis within PORT.
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Current Pricing: Intraday prices refresh every 5 seconds for up to 3000 unique securities across the portfolio and
benchmark. This refresh rate is slowed by 1 second for every 200 additional securities.

PORT incorporates the real-time change in FX rates when calculating current market values, P&L, and returns. All measures
are converted into the base currency of the portfolio, which is specified in the Creating/Updating Portfolios (PRTU) function.
For more information, see PRTU <Help>.

Halted securities that started trading today are supported in the Intraday view. PORT carries forward stale prices (e.g., for
halted securities) to ensure the % weight exposure to these securities is properly represented.

Previous Close Pricing: Previous close (t-1) prices and weights are calculated based on the historical pricing source setting
in PORT and may be set to composite, primary exchange, or MSCI prices.

PORT uses the previous close (t-1) FX rate provided by the index vendor of the benchmark being utilized, if available. If no
vendor rate is available, a Bloomberg 4PM London rate is used which is generally consistent with index contributors.

Regional Price Roll: Prices roll from "current day" to "previous close" based on the region in which the security trades.
• For securities in Europe and Asia, prices roll at approximately 6PM EST (11PM GMT).
• For securities in the Americas, prices roll at approximately 9PM-10PM EST (2AM-3AM GMT).

Returns on Cash: Cash, or spot currency, positions contribute to the intraday return in PORT only if the currency is in a
different denomination than the portfolio base currency. For example, if the default portfolio currency is EUR and the cash
position is in EUR, then the EUR SPOT price change is displayed on PORT with no return; it is always 0. But if the portfolio
base currency is USD and the cash position is in EUR, then cash displays a contribution to the return.

Equity Options: PORT Intraday always uses the mid-price for options. Delta adjusted exposures can be viewed for options by

adding the fields Notional Exposure171  and % of Total Notional Exposure172  to the Intraday Main View.

Note:  For instructions on how to add fields, see Adding/Removing Fields.

INTRADAY RETURNS (FIXED INCOME)

The default intraday waterfall for fixed income and balanced portfolios is:

• (Bid Pricing) using MSG1 > TRAC > EXCH > CBBT > BGN

Note:  For information on changing the FI intraday waterfall pricing, see Pricing Source Defaults.

To calculate the intraday P&L, Bloomberg uses:

• T-1 market price: T-1 close of day market prices use the (Bid BVAL price, else custom) waterfall

• Market values: Price quotes are in the conventions of the bond (clean or dirty), but the market value remains Gross (with
accrued interest)

The default pricing setting for a bond portfolio is "Bid."

Note:  For information on changing this setting, see Pricing Source Defaults.

171 The current value of the underlying asset. For an option, notional exposure is the delta-adjusted underlying value
(calculated as number of contracts * contract size * option delta * underlying asset price), while for a future it is the
contract value. For non-derivative instruments, the current market value is displayed.

172 The current Notional value of the instrument or grouping divided by the total current notional value of the portfolio,
expressed as a percentage.

bbg://screens/HELP PRTU
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RETURN ATTRIBUTION

For equity portfolios, PORT uses the Brinson-Fachler Total Return Attribution model to decompose the Active Return173

(excess return of the portfolio relative to the benchmark) into four Attribution Effects: Asset Allocation, Stock Selection,
Interaction, and Currency. By default, Interaction Effect174  is embedded within Selection Effect175 , but this may be changed
from the View Manager screen. For fixed income and balanced portfolios, additional factor-based attribution models are
available. For more information on these settings, see Attribution Calculation Defaults.

The following calculations apply to historical Brinson-Fachler Total Return Attribution in PORT. Historical total returns and
weighted contributions to return are calculated daily using beginning of period weights, then geometrically linked according to
the Carino method to determine the Attribution Effects over a given timeframe.

Attribution at the Sector Level (Brinson Mode): The attribution calculations at the bucket (grouping) level differ from the
calculations at the security level. The calculations for a one-day return period are as follows:

• Allocation Effect176  = (wp − wb) * (rb - Rb)
• Selection Effect177  = wb * (rp − rb)
• Interaction Effect178  = (wp − wb) * (rp − rb)
• Currency Effect179  = sum of individual security currency effects within the sector

• Total Attribution = Allocation + Selection + Interaction + Currency Effects

Where:

• wp = sector weight within the portfolio at beginning of period

• wb = sector weight within the benchmark at beginning of period

• rp = return of the sector in the portfolio (in local currency)
• rb = return of the sector in the benchmark (in local currency)
• Rb = return of the overall benchmark (in local currency)

Note:  If the portfolio includes a sector that is not in the benchmark, there can be no benchmark return for that sector (rb).
In this case, the portfolio sector return is used as a proxy for the benchmark sector return, replacing rb with rp in the above
formulas. Similarly, if the benchmark includes a sector that is not in the portfolio, rp is replaced with rb in the above formulas.

173 The difference between portfolio return and benchmark return. If you are using the Geometric Method:

Active return = 100 * [(1 + portfolio return / 100) / (1 + benchmark return / 100) - 1]
174 The interaction between the weighting and the selection effects, which does not represent an explicit decision of the

investment manager.
175 The active return attributed to security selection decisions that differ from the benchmark. When the portfolio sector

returns exceed the benchmark return, a positive number is posted.
176 The active return attributed to asset allocation decisions (e.g., sectors, countries, or market caps) that differ from the

benchmark. The allocation is generally positive when the fund is overweight for a sector in which the benchmark return
exceeds the total benchmark return.

177 The active return attributed to security selection decisions that differ from the benchmark. When the portfolio sector
returns exceed the benchmark return, a positive number is posted.

178 The interaction between the weighting and the selection effects, which does not represent an explicit decision of the
investment manager.

179 The active return due to currency exposures that differ from the benchmark.
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The net effect for both of those sector cases is that Selection and Interaction Effects are 0, and Total Attribution comes from
Allocation and Currency Effects alone.

Attribution at the Security Level (given a Sector Breakdown): The attribution calculations at the security level differ from
the calculations at the sector (grouping) level. Only Selection and Currency Effects are defined at the security level; Allocation
and Interaction Effects are not. The calculations for a one-day return period are as follows:
• Selection Effect (Interaction combined): Wps * [(wp / Wps) - (wb / Wbs)] * (r - Rbs)
• Selection Effect (Interaction not combined): Wbs * [(wp / Wps) - (wb / Wbs)] * (r - Rbs)
• Currency Effect: (wp - wb) * (rp - r)
• Total Attribution: Selection Effect + Currency Effect

Where:
• wp = security weight within the portfolio at beginning of period
• wb = security weight within the benchmark at beginning of period
• Wps = sector weight within the portfolio at beginning of period
• Wbs = sector weight within the benchmark at beginning of period
• r = return of the security in local currency
• rp = return of the security in portfolio currency
• Rbs = return of the sector in the benchmark in local currency

Note:  If the portfolio includes a sector that is not in the benchmark, or if the benchmark includes a sector that is not in the
portfolio, then Selection Effect for any security in these sectors is set to 0. Total Attribution for such sectors is fully explained by
Allocation and Currency Effects, so there can be no Selection Effect for the securities within these sectors.

Attribution at the Security Level (with No Sector Breakdown): If you are analyzing security-level attribution with no
sector (grouping) breakdown, attribution boils down to your over/underweight decision for each security and that security's
performance relative to the overall benchmark. In this case, calculations for a one-day return period are as follows:
• Selection Effect: (wp - wb) * (r - Rb)
• Currency Effect: (wp - wb) * (rp - r)
• Total Attribution: Selection Effect + Currency Effect

Where:
• wp = security weight within the portfolio at beginning of period
• wb = security weight within the benchmark at beginning of period
• r = return of the security in local currency
• rp = return of the security in portfolio currency
• Rb = return of the overall benchmark in local currency

Active Returns: Active Return is also known as relative return or Alpha, and it may be viewed in the Attribution tab of PORT.
By default, Active Return is simply the difference between Portfolio Return and Benchmark Return. However, if you have set
the Attribution Calculation Method to "Geometric" in the PORT View Manager, then Active Return may not equal the simple
difference between Portfolio and Benchmark Returns. (For more information, see Pricing Source Defaults.)

The Geometric Calculation Method causes Active Return to be captured as a ratio of the portfolio return to the benchmark
return:
• Active Return = 100 * [(1+portfolio return / 100) / (1+benchmark return / 100) - 1

Active Returns Attributed to Cash: By default, cash is assumed to have zero return, but this can be changed by adjusting
your Return on Cash options in the View Manager. For instructions on how to set this, see General Calculations.
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Even if you leave the default setting of assuming zero return for cash, cash can have a positive or negative Active Return due
to the Currency Effect, which is caused by the change in FX rates between the cash position's currency denomination and the
base currency of the portfolio.

In addition, cash may have a positive or negative Active Return that is completely due to the Allocation Effect. As described in
prior sections, the general formula for Allocation Effect is:

• Allocation Effect = (wp - wb) * (rb - Rb)

Since benchmarks typically do not have cash positions, this formula simplifies to:

• Allocation Effect = wp * (rcash - Rb)

Where:

• wp = cash weight in portfolio at beginning of period

• rcash = cash return (in local currency)
• Rb = return of the overall benchmark (in local currency)

Thus, if the Total Benchmark Return is greater than your cash rate of return, then cash shows a negative Active Return.
Conversely, if the Total Benchmark Return is less than cash rate of return, then cash shows a positive Active Return.

Equity Return Attribution: The Bloomberg Performance Attribution Training Manual reviews how returns relative to an index
can be broken down into attribution effects. Starting from single period attribution, the manual describes:

• The Brinson Method that yields an exact solution for multi-period attribution at fund level.
• The solution for multi-period attribution at sector level (geometric and arithmetic attribution).
• Various attribution methods are presented (using Carino methodology).

Note:  To access the Bloomberg Performance Attribution Training Manual in full, click here.

TAX RATES FOR NET OF TAX RETURNS

In each portfolio view, you can choose if you want to withhold tax from dividends included in return calculations using the
Return Calculation Type drop-down menu. When you are using a return calculation type of Net, the tax rates used to calculate
the net of tax returns is based on a default tax rate table maintained by Bloomberg. Alternatively, you can set your own custom
tax rates by creating a custom data field in the Custom Data Editor (CDE) function.

Note:  For a list of Bloomberg tax rates, see the document PORT Default Tax Rate Table. For information on related general
calculation fields, see General Calculations (Equity).

To use custom tax rates, you can upload custom country tax rates as a decimal (e.g., 0.30 equals a 30-percent tax rate) using
the content type "Country Tax Rate." You must use the private company equity ticker to identify the country as a security. For a
list of each country's equity ticker as recognized in the Bloomberg, see the document PORT Default Tax Rate Table.

Once you upload custom country tax data, as long as the Return Calculation Type field is set to Net or Portfolio Gross / Bench
Net, your custom country tax rates are used to calculate net of tax returns.

Note:  If the tax rate law changes, as of the change date, PORT reverts to the Bloomberg tax rate until you enter or upload a
new tax rate.

RISK ANALYSIS

bbg://screens/IDOC #2040674
bbg://screens/DOCS #2067561
bbg://screens/DOCS #2067561


>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //145

RISK TRANSPARENCY

Risk transparency is accessed in the Tracking Error - Exposures sub-tab when you click on any security's exposure number on
the screen. Factor Exposures, as well as Descriptors used to calculate Factor Exposures, are standardized.

Bloomberg takes the Original value, subtracts the Average, then divides by the Standard Deviation. This value equals the first
row of the Iterations dialog, which you can display by clicking the icon next to the Exposure field or Standardized column.

Bloomberg takes all Values in the universe, subtracts Average, then divides by the standard deviation. Then Bloomberg takes
values that are over + / -3 standard deviation and set them to + / -3, respectively. This process is repeated multiple times until
the average of the distribution is close to 0, the standard deviation is close to 1, and there are very few observations outside of
+ / -3 range.

Risk exposures appear in the Risk Transparency screen in another window. For more information on analyzing risk exposures,
see Risk Transparency Screen.

LIQUIDITY RISK

Liquidity risk is calculated and displayed in the Characteristics-Liquidity Risk sub-tab for equity and balanced portfolios. The
calculation of liquidity risk is based on three inputs: position size, an average or median daily volume based on some lookback
period, and a market participation rate.

For example, suppose you hold a position of 20,000 shares of Tootsie Roll (TR US). In your liquidity analysis, you use a
six-month average daily volume of 85,233 and a market participation rate180  of 10%. Multiplying the market participation rate
.10 by the six-month average daily volume of 85,233 equals the number of shares you expect to sell each day, 8,523. If you
divide your current position by the expected amount of shares to sell daily (8,523), you can determine the number of days it will
take to unwind the Tootsie Roll position. In this case, the number of days to unwind is 20,000 / 8,523, which equals 2.35 days
to liquidate your holding of Tootsie Roll.

For information on using the Characteristics-Liquidity Risk sub-tab, see Liquidity Risk. For information on setting up your
liquidity risk defaults, see Liquidity Risk Defaults.

BENCHMARK SCALING

When comparing portfolio P&L to benchmark P&L, the benchmark's market value is scaled to equal the portfolio's market
value to allow for a meaningful comparison. This scaling is necessary because a portfolio and a benchmark typically have very
different market values, so their P&L magnitudes may be significantly different.

This behavior applies to the Tracking Error, VaR, and Scenarios tabs.

STRESS MATRIX PRICING

The following is a brief introduction to Bloomberg's Equity Derivatives Stress Matrix Valuation, which is relevant for
Value-at-Risk analysis.

Full pricing valuation of equity derivatives generally involves lattice or Monte Carlo methods and are time consuming. However,
since the values of these instruments are usually non-linear functions of the pricing inputs, an accurate estimate of the portfolio
risk requires simulation methods.

180 The percentage of the average or median daily volume of your position that you are willing to expose into the market.
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The full pricing simulation method proceeds as the following: for each of the scenarios, the portfolio is priced on the horizon
date using full-valuation method. The method accounts for non-linearity of the security prices as a function of the pricing inputs,
income payments, or time decay effects. VAR is then computed from the full distribution of the portfolio P&L.

Full-valuation approach is computationally demanding and cannot be realistically implemented for a multi-asset risk system that
updates daily. To expedite the computation while faithfully representing the risk profiles of nonlinear instruments, many methods
have been developed. A consistent theme of these methods is the recognition of the fact that: the number of times a portfolio
has to be priced does not have to be equal to the numbers of scenarios simulated. The stress matrix valuation (commonly
known as grid simulation approach) is such a method used by many risk analytic vendors.

The basic idea of stress matrix pricing (SMP) is to compute full valuation on a low dimensional grid. The scenario P&L is then
approximated by interpolating on the grid during simulation.

Model Overview: Bloomberg's approach to portfolio risk analytic calculations is based on a mixture of full valuation, stress
matrix pricing, and delta-gamma-vega approximation. This mixture of approaches seeks to optimize the trade-off between
speed and accuracy. In general, stress tests are processed through full valuation and simulation based Monte Carlo and
historical VaR are processed through stress matrix pricing or delta-gamma-vega approximation. In this section, the SMP
methodology is explained in detail. The full pricing uses the same data source and model configuration as the construction of
the pricing grid and, therefore, does not occupy an independent section.

Note:  For more information, see related white papers in Documents.

STRESS PROPAGATION

In the course of creating scenarios for stress testing, you may want to propagate stresses from some variables to others, based
on statistical relationships.

Using the Scenario Manager in PORT, you can demonstrate the anticipated move in equity prices when, for example, the price
of oil is shocked by a given percentage (say, up 20%).

The variables that are stressed explicitly are referred to as the independent variables, while the other variables, to which these
explicit stresses are to be propagated, are called dependent variables.

The Scenarios tab in PORT (see Scenarios Tab) is powered by the Bloomberg equity factor models; thus, the dependent
variables are the equity factors that drive the prices of individual equities (market, style, industry, country, and currency factors),
while the independent variable (in this example) is the price of oil. The idea is that once the stresses to the independent
variables are known, the expected (i.e., average) moves in the dependent variables can be calculated and stressed by the
expected moves.

SHORT/FUTURE MARGIN

OVERVIEW

Bloomberg enables you to calculate historical performance and attribution on portfolios that include short positions and
futures. In order to fairly measure the contribution to performance of these instruments, you must either upload cash margin or
make a simplifying assumption about a margin.

Historical performance is calculated by geometrically linking daily returns. The daily return of any security is calculated as the
profit or loss on that security divided by the start-of-day investment value, typically based on the previous closing value. While
for many securities the previous closing value is straightforward to calculate, futures are marked to zero at the end of each day,
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and shorts are often considered to have negative values, causing issues when used as the divisor of a return calculation. In
order to address these issues, margin is used to represent the daily start-of-day investment you have made on the futures and
short securities in your portfolio.

SETTING YOUR MARGIN

Margin can be set as either a percentage or cash value in the Creating/Updating Portfolios (PRTU) or Bloomberg Uploader
(BBU) function.
• For information on the margin accounts for futures and shorts, see Margin Accounts.
• For information on using PRTU to set up the margin for futures and shorts in the Advanced tab of the Portfolio Settings

window, click here .
• For information on using BBU to set the margin for futures and shorts, click here .

MARGIN ACCOUNTS

Margin can be entered either as cash or calculated by Bloomberg on the basis of a percentage assumption. There are separate
accounts for futures and shorts.

The Include cash checkboxes in the Advanced tab of the Portfolio Settings window corresponds to the separate accounts
available for futures and shorts:

• Future Margin - Cash: The aggregate cash amount held in margin to cover all futures positions (long and short). This
includes initial margin that was posted, plus variation margin marked on a daily basis.

• Short Margin - Cash: The aggregate cash amount held in margin to cover all non-future short positions. This includes
both the proceeds from entering into the shorts, as well as any additional capital posted to the margin account. Calculated
as long market value + short market value + short margin.

• Future Margin - Percentage: A value between 0% and 100% used to calculate the futures margin amount. On a daily
basis, the specified % is multiplied by the absolute value of the total exposure value (e.g., number of contracts *contract
size * futures price) of all futures positions.

• Short Margin - Percentage: A value between -100% and 100% used to calculate the short margin amount. On a daily
basis, the specified % is multiplied by the absolute value of the total exposure value (e.g., position * price * contract size
(for options)).
— 100% equates to a full investment assumption

— 0% equates to zero margin for futures and only proceeds for shorts

— -100% equates to proceeds from shorts being fully available for investment

Calculated as long market value + short market value + abs(short market value) * (100 + short margin%).

For descriptions of the advanced portfolio settings available in PRTU, click here .

MARGIN EXAMPLE

The correct margin depends on what you are trying to achieve. The margin assumption influences the portfolio market value,
hence the portfolio return and how much leverage is assumed.

The table below provides examples of appropriate margin amounts based on desired assumptions:

bbg://screens/LPHP PRTU:0:1 1956097
bbg://screens/LPHP BBU:0:1 1818332
bbg://screens/LPHP PRTU:0:1 1956090
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Desired assumption Appropriate margin

Net (longs - short) Set the short margin to 0 or -100% (if you are using a percentage)

Gross (longs + short) Set Short Margin to 2 * abs(shorts) or 100% (if you are using a percentage)

Actual margin = 20% 1.2 * abs(short) or 20% (if you are using a percentage)

Note:  It is possible to set margin as a percentage and assume that some of the short proceeds are used to invest in long
securities by entering a negative margin percentage. For example, to assume that $200k from the proceeds of $1m short are
used to purchase long securities with $800k remaining in the margin account, enter a margin of -20%.
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DOCUMENTS & VIDEOS

DOCUMENTS

1. GETTING STARTED

Type Title

PORT Equity Fact Sheet 2 pages

PORT Fixed Income Fact Sheet 2 pages

PORT Intraday Fact Sheet 2 pages

PORT Portfolio & Risk Analytics Brochure 16 pages

Portfolio Construction Tools 2 pages

Customizing PORT Value Fact Sheet 2 pages

2. CUSTOMIZING PORT

Type Title

Customizable Price & FX Source Waterfalls 3 pages

Custom Data in PORT 3 pages

Uploading Custom Data 2 pages

Case Study: Custom Data in PORT 11 pages

3. PERFORMANCE

Type Title

Equity Performance Attribution Model 30 pages

Factor Based Performance Attribution 10 pages

bbg://screens/BPS L#1937166
bbg://screens/BPS L#1961373
bbg://screens/BPS L#2234714
bbg://screens/BPS L#1960608
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bbg://screens/DOCS #2069911
bbg://screens/DOCS #2069909
bbg://screens/BPS L#2138614
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Type Title

Fixed Income Return Attribution 15 pages

Performance Attribution Model 17 pages

Nested Attribution White Paper 7 pages

Transactions-Based Performance Measurement and Attribution 14 pages

4. RISK

Type Title

PORT Risk Model Fact Sheet 2 pages

PORT VaR (Value-at-Risk) White Paper 8 pages

Multifactor Risk Model Primer 8 pages

Stress Matrix Pricing in PORT 14 pages

MULTI-ASSET RISK

Type Title

Fund Risk Model 37 pages

Multi-Asset Risk Model 19 pages

EQUITY RISK

Type Title

Asia Equity Fundamental Factor Model 43 pages

Australia Equity Fundamental Factor Model 25 pages

Canada Equity Fundamental Factor Model 39 pages

China A-Shares Equity Fundamental Factor Model 40 pages

Emerging Europe, Middle East, and Africa Equity Fundamental Factor Model 45 pages

bbg://screens/DOCS #2071557
bbg://screens/BPS L#2073618
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Type Title

Emerging Markets Equity Risk Models 36 pages

Equity Portfolio Factor Model: Non-Factor Risk 5 pages

European Equity Fundamental Factor Model 35 pages

Global Equity Fundamental Factor Model 33 pages

Latin America Equity Fundamental Factor Model 43 pages

Japan Equity Fundamental Factor Model 27 pages

U.S. Equity Fundamental Factor Model 23 pages

FIXED INCOME RISK

Type Title

CDS Fundamental Factor Model 17 pages

Convertible Bonds Fundamental Factor Model 8 pages

Emerging Markets Fixed Income Fundamental Factor Model 15 pages

Fixed Income Risk Factor Model 45 pages

Fixed Income Securitized Fundamental Factor Model 20 pages

Inflation Linked Bonds Fundamental Factor Model 19 pages

U.S. Agency Stripped MBS and CMO Products Fundamental Factor Model 15 pages

U.S. Municipal Fundamental Factor Model 23 pages

COMMODITY RISK

Type Title

Commodities Factor Model 66 pages

DERIVATIVES RISK
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Type Title

Equity Options & VIX Futures Support 6 pages

 SCENARIO ANALYSIS

Type Title

Scenario Analysis White Paper 5 pages

Multi-Asset Scenario Manager (SHOC <Go>) User Guide 31 pages

5. PORTFOLIO CONSTRUCTION

Type Title

Bloomberg Portfolio Optimizer Frequently Asked Questions and Best Practices 8 pages

Portfolio Optimization White Paper 43 pages

Optimizing Portfolio with User Expected Returns 2 pages

PORT Portfolio Optimizer Fact Sheet 2 pages

Trade Simulation and Optimization User Guide 13 pages

6. CASE STUDIES

Type Title

Case Study: Convertible Bond Portfolios 8 pages

Case Study: ETFs 9 pages

Case Study: Hedging Risk  20 pages

Case Study: Index Replication 13 pages

Case Study: Low Risk High Return 14 pages

Case Study: Managing Curve Risk 11 pages

Practical Use Cases for Equity Portfolio Managers 10 pages
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Type Title

Bloomberg Markets Strategies: Finding the Best Funds 3 pages

VIDEOS

1. GETTING STARTED

The following videos provide information on getting started with PORT, including uploading your portfolios, sharing portfolios,
fixing upload errors, and setting up a custom report.

Type Title (Length)

Uploading Equity Portfolios (3:10)

Uploading Fixed Income Portfolios (3:41)

How to Share Portfolios (1:36)

Creating a Report Template (2:51)

Fixing Portfolio Upload Errors (1:58)

Introductory Video: Fixed Income Portfolio & Risk Analytics (1:51)

2. CUSTOMIZING PORT

The following videos provide information on customizing your usage of PORT, including setting up defaults, creating a group of
portfolios, customizing sectors, and addressing security exceptions.

Type Title (Length)

Setting Your Default Portfolio, Benchmark, and Grouping Model (3:00)

Creating a Group of Portfolios (2:18)

Uploading Custom Sectors and Grouping Models (3:08)

Uploading Target Prices and Analyst Coverage (5:26)

Correcting Notices in PORT for Fixed Income Securities (2:27)
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3. CHARACTERISTICS

The following videos provide information on using PORT to analyze the core structure of your portfolio, including valuation
measures and other fundamentals for equity portfolios and interest rate sensitivity, cash flow projections, and liabilities for fixed
income portfolios.

Type Title (Length)

Customizing Your Characteristics Fields (2:46)

Analyzing Historical Trends in Valuation (2:05)

Analyzing Fixed Income Portfolio Characteristics (2:24)

Analyzing Portfolio Interest Rate Exposure (1:43)

New! Overriding Fixed Income Analytics in PORT (4:00)

Projecting Future Cash Flows (2:02)

New! Uploading Liability Streams in BBU (1:43)

New! Analyzing Liabilities in PORT (3:12)

4. PERFORMANCE

The following videos provide information on identifying the sources of your portfolio's historical performance on an absolute
basis and relative to a benchmark through PORT's performance and attribution tools.

Type Title (Length)

Identifying Top Performing Sectors and Securities Historically (2:36)

Identifying the Securities Contributing Most to Returns (2:28)

Equity Attribution: Attributing Active Returns (2:48)

Fixed Income Attribution: Attributing Active Returns (3:45)

Identifying Your Risk Adjusted Returns (1:28)

Return Attribution Models (3:02)

5. RISK

The following videos provide information on measuring, analyzing, and anticipating portfolio risk through the tracking error,
value-at-risk, and scenario analysis tools in PORT.
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Type Title (Length)

Identifying Securities Contributing the Most Risk to Your Portfolio (2:17)

Forecasting Tracking Error (3:18)

Stress Testing Your Portfolio for Different Market Environments (1:59)

Stress Testing Your Portfolio for Different Interest Rate Scenarios (2:58)

Creating a Custom Stress Test (3:31)

Determining Value at Risk and the Factors Driving It (2:21)

Identifying Beta Adjusted Exposure (2:08)

Shocking the Treasury Curve on an Equity Portfolio (2:09)

6. PORTFOLIO CONSTRUCTION

The following videos provide information on using the trade simulation and portfolio optimization tools in PORT, which can help
you construct your optimal portfolio.

Type Title (Length)

Equity Trade Simulation: Evaluating the Impact of a Hypothetical Trade (2:35)

Fixed Income Trade Simulation: Evaluating the Impact of a Hypothetical Trade (2:34)

Optimizing Your Equity Portfolio (3:17)

Optimizing Your Fixed Income Portfolio (3:44)
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EXCEL INTEGRATION
You can analyze your portfolio in a Microsoft® Excel spreadsheet in two ways: you can use a pre-built BLOOMBERG
PROFESSIONAL® service spreadsheet that extends PORT's functionality or create your own API formulas to customize your
analysis.

ASSET ALLOCATION OPTIMIZER

SPREADSHEET DESCRIPTION

The Asset Allocation Optimizer spreadsheet uses historical returns or user-customized forecasted returns to generate optimal
portfolios, assigning weights to specific security groups based on the following objectives: minimize risk, maximize return,
maximize the Sharpe ratio, maximize return given a volatility, and minimize volatility given a return. The spreadsheet also builds
an efficient frontier showcasing optimal portfolios of varying risk-return tradeoffs. The efficient frontier approaches the same
optimization problem over a range of return possibilities, seeking the minimum standard deviation for each unit of iterated
return.

Spreadsheet:  Asset Allocation Optimizer

• For more information on using the Asset Allocation Optimizer spreadsheet, see Features.
• For an example on using the spreadsheet, see Example: Optimal Portfolio.

FEATURES

The Asset Allocation Optimizer spreadsheet uses historical returns or user-customized forecasted returns to generate optimal
portfolios. The tab is divided into nine sections. You can customize your analysis in the ETF format, ticker/asset classes,
returns, dates, and constraints sections, run the optimizer in the optimizer engine section, analyze the results in the correlation
matrix and objectives sections, and access additional spreadsheets in the related spreadsheets section.
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• ETF Format: Allows you to switch the spreadsheet template to accommodate exchange-traded funds (ETF).
• Related Spreadsheets: Provides links you can use to launch other related spreadsheets to enhance your analysis. For

example, you can launch the Asset Allocation Calculator spreadsheet, which is used to illustrate the annual returns for a
variety of user-defined asset classes and rank them each year from best to worst based on their total return.

• Ticker/Asset Classes: Allows you to enter the securities and asset classes you want to analyze.
• Returns: Allows you to customize the return and standard deviation for specific security groups.
• Dates: Allows you to enter the dates between which the optimization is calculated.
• Correlation Matrix: Displays the correlation between different security groups. Correlation ranges between -1 and +1,

and perfect positive correlation (+1) implies that as one security moves, either up or down, the other security will move in
lockstep, in the same direction. Perfect negative (-1) correlation implies the opposite.

• Constraints: Allows you to customize the weight constraints based on your analysis. The default constraints are 15%.
• Objectives: Displays the objective measures and allows you to customize specific measures, such as the risk-free return,

to generate the most accurate optimization.
• Optimizer Engine: Allows you to run the optimizer, so you can see the optimal weights for your portfolio.

The other tabs at the bottom of the spreadsheet are:
• Efficient Frontier: Allows you to build an efficient frontier, showcasing optimal portfolios that are dependent on the

returns, standard deviations, correlations, and constraints chosen on the Optimizer tab.
• Forecasted Returns: Allows you to input forecasted returns based on various scenarios and probabilities of these

scenarios.
• Help: Displays instructions and hints on how to use the Asset Allocation Optimizer spreadsheet.

EXAMPLE: OPTIMAL PORTFOLIO

This topic provides an example of how to use your own expectations of equity and fixed income asset performance on the
Asset Allocation Optimizer spreadsheet to generate optimal portfolios that take historical returns into consideration.

Steps:
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1. In the ticker/asset classes section, enter the following tickers and asset classes for equities and fixed income, respectively:
SPTR Index (S&P 500 Total Return Index) and LUTLTRUU Index (US Treasuries).
 

 

Note:  The most important reason for using these two asset classes is the negative correlation between them. The less the
correlation between the asset classes indicates a better diversification, hence a better optimization.

2. In the Choose Return Type step, select Historical.
 

 

The spreadsheet populates with historical returns between the default dates, which are 1/1/1992 and 1/1/2012.

3. In the Enter Dates Below fields, change the Start Date to 1/1/2002, then press <Go>.
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The spreadsheet updates based on the date range.

4. In the Review Constraints step, deselect Constraints Kept.
 

 

Note:  The default constraints for a 12-asset portfolio are capped at 15% per each asset class, but for this example, only
two assets are used, so the portfolio is split evenly between them.

5. Note the risk and return statistics for the assets fed into the optimizer. During the period between 1/1/2002 and 1/1/2012,
equities had an annualized return of 2.9% with a standard deviation of 16%, whereas the fixed income portion has gained
roughly 9% with a standard deviation of 11.3%.
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6. Click the Optimize Weights button.
After calculations are finished, the optimizer recommends a 37% allocation to equities and 63% allocation to fixed income,
which outperformed equities significantly. This allocation achieves a return value of 6.7%, which is the weighted average
of the returns of the two assets according to the allocation above. More interestingly, this allocation achieves a standard
deviation of 7.8%, which is considerably smaller than the standard deviation of each individual asset at 16% and 11.3%,
respectively. This reduction is due to the negative correlation between the two assets, which works to cancel out some
of the volatility observed by both. The optimizer validates the theory that when assets are negatively correlated, optimal
allocation not only reduces risk, but reduces it to levels that are less than the individual risks of both assets.
 

 

7. If you want to review the risk and return characteristics of these asset classes observed throughout 2012, in the Enter
Dates Below section, change the dates to 1/1/2012 (Start Date) and 1/1/2013 (End Date).
During this period, equities returned roughly 16% with a standard deviation of 12.7%, whereas fixed income returned
roughly 3.5% with a standard deviation of 12.4%.
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8. Click the Optimize Weights button.
The optimizer allocates roughly 50% to each portfolio to achieve minimum risk. The return observed by this allocation turns
out to be roughly 9.7%, which is the weighted average return of these asset classes. However, despite the fact that both
assets had roughly 12-13% risk levels, combining these asset classes based on this allocation suggestion has dropped
the portfolio risk level to 5.4%, which is significantly less than the risk observed by either asset.
 

 

TECHNICAL REQUIREMENTS

To use the Asset Allocation Optimizer spreadsheet, the Microsoft® Excel Solver Add-in is required. For more information on
how to enable the Solver Add-in for different versions of Excel, click the Help tab.

PORTFOLIO CLASSIFICATION (S&P500)

SPREADSHEET DESCRIPTION

The Portfolio Classification by S&P 500 Sectors (GICS) spreadsheet breaks down portfolios, equity indices, and custom
security lists by Global Industry Classification Standards (GICS) sectors, so you can analyze key performance data within
specific area, such as energy and financials. Sector averages are displayed, which you can use to determine if you should
adjust your investment in that sector. For example, you can see the percentage contribution of consumer discretionary stocks
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to the overall portfolio, then determine how your portfolio is performing relative to the S&P based on the difference in weighting
for the same sector.

Spreadsheet:  Portfolio Classification by S&P 500 Sectors
• For more information on how to use the  Portfolio Classification by S&P 500 Sectors spreadsheet, see Features.
• For an example of comparing stock profitability within multiple portfolios, see Example: Stock Profitability.

FEATURES

The Portfolio Classification by S&P 500 Sectors (GICS) spreadsheet breaks down portfolios, equity indices, and custom
security lists by Global Industry Classification Standards (GICS) sectors, so you can analyze key performance data within
specific areas, such as energy and financials. The tab is divided into three sections that allow you to analyze the sector
breakdown of the ticker symbols you specify on the Input Portfolio tab.
 

 
• Company Name: Displays the company names and corresponding sectors in the universe of securities that you specify.
• Portfolio Data: Displays data regarding the relationship of each security to the list, index, or portfolio in which it resides,

so you can assess high-level performance.
• Stock Data: Displays stock-specific data, so you can assess more granular performance data.

The other tabs at the bottom of the spreadsheet are:
• Input Portfolio: Allows you to select your universe of securities, which can be from a portfolio, custom list, or equity index.
• Help: Displays instructions and hints on how to use the Portfolio Classification by S&P 500 Sectors (GICS) spreadsheet.

EXAMPLE: STOCK PROFITABILITY

This topic provides an example for using the Portfolio Classification by S&P 500 Sectors (GICS) spreadsheet to determine
the profitability of an index's members, then determine how much those stocks contribute in terms of profitability indicators.

Steps:
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1. At the bottom of the spreadsheet, click the Input Portfolio tab.
 

 

The spreadsheet displays the data source selections.

2. In the Source field, choose Equity Index.
 

 

3. In the Equity Index field, select the index ticker you want to analyze.
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The Security column populates with the index members.

Note:  The full names for the indices appear at the right of the spreadsheet.

4. In the Portfolios column, enter the portfolio IDs you want to analyze.
 

 

Note:  You can find your portfolios by running the Creating/Updating Portfolios (PRTU) function. For more information,
see PRTU <Help>. For information on locating the portfolio IDs for your portfolios, see the Portfolio ID section of DAPI
<Help>.

5. Click the GO button.
The data generates and appears on the Industry Classification tab.

6. Scroll to the right of the spreadsheet until you reach the Profitability (Last FY) columns, such as EBITDA (M).
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The stocks in your selected portfolios are listed and by scrolling down, you can compare any one stock's indicator value to
the universe average, so you can determine over- and under-performance.
 

 

INTRADAY PORTFOLIOS MONITOR

SPREADSHEET DESCRIPTION

The Intraday Portfolios Monitor spreadsheet (Master tab) allows you to track the intraday performance of multiple equity
portfolios against multiple equity benchmarks, so you can simultaneously track the performance of your portfolios in real time.
The spreadsheet also shows the best and worst stock performers out of all portfolios, which allows you to assess which
individuals are contributing the most to performance. Different sort options appear as buttons (e.g., Positive Impact) across the
top of the tab.

Spreadsheet:  Intraday Portfolios Monitor

• For more information on how to use the  Intraday Portfolios Monitor spreadsheet, see Features.
• For an example of comparing multiple portfolio returns against several benchmarks, see Example: Returns Against

Benchmarks.

FEATURES

The Master tab of the Intraday Portfolios Monitor spreadsheet is divided into six sections that allow you to track the real-time
performance of multiple equity portfolios and their benchmarks (that you specify on the Input Portfolios tab).
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• Time Stamp: Displays the date and time.
• Sort Options: Allows you to select a sort option, so you can display the data most critical to your portfolio analysis.
• Benchmarks: Displays the selected benchmarks against which your portfolios are being measured.
• Portfolio Performance: Displays each portfolio's performance relative to each benchmark, so you can determine where a

more favorable return exists.
• Stock Performance: Displays the 10 best and worst stock performers from all portfolios, which allows you to maximize

outperforming investments and reassess underperforming investments.
• Additional Benchmarks: Displays key data for additional benchmarks, so you can quickly determine the performance of

other closely related indices.

The other tabs at the bottom of the spreadsheet are:

• Input Portfolios: Allows you to select the portfolios that you want to monitor, up to four benchmarks against which you
are measuring your portfolios, and a list of other key indices against which you may want to measure your portfolios.

• (Portfolio name): Displays key performance data for an individual portfolio you are analyzing. Using these tabs, you can
drill into more granular details, so you can assess where you may need to make adjustments to maximize profits.

• Help: Displays instructions and hints on how to use the Intraday Portfolios Monitor spreadsheet.

EXAMPLE: RETURNS AGAINST BENCHMARKS

This topic provides an example for monitoring and comparing multiple portfolios against several different benchmarks using the
Intraday Portfolios Monitor spreadsheet.

Steps:

1. At the bottom of the spreadsheet, click the Input Portfolios tab.
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The spreadsheet displays the portfolio and benchmark update fields.

2. At the top of the spreadsheet, input up to four primary indices you want to use as benchmarks.
 

 
3. At the right of the spreadsheet, input any additional indices you want to use as benchmarks.

 

 
4. In the Portfolio ID column, enter the portfolios you want to analyze.
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Note:  You can find your portfolios by running the Creating/Updating Portfolios (PRTU) function. For more information,
see PRTU <Help>. For information on locating the portfolio IDs for your portfolios, see the Portfolio ID section of DAPI
<Help>.

5. If you want to include a portfolio in the 10 best/worst performers list, in the corresponding Include in 10 Best/Worst
Performers field, enter an "X".
 

 

6. Click the GO button.
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The data generates and appears on the Master tab. At the top of the spreadsheet, you can quickly gauge how your
portfolios are performing against the selected benchmarks. Using this information, you can determine if you need to mix
the securities in your portfolios differently.
 

 

API FORMULAS

FORMULA CONSTRUCTION

You can create custom API formulas within Microsoft® Excel to download data about the portfolios you create in the
Creating/Updating Portfolios (PRTU) function. Custom formulas allow you to tailor the data to only the most relevant
information for your analysis.

You can use the following formula types to import portfolio data into Excel:

• BDP

• BDS

For more information on constructing API formulas, see the Bloomberg API - Tutorial with Examples.

For an example of a formula you can create, see Example: Base Currency.

For more information on obtaining the ticker symbol for a portfolio for use in API formulas, see the Portfolio ID section in DAPI
<Help>.

For a list of the data fields you can use to download portfolio data, see the Portfolio Fields topic in DAPI <Help>.

EXAMPLE: BASE CURRENCY

This topic provides a practical example on how to display a portfolio's base currency in Microsoft® Excel.

Steps:
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1. Locate the portfolio ticker symbol of the portfolio you want to analyze.

Note:  For more information on obtaining the ticker symbol for a portfolio for use in API formulas, see the Portfolio ID
section in DAPI <Help>.

2. Click here to display the list of portfolio data fields that you can use.
In the table, you see PORTFOLIO_BASE_CURRENCY.

3. In a cell on your spreadsheet, use the ticker symbol and field to create a BDP formula:

=BDP("U6473440-9 Client","PORTFOLIO_BASE_CURRENCY")
The data is imported to your spreadsheet.

Note:  You are not enabled to access the above portfolio. You must use an ID for a portfolio that you either created or
which was shared with you.
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FAQ

What security types are supported in PORT?

For information on the asset types supported by PORT, see Supported Asset Types.

Why does PORT Intraday give incorrect P&L values for my FI/Balanced portfolio?

The live FX rates and calculation methodology are exactly the same as those for current Equity Intraday. Differences may be
attributed to the difference between the previous close BVAL price and MSG1/TRAC/CBBT/BGN/EXCH pricing, or to the
Bid/Ask settings for the side of the market.

To troubleshoot, check the units setting, which defaults to "Basis Points" for fixed income and balanced portfolio views. You

can also add the Closing Market Value181 column to the Intraday tab and compare the closing market value with the current
market value.

Why do I have an incorrect price for MSG1?

In the Intraday tab, you can right-click the security and select Quotes Manager (QMGR), which opens the QMGR function
in another window. In QMGR, you can see the market depth for the current security in question and also drill down to see the
actual message that corresponds to the MSG1 price. For more information on using QMGR, see QMGR <Help>.

Why is the total return of CDS contract show up as positive when the contract actually lost money?

The total returns is always shown from the seller of protections view.

Why doesn't the market value of my Swap/CDS tie out with what I see in SWPM/CDSW?

PORT takes a snapshot of the curve at 4PM New York, London, and Tokyo time. This can differ from the closing curve for
SWPM/CDSW.

Why does the risk for my long-short portfolio look so high?

PORT expects that cash from shorting securities is included in the portfolio. For example, if you started with $100 capital and
bought $100 worth of stocks while simultaneously short-selling $100, then your portfolio should include a $100 long position,
$100 short position, and $100 cash that you've received as proceeds for shorting. If the $100 cash position is missing, PORT
assumes that portfolio leverage is high and subsequently the risk of this portfolio is high as well.

Is it possible for the Factor Risk Contribution (%) value for a particular factor group to be greater than 100%?

Yes, it is possible. Total Risk Contribution (%) always sums up to 100%. Factor Risk Contribution can be both positive and
negative. If Factor Risk Contribution for a given factor group is negative, then to get all risk contributions to sum up to 100%,
some other factor group risk contribution can be greater than 100%.

181 The value of your investment in or exposure to an instrument as of the previous market close, calculated as your position
in that instrument multiplied by its closing price multiplied by the exchange rate. At the sector and portfolio levels, this is
the sum of the market values of the individual instruments.

For a portfolio with short positions, market value at the portfolio level is calculated as the total market value of long
positions minus the total market value of the shorts, plus cash and any margin set aside to cover the shorts.

bbg://screens/HELP QMGR
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How are the buckets defined when I choose the Market Cap grouping option?

The following buckets are in USD:

• Small Cap = < $2 billion

• Mid Cap = $2 billion - $5 billion

• Large Cap = > $5 billion

Note:  You can create your own custom market cap buckets using the Custom Sector Classifications (PCLS) function. For
more information, see PCLS <Help>.

bbg://screens/HELP PCLS
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LEARN MORE

GETTING STARTED

SUPPORTED ASSET TYPES

The following asset types are supported by PORT:

     

Closed End Funds Commodity Futures Commodity Spots

Common Stocks Contracts for Difference (CFD) Equity Index Futures

ETFs FX Forwards Investment Funds

Limited Partnerships Listed Equity Options Listed Index Options

Listed Options on Equity Index,
Commodity, and Bond Futures

Mutual Funds Off-Shore Funds

OTC Equity Options Preference Shares (not same as
Preferreds [PFDs])

Private Equities (EQPLs)

Receipts REITs Rights

Royalty Trusts Single Stock Futures and Futures
Options

Spot Currencies

Tracking Stocks UK Unit Trusts Unit Investment Trusts

Note:  For more information on CFDs or EQPLs in PORT, see Notes on Specific Types.

All securities in your portfolio that are not covered by PORT are placed in the "Exceptions" bucket and the remaining securities
in the portfolio are re-weighted to add up to 100%. For more information, see Displaying Exceptions.

If price data is missing, PORT lists the security as an exception. The security is omitted from the portfolio calculation and the
weight of the remaining securities is rebalanced to 100%. For more information on exceptions, see Displaying Exceptions.

SUPPORTED FI INSTRUMENTS

The following fixed income instruments are covered by PORT:
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Agency Debentures Agency-backed Pool-Specific Mortgages
(fixed rate and hybrid ARM)

Asset Backed Securities (ABS)

Bond Futures and Options on Bond
Futures

Commercial Mortgage Backed Securities
(CMBS)

Convertible Bonds

Corporate Bonds Corporate Credit Default Swap Indices
(CDX, ITRAXX)

Custom Bond Securities (PPCR)

Custom Money Market Securities
(MMPL)

Fixed Rate Pools (Agency Backed) Government Debt

Hybrid Adjustable Rate Mortgages
(Agency Backed)

Inflation Linked Bonds Loans

Money Market Instruments Municipal Bonds Plain-vanilla Interest Rate Swaps (IRS)
(fixed-to-float)

Preferred Shares (PFDs) Single Name Corporate Credit Default
Swaps (CDS)

Short Term Interest Rate (STIR) Futures

Sovereigns Supranationals Term Loans

Unit-traded Bonds VIX ETFs, Options, and Futures
 

SUPPORTED FI INDEX PROVIDERS

PORT supports analysis on indices from the source providers listed in the following table. The index source providers are
available either as part of the standard BLOOMBERG PROFESSIONAL® service offering, or as a separate license required
by the provider. For more details on the special licensing required to access indices from specific providers, contact your
Bloomberg account representative.

Index Source Availability

Merrill Lynch/Bank of America Available to all buy-side clients

Barclays Capital FI Indices License required (firm-level or user-level permissions must be enabled)

Markit/iBoxx FI Indices License required (firm-level or user-level permissions must be enabled)

HSBC FI Asia/Euromoney License required (firm-level or user-level permissions must be enabled)

FTSE FI Indices License required (firm-level or user-level permissions must be enabled)

Nomura Bond Indices License required (firm-level or user-level permissions must be enabled)
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Index Source Availability

Chinabond Interbank FI Indices Available to all clients

Swiss Bond Indices License required (firm-level or user-level permissions must be enabled)

South African Bond Indices Available to all clients

ANBIMA Brazilian Bond Indices Available to all clients

Thai Bond Indices Available to all clients

Allianz Bond Index Available to all clients

DEX Universe Bond Index License with PC Bond required (firm-level or user-level permissions must
be enabled)

Malaysian Bond Index Available to all clients

Russian Cbond FI Indices Available to all clients

SUPPORTED FI PRICING SOURCES

PORT provides access to prices for fixed income securities from the source providers listed in the following table. The pricing
source providers listed are generally available to all standard BLOOMBERG PROFESSIONAL® service clients.

You can set up your pricing source preferences using a custom price waterfall, which is configured in the pricing source
defaults on your view. For complete information on setting up a price waterfall, see Customizing Price Waterfall.

Index Source PCS Code FI Securities Country

ANDIMA Brazil ANBE Corporate and local government
bonds

Brazil

CFETS Trade Price CHBK Corporate and local government
bonds

China

Chinabond Val SHSE CSOP Corporate and local government
bonds

China

Chinabond Val SZSE CZOP Corporate and local government
bonds

China

ISE Large Market ISEL Corporate and local government
bonds

Turkey

Korean Exch Prices KCMP Local exchange bonds South Korea
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Index Source PCS Code FI Securities Country

MICEX Exch Corps MICB Corporate and local government
bonds

Russia

MICEX Exch Sovereign MICX Sovereign bond prices Russia

PDEX Corp Summary PDCS Corporate and local government
bonds

Philippines

PDEX Even Done Trade PDSS Corporate and local government
bonds

Philippines

JSE/BESA Exch BMA Corporate and local government
bonds

South Africa

Shanghai Exch SHNG Corporate and local government
bonds

China

Shenzhen Stock Exchange SHEN Corporate and local government
bonds

China

TBSP via WSE WMTS Corporate and local government
bonds

Poland

Valmer VALP Corporate and local government
bonds

Mexico

Warsaw Stock Exchange WSE Corporate and local government
bonds

Poland

NOTES ON SPECIFIC TYPES

CDS Contracts: To model a CDS contract, use the Credit Default Swap Valuation (CDSW) function. To model a plain-vanilla
IRS, use the Swap Manager (SWPM) function. All CDS and IRS should be added to the portfolio in thousands, not actual.
For example, if you own an IRS with a notional of 1 million, enter 1,000 in the portfolio in PRTU.
• For more information on CDSW, see CDSW <Help>.
• For more information on SWPM, see SWPM <Help>.

Note:  The market value of a swap/CDS in PORT may differ from the value in SWPM/CDSW because PORT takes
a snapshot of the curve at 4PM New York, London, and Tokyo time, which may differ from the closing curve used in
SWPM/CDSW.

Securities and Indices that Trade on Saturday and Sunday: Prices, dividends, and changes to the portfolio that occur on
Saturday and Sunday are included in calculations. For more information on setting a seven-day trading week for your portfolio,
see General Calculations.

bbg://screens/HELP CDSW
bbg://screens/HELP SWPM
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Privately Held Instruments (EQPLs): PORT supports private equity instruments (EQPLs) for historical performance
analysis, so these instruments are not dropped as exceptions. The Holdings, Performance, and Attribution tabs in PORT
provide the most value, as you can analyze weights, returns, and contributions to return of these private instruments. For more
information on these tabs, see Intraday Tab, Holdings Tab, Performance Tab, and Attribution Tab. EQPLs also appear in all
other tabs, such as Intraday, Characteristics, and Tracking Error, but these instruments do not tick and are not covered by any
risk model.

To analyze EQPLs in PORT, the securities must be created via the Equity Custom Security (EQPL) function, and their
historical prices must be uploaded via BBU and saved with the portfolio in PRTU. For more information on creating EQPLs and
saving historical prices, see EQPL <Help>, PRTU <Help>, and BBU <Help>.
|Hint| For AIM Analytics users, prices saved in AIM accounts flow through to PRTU and PORT automatically.

Note:  When you first create the EQPLs and load prices, the Intraday tab does not immediately recognize them. There is a 24
hour lag between when an EQPL is first created and when it will be recognized in the PORT Intraday tab. This lag only affects
intraday analysis.

Contracts for Difference (CFDs): PORT allows you to book and analyze CFDs in all PORT tabs. You can create a CFD in
the Option Valuation (OVME) function by entering OVME CFD <Go>, then you can book the position in PORT. To analyze the
CFD in PORT, the underlying instrument must be an equity, fund, bond, or index. For more information on option valuation, see
OVME <Help>.

The initial contract price for a CFD can be modified over time by changing the cost price in your position file uploaded via the
Bloomberg Uploader (BBU) function. Setting a non-zero margin percentage for the CFD implies that a daily cash amount
equal to the exposure value of the contract times the percentage will be injected into the portfolio. For more information on
uploading positions via BBU, see BBU <Help>.

PORT SHORTCUTS

You can access specific tabs, sub-tabs, and windows in PORT using the following command line shortcuts.

Enter To display

PORT IP <Go> Intraday > Main View

PORT HD <Go> Holdings > Main View

PORT CH <Go> Characteristics > Summary

PORT KR <Go> Characteristics > Key Rates

PORT CF <Go> Characteristics > Cash Flows

PORT TE <Go> Tracking Error > Summary

PORT VR <Go> VaR > VaR Comparison

PORT SS <Go> Scenario > Scenario Summary

PORT HP <Go> Performance > Total Return

bbg://screens/HELP EQPL
bbg://screens/HELP PRTU
bbg://screens/HELP BBU
bbg://screens/HELP OVME
bbg://screens/HELP BBU
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Enter To display

PORT PA <Go> Attribution > Summary

PORT TS <Go> PORT with Trade Simulation enabled

PORT OP <Go> Portfolio Optimization window

PORT V <VIEW_NAME> <Go> PORT using the selected view

ACCESSING NEWS & RESEARCH

PORT allows you to access real-time, comprehensive news for your portfolios and holdings, so you can stay on top of
information that may affect your investments. PORT also integrates access to the Research (RES) function, so you can quickly
display in-depth research related to your portfolio holdings.

When you load your portfolio, the Main View of all tabs displays a column on the left of the table that contains News Heat182 
icons. These icons represent the level of news story flow for the securities and sectors in your portfolio.
 

 

News heat is a measure of the amount of stories currently being published on a company relative to the flow over the previous
45 days. The data is updated in real time. The greater the number of bars, the more news that is being generated for that
instrument.
 

182 A measure of the amount of stories currently being published on a company relative to the flow over the previous 45
days. The data is updated in realtime. The greater the number of bars, the more news that is being generated for that
instrument.
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You can click any news icon to display relevant information for that sector/bucket level (as opposed to the entire portfolio) in
another window. For example, News & Research Headlines (NPH) appears at the sector levels, while Company News (CN)
appears at the security level. For more information, see N <Help>.

You can also right-click the portfolio name and select a news and research option:
 

 

• News: Displays a window of news and research at portfolio and sector levels.
• Research: Displays the Research Portal (RES) function in another window. The portfolio is loaded and research related to

holdings appear in alphabetical order (or based on your previously set preference). For more information on how to set up
and use RES to aggregate and customize views for all research on a single screen, see RES <Help>.

• SALT (Create daily news summary): Displays the Suggested Alerts (SALT) function in another window. SALT suggests
real-time and daily news alerts to which you can subscribe for a daily delivery of top news on your portfolio. For more
information, see SALT <Help>.

ADDING ALERTS

You can create and manage news, trading, and/or corresponding alerts for the securities in your portfolio. You can set alerts
for certain trading conditions, manage their delivery, and include colleagues in the alert. Typically, alerts are sent to your MSG
inbox, but you can change this option.

To add an alert for the securities in your portfolio:

1. From the toolbar, select Actions > Add Alert.
 

bbg://screens/HELP N
bbg://screens/HELP RES
bbg://screens/HELP SALT
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The Alert window appears.

2. In the Step 1. Select/Securities section, click the Securities/List drop-down menu and choose whether to set an alert for an
individual security (Security) or for multiple securities, shared list, or portfolio (List).
 

 

• If you select List, click the corresponding drop-down menus and choose from the portfolio source, and then the
portfolio. options.

• If you want to create an individual alert for your list, select the Create Individual Alert checkbox.
• Click the Positions drop-down menu and choose All, Long, or Short.

3. In the Step 2. Select Conditions section, set the alert conditions:
 

 

• Any: Sends your alert when any of your conditions are true.
• All: Sends your alert when all of your conditions are true.
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• Click the Field drop-down menus to set your alert conditions. Your subsequent options vary with each option you
choose.

4. In the Step 3. Select Settings section, select the additional settings (where applicable):
 

 

• Notification of Frequency: Determines how often the alert is sent.
• Time Range: Allows you to set a specific time of day by which alerts are sent. Leave unchecked if you do not want to

set a timeframe.
• Expires: Allows you to choose the number of days when the alert will expire.
• Notes: Enter notes about the alert, if needed.
• Alert Group: Allows you to choose to which group of alerts you want to combine the alert.
• Override Delivery: Allows you to choose alternative methods by which your alert is delivered.
• Contacts: Enter SPDL or other contact information for colleagues with whom you want to share the alert.

5. Click the Update button.

The alert is created and can be managed in the future by selecting, from the toolbar, Actions > Add Alert.

ANALYZING ONE INSTRUMENT

You can display single-instrument analytics from most tabs within PORT. You can display these analytics by right-clicking the
individual instrument to display a menu of options:

Select To display

BQ (Bloomberg Quote) A composite overview of key price and trade data.

CN (Company News and Research) News stories and research reports.

CU (One Security Menu) A quote line and related menu for the security.

DES (Description) A detailed description of the commodity.

EE (Earnings Estimate) Earnings estimates.
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Select To display

FA (Financial Analysis) The financial history for a specific company.

GIP (Intraday Price Graph) An intraday price chart.

GPO (Price Bar Graph with Moving Average) A price bar chart.

HP (Historical Price) Historical prices, yields and values.

QR (Trade Recap) All price ticks for a selected exchange listed security.

SPLC (Supply Chain) The supply chain relationships for a selected company.

For more information, see the corresponding Help Page for each of the above functions. For example, EE <Help>.

ANALYTIC RESULTS MONITOR

In the Main View sub-tabs for each tab, you can monitor the status of analysis calculations and quickly re-run previous
calculations via the analytic results monitor.

The monitor appears at the bottom of the screen and can be displayed or hidden by clicking the arrow next to the Submitted at:
(last update time) label.
 

 

The Stored Results section appears and displays recently run Main View sub-tab calculations. The Status column indicates
whether the calculation is complete, still processing, or failed.
 

 

You can update the list of stored results:
• To search for calculation results, enter keywords in the fields below the column headers and pressing <Go>.
• To re-run a calculation, simply click the row. The screen updates automatically.
•

To clear the list of results, click the Clear Stored Results icon ( ) in the top right.

bbg://screens/HELP EE
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USING CUSTOM DATA (CDE)

You can incorporate custom data that is uploaded or entered in the Custom Data Editor (CDE) function into PORT, so you
can customize your portfolio view and calculations to meet your individual or firm's analysis needs. Custom data gives you the
flexibility to supplement Bloomberg's security coverage, leverage your firm's internal models, feed analytics from a licensed
data vendor, and customize and extend specific portfolio calculations.

For complete information on uploading or entering data in CDE, see CDE <Help>.

You can access information on using custom data in PORT:

• For information on overriding fixed income data to analyze in the Characteristics tab, see Overriding Fixed Income
Analytics.

• For information on generating return on cash for currencies in your portfolio using custom data, see Return on Cash.
• For information on customizing the country tax rates used to calculate how tax is withheld from dividends included in return

calculations, see Tax Rates for Net of Tax Returns.
• For information on uploading custom target prices so you can monitor your positions versus your target price, see Custom

Target Prices.
• For information on creating new classifications using custom data, see Creating New Classifications.

SETTINGS

GROUP-LEVEL ANALYTICS

You can analyze a group of up to ten (10) equity portfolios in PORT in a group-level aggregation. You can also choose to
analyze the portfolio grouping against a benchmark.

To analyze a portfolio group, you must first create the group in the Portfolio Groups Setup (PGPS) function and select the
Enable group-level aggregated analytics in PORT option. In PGPS you can also determine the benchmark against which
to analyze the grouping, as well as the currency for the analysis. For more information, see PGPS <Help>.

To analyze a portfolio group:

1. From any Main View sub-tab, click the Port183  (portfolio) drop-down menu in the control area and select the aggregated
option from the Portfolio Groups section of the drop-down list, then press <Go>.
 

183 In general, Port indicates the portfolio being analyzed. The portfolios are created and maintained in PRTU and BBU.
For more information, see PRTU <Help> and BBU <Help>. In the Characteristics - Characteristics Summary sub-tab,
however, Port indicates the weight value of the portfolio.

bbg://screens/HELP CDE
bbg://screens/HELP PGPS
bbg://screens/bbg://screens/HELP PRTU
bbg://screens/bbg://screens/HELP BBU
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|Hint| If you want, you can also select a benchmark from the Bmrk184 field.
Your aggregated portfolio group appears. The top-level of your aggregation appears in white and your sub-portfolios appear
in amber and display a "P" icon. The top-level data is a computation of the analytics of the aggregate of sub-portfolios.
 

 
2. If you want, conduct further analysis:

• To analyze the constituents of the aggregate portfolio, double-click the aggregate level (white).
 

184 Indicates the benchmark against which you are comparing your portfolio, which can be an index, portfolio, or fund.
• In the Characteristics - Characteristics Summary sub-tab, the benchmark indicator value.
• In the View Manager, allows you to choose which fields appear in the benchmark column (for each tab).
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• To analyze the constituents of a single portfolio, double-click the portfolio name (amber).
 

 
|Hint| You can return to the aggregate level by clicking the aggregate title, which now appears blue.

In the Intraday tab, the intraday monitor chart at the bottom of the screen tracks whichever level you have selected, either
multiple portfolios or a single portfolio.
 

 

CONFIGURING TAB ORDER

Once you have created a view, you can add, remove, and re-order tabs, so the display matches your portfolio analysis
workflow.

Note:  These instructions assume you have created a view and are in the View Manager screen. For more information on
creating a view, see Creating a View.

You can also drag and drop the tabs in PORT to change their order. Your order changes automatically save. The first tab will
always be your default.

To further configure the tabs in your view:

1. From the sidebar, click General Settings > Tab Order.

The Available Tabs, Selected Tabs, and Description sections appear in the Tab Order section.
|Hint| You can click any tab name in the Available Tabs or Selected Tabs sections to see information about the tab in the
Description section below.

2. Modify the order of the tabs:

• To add a tab to your view, select the tab name in the Available Tabs section, then click the Add -> button. The tab
appears in the Selected Tabs section.
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• To remove a tab from your view, click the tab name in the Selected Tabs section, then click the Remove <- button. The
tab is removed from your view.

• To re-order your tabs, click the tab you want to move, then click the Move Up or Move Down buttons until your order
is achieved. At anytime using PORT, you can drag and drop the tabs into a new order. Your order changes automatically
save. The first tab will always be your default.

3. From the toolbar, click the Save button.
Your view settings are saved.

If you want to see your view in PORT, from the toolbar, click the Run button. The view and its related settings appear.

ADVANCED VIEW DEFAULTS

Once you have created a view, you can set advanced view defaults, so PORT accurately matches your workflow needs.

These instructions assume you have created a view and are in the View Manager screen. For more information on creating a
view, see Creating a View.

To set advanced view defaults:

1. From the sidebar, click General Settings > View Defaults.
The View Defaults section appears.

2. Update your view settings:

 

 

• Display Securities Fully Expanded: Choose to display your securities fully expanded in the data grid each time you
access the view.

• Show Benchmark Securities: Choose to see benchmark securities (when comparing your portfolio to a benchmark).
• Enable (Portfolio / Benchmark) Look-through: If your portfolio (or benchmark) contains funds or ETFs, choose to

"look through" these funds or ETFs to their underlying holdings.
• Default As Of Date: Select the default date of analysis when starting PORT. If set to Today, the analysis is based on

current positions, but still uses the previous day's closing prices. This feature applies to all tabs except Intraday and
Attribution.
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• Default Historical Date Range: Select the default timeframe for analysis in the Performance Total Return and Period
Analysis sub-tabs and the Attribution tab, such as one day (1D), week-to-date (WTD), or month-to-date (MTD).

• Instrument Description: Choose the description that appears under the Name column of the Main View sub-tab,
either a long form name (Long Name) or the ticker symbol (Ticker).

• Exclusion: Select to exclude a portion of your portfolio and benchmark from the analysis. You can exclude cash, a
sector, or even a specific instrument. For more information on this feature, see Excluding Securities.

• Wake-up Mode for Aggregated Group: Choose the default aggregation mode, either Portfolios or Aggregation.

Note:  For desktop users, an aggregation of groups is set in the Portfolio Groups Setup (PGPS) function. For more
information, see PGPS <Help>.

3. Update your Display Units options, which allow you to set how performance-related fields (e.g., Total Return, Attribution
Effects) appear in PORT. The options are Basis Points, Percentage, and P&L.
 

 

Note:  Not all tabs support all options.

4. From the toolbar, click the Save button.
Your view settings are saved.

If you want to see your view in PORT, from the toolbar, click the Run button. The view and its related settings appear.

SETTING COLUMN DEFAULTS

Once you have created a view, you can select the columns (fields) that appear in the tabs as well as attribute benchmark and
difference data. You can also choose the number of decimal places, arrange column order, and other options for each tab.

These instructions apply to setting defaults for all tabs (rather than a specific tab) and assume that you have created a view
and are in the View Manager screen. For more information on creating a view, see Creating a View.

To set column defaults:

1. From the sidebar, click Tabs & Columns > (Tab Name).
The corresponding default options appear, including the currently selected columns (i.e., the columns that currently appear
in the tab).

2. Update your column defaults:

 

bbg://screens/HELP PGPS
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• Available Fields: To add a field to the selected tab, from the Available Fields section, browse for the field and click the

corresponding add ( ) icon. The field appears in the Field Order & Grouping section.
|Hint| To learn more about a particular field, click the (i) button. Depending on the selected tab, you can also search for
more fields by clicking the More (Asset Class) Fields button and entering keywords in the search field that appears.

• Field Order & Grouping: To display/hide benchmark and/or difference data for a field, de/select the Bmrk or +/-
checkboxes.

To re-order your columns in the tab, click the drag and drop icon ( ) on the left and move the column to the desired
order.

To remove a column from the tab, select the field name, then click the delete icon ( ) to the right of the column.

3. If you want to adjust the number of decimals that appear for a column, among other parameters, click the pencil icon next to
the column name.
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The corresponding field options appear in another window, where you can update the relevant criteria. The options vary
depending on the selected tab and field. For information on any of the options, position your cursor over the field name.

4. From the toolbar, click the Save button.
Your view settings are saved.

If you want to see your view in PORT, from the toolbar, click the Run button. The view and its related settings appears.

GENERAL CALCULATIONS

You can set your portfolio's trading week options, which can reflect your portfolio default settings (set in PRTU) or five or seven
day trading calendar settings. You can also customize return on cash settings, which allow you to determine the value of cash
returns in your portfolio analysis, as well as enable proxies for securities.

These instructions assume that you have created a view and are in the View Manager screen. For more information on creating
a view, see Creating a View.

To set your general calculations:

1. From the sidebar, select Calculation Settings > General.
General calculation options appear at the top of the screen.

2. Update your settings:
 

 
• Trading Week: Choose the calendar settings for default trading week setup.

— 5 Day (M-F): The conventional trading week setting for portfolios, which does not include trading activity that occurs
on Saturday or Sunday.
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— 7 Day: The seven day setting includes securities that trade on Saturday and Sunday. This selection ensures that
prices, dividends, and changes to the portfolio that occur on Saturday and Sunday are included in calculations.

— Portfolio Default: This option is tied directly to the portfolio settings you established in the Creating/Updating
Portfolios (PRTU) function. For the Trading Week option, Portfolio Default is the default setting in PORT.

• Return on Cash: Choose how to calculate the value of your cash returns in the Performance and Attribution tabs.
— None: There is no return on cash in the portfolio.
— Portfolio Fixed Rate: Allows you to use a fixed rate of return for your cash positions associated with a specific

portfolio. The fixed rate of return comes from the Return on Cash field on the PRTU Portfolio Display screen. For
more information on setting up this cash return, see Return on Cash.

— Pre-Defined Money Market Program: Allows you to simulate an investment in a money market instrument to see
a return on cash in your portfolio analysis. PORT uses a pre-defined money market program to define the return
associated with your currency. For more information on these options, see Return on Cash.

— Custom: Allows you to use a set of custom cash returns for any currency cash you have in your portfolio, rather
than just at the portfolio level. You can upload or enter custom cash returns through the Custom Data Editor (CDE)
function. From the Return on Cash drop-down menu, you can select the source you associated with the custom
data. For more information on uploading custom data via CDE, see CDE <Help>.

• Enable Proxies for Securities: When selected, proxied assets are used for security exceptions, allowing you
to effectively evaluate your portfolio as a whole. PORT allows you to proxy the risk attributes and security level
characteristics of one security to another. Once proxied, the security is no longer considered an exception and is
included in your risk and characteristic analysis and reporting. Proxied securities apply across all tabs. Descriptive data
and classifications of the original security are maintained for more accurate reporting. For information on setting up proxy
assets, see Setting Up Proxy Assets.

• Create Economic Cash: Allows you to enable or disable the calculation of economic cash for positions on futures.
Economic cash is generated synthetically in order to cancel out the leverage of the position so the portfolio weight adds
up to 100%. For long/short portfolios, the portfolio weight does not need to be 100%, in which case you can choose to
disable economic cash.

3. From the toolbar, click the Save button.
Your trading week settings are saved.

If you want to see your view in PORT, from the toolbar, click the Run button. The view and its related settings appear.

GENERAL CALCULATIONS (EQUITY)

Once you have created a view, you can customize general equity defaults, including the return on calculation type.

These instructions assume that you have created a view and are in the View Manager screen. For more information, see
Creating a View.

To set your equity general settings:

1. From the sidebar, select Calculation Settings > General.
Options for general equity settings appear.

2. Update your settings:
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• Depositary Receipts Pricing: If selected, the underlying equivalent price is calculated by multiplying the price of
the underlying ticker by the receipt ratio. The receipt ratio represents the number of underlying shares represented by
one receipt. If the underlying share is unlisted, not actively traded, or a receipt ratio is unavailable, the receipt price
continues to be used. If the underlying is not trading on a particular day due to a holiday (for example), the underlying
price from the previous day is carried forward.

If the underlying pricing is used, the currency of the receipt will be in the underlying share currency.

Note:  By default, the Depositary Receipts Pricing option is not checked.
• Foreign Share Pricing: Enabled by default. If selected, the price for the foreign share is taken from the equivalent

local share. Foreign shares are issued in Thailand and India as equivalent shares to the local market share, but legally
can be owned by foreign investors. Foreign shares are usually identified with /F at the end of the ticker (e.g., THAI/F
TB <Equity>, as opposed to THAI TB <Equity> for the local share). Typically, there is very little, if any, trading activity
reported by the exchange on Foreign Shares, and hence the fair market price is much more closely aligned to the
equivalent local share price.

• Return Calculation Type: Choose your taxation calculation method.
— Gross: No tax is taken out of dividends included in return calculations.
— Net: The withholding tax is based on the country of domicile of the company, and is taken out of the dividend in the

return.

Note:  By default, the withholding tax for each country is based on a Bloomberg-maintained tax rate. You can
override a specific country's tax rate by uploading custom country tax rates using the Custom Data Editor (CDE)
function. For more information on using custom tax rates, see Tax Rates for Net of Tax Returns.

— Portfolio Gross / Bench Net: Calculates gross returns for the portfolio versus net of tax returns for the benchmark.
• Country of Jurisdiction: Choose the tax status to be used when determining the dividend to be included in the total

return calculation. Net dividend calculations reduce this dividend by (1 - country tax rate).

For more information on these options, see Definitions.

Note:  Country-based tax rates are applied to dividends going ex-date between specified dates. The appropriate
country rate to be applied is determined by the Country of Domicile (Bloomberg Field Code DX113) of the company
issuing the dividend. To see a table of default tax rates utilized by PORT when performing net of tax return calculations,
see the document PORT Default Tax Rate Table.

3. From the toolbar, click the Save button.
Your equity pricing settings are saved.

If you want to see your view in PORT, from the toolbar, click the Run button. The view and its related settings appear.
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GENERAL CALCULATIONS (FI)

Once you have created a view, you can customize general fixed income defaults.

These instructions assume that you have created a view and are in the View Manager screen. For more information, see
Creating a View.

To set your equity general settings:

1. From the sidebar, select Calculation Settings > General.
Options for general fixed income settings appear.

2. Update your settings:

 

 

• Discount Curve: Choose the curve you want to use for your discount factor (swap or sovereign).

Note:  For both swap and sovereign, the curve is based on Option Adjusted Duration (OAD) and Option Adjusted
Spread (OAS).

• Mode: Choose how to display XXXX value, either as a percentage or as dollar value of one basis point (DV01).

3. From the toolbar, click the Save button.
Your fixed income settings are saved.

If you want to see your view in PORT, from the toolbar, click the Run button. The view and its related settings appears.

PRICING SOURCE DEFAULTS

Once you have created a view, you can customize pricing sources and historical return defaults.

You can see the prices and resolved sources used for each specific instrument in the analysis by drilling into the Attribution
tab. To access this information, right-click the name of the portfolio in the Attribution tab and select Explain Return
Calculation. The Performance Data Dashboard appears in another window, which allows you to access portfolio performance
by historical date and drill into each date to analyze return, weight, pricing source, and more for each position.

These instructions assume that you have created a view and are in the View Manager screen. For more information, see
Creating a View.

To set your historical return pricing sources:

1. From the sidebar, select Calculation Settings > Pricing Source.
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Options for the historical return calculation appears.

2. Update your settings:

 

 

• Equity Intraday Data: Choose the source for the live market price on the Intraday tab.
— Primary Exchange: Uses price data from the security's primary exchange.
— Composite: Uses Bloomberg composite prices, which are aggregated data from local exchanges.



>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //194

• Fixed Income Intraday Data: Choose the source for the live market prices for fixed income and balanced portfolios
for Intraday tab analysis. BVAL is the default price if a security is not priced in your waterfall selection. In the second
row, you can choose the side of the market (Bid or Ask) from which prices are sourced.

• Equity Historical Data: Choose the order of pricing sources for closing prices.
— MSCI: Uses price data provided by MSCI. PORT supports up to seven years of MSCI analysis. If you select this

option, PORT uses Primary Exchange and Composite Prices as backups for any securities for which MSCI Prices
are not available.

When using MSCI, typically you can only see month-end data when going back beyond the first year. Thus, with an
MSCI index (on either the portfolio or benchmark side), you cannot enter mid-month dates beyond the first year. For
example, you can only select 12/31/2009, not 12/15/2009.

— Primary Exchange Pricing: Uses price data from the security's primary exchange. If you select this option, PORT
uses Composite Prices as a backup for any securities for which Primary Exchange Prices are not available.

— Composite: Uses Bloomberg composite prices, which are aggregated data from local exchanges.
• Fixed Income & Private Equity Historical Data: Choose the pricing source waterfall185  for closing prices and

other non-ticking data for portfolios, indices, and public portfolios. You can choose a predefined waterfall provided by
Bloomberg or create a custom waterfall, which is a set of pricing sources you select and organize or a set of pricing
sources that is based on a predefined waterfall.
— BVAL else Local else Custom: Uses a predefined waterfall that sources the Bloomberg Valuation Service (BVAL)

first, then local prices, then your custom portfolio pricing from the Creating/Updating Portfolios (PRTU) function.
— Local else BVAL else Custom: Uses a predefined waterfall that sources local prices first, then BVAL, then your

custom portfolio pricing from the Creating/Updating Portfolios (PRTU) function.

Note:  In some cases, the local sources price some of the same bonds; in those instances the pricing source
that is highest in the pricing source hierarchy is used in PORT. The hierarchy for local price sources is: 1) Brazil
(ANBE), 2) Korea (KCMP), 3) South Africa (PBMA), and 4) Mexico (PIPV). For more information on BVAL, see
BVAL <Help>.

— BVAL else Portfolio: Uses a predefined waterfall that sources BVAL first, then prices uploaded to the specific
portfolio.

— Index Provider else BVAL else Portfolio: Uses a predefined waterfall that sources the provider of the index selected
as the benchmark first, then BVAL, then prices uploaded to the specific portfolio.

Note:  The index provider source is a special wildcard source that is dynamically evaluated when running PORT.
If the portfolio is benchmarked to a specific single index (not a composite, another portfolio, or fund), the index
provider source picks up the associated pricing from that index provider. If the benchmark is a custom benchmark
composed of one or more indices (even from the same vendor), the index provider source does not evaluate and the
waterfall falls through to the next source. Some index sources require direct licensing with the vendors providing the
data to Bloomberg. If you are not licensed for an index provider source, the waterfall falls through to the next source.

185 A hierarchy of sources used to specify the priority of pricing sources you want to use. For each day in the analysis,
instruments are priced by checking for a price from the first source in the hierarchy. If not found, the next price source on
the list is checked. The process continues until a price is found. For historical analysis such as performance attribution,
PORT looks back up to 10 business days to find prices for the start date of the analysis. From that day forward, if the
price source hierarchy fails to find a price for a given day, the last known price is carried forward.
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— Index Provider: The provider of the index selected as the benchmark is sourced. See above for more information on
index provider sources.

— Custom Waterfall: Uses the custom pricing waterfall that you created or that a colleague shared with you, which may
include any set of sources you are licensed to see. The custom pricing waterfall may be a set of pricing sources you
select and organize or a set of pricing sources that is based on a predefined waterfall. For information on setting up
your pricing waterfall, see Customizing Price Waterfall.

When you select a custom waterfall, you can also specify that your custom analytics override the fixed income
analytics calculated by PORT. For more information on setting up custom fixed income analytics, see Overriding
Fixed Income Analytics.

Note:  Once you create and save a custom waterfall, the name of the waterfall appears in the list of options available
for your Fixed Income & Private Equity Historical Data.

• Fx Historical Data: Choose the source waterfall186  for currency rates used in pricing calculations. You can choose
a predefined waterfall provided by Bloomberg or create a custom waterfall, which is a set of pricing sources you select
and organize or a set of FX rate sources that is based on a predefined waterfall.
— TTM else BB Composite (London, 6PM): Uses a predefined waterfall that sources the Telegraphic Transfer Middle

(TTM) rate first, then the Bloomberg composite rate from London at 6PM.
— Index else Bloomberg Fixing (New York, 4PM): Uses a predefined waterfall that sources the rate provided by the

index vendor of the benchmark utilized in the analysis, then the Bloomberg FX fixing rate from New York at 4PM.
— Custom Waterfall: Uses the custom FX rate waterfall that you created or that a colleague shared with you, which

may include any set of sources you are licensed to see. The custom waterfall may be a set of FX rate sources you
select and organize or a set of FX rate sources that is based on a predefined waterfall. For more information, see
Customizing Price Waterfall.

Note:  In your custom waterfall for FX rates, you can choose a custom FX rate source that you set up via the
Custom Date Editor (CDE) function. For more information, see Using Custom FX Rates.

3. From the toolbar, click the Save button.
Your pricing source defaults are saved.

If you want to see your view in PORT, from the toolbar, click the Run button. The view and its related settings appears.

Note:  Your portfolio may show a different total return between PORT and the Historical Fund Analysis (HFA) function. For
more information on HFA, see HFA <Help>.

CUSTOMIZING PRICE WATERFALL

When setting up your price source defaults for Fixed Income & Private Equity Historical Data or FX Historical Data, you can
create a custom pricing source waterfall, so you can leverage all the sources you are licensed to see and understand the
exact ordering of the pricing sources. You can also enable your custom analytic data to be used in place of BLOOMBERG
PROFESSIONAL® service analytics, which are derived from bond prices.

186 A hierarchy of sources used to specify the priority of pricing sources you want to use. For each day in the analysis,
instruments are priced by checking for a price from the first source in the hierarchy. If not found, the next price source on
the list is checked. The process continues until a price is found. For historical analysis such as performance attribution,
PORT looks back up to 10 business days to find prices for the start date of the analysis. From that day forward, if the
price source hierarchy fails to find a price for a given day, the last known price is carried forward.

bbg://screens/HELP HFA
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Your pricing waterfall187  may include a variety of sources, so PORT allows you to see the prices and sources actually used
on each historical date by drilling into the Attribution tab. To access this information, right-click the name of the portfolio in the
Attribution tab and select Explain Return Calculation. The Performance Data Dashboard appears in another window, where
you can access portfolio performance by historical date and drill into each date to analyze return, weight, pricing source, and
more for each position.

The steps below demonstrate customizing your fixed income and private equity pricing source waterfall, and assume you are
already in the Pricing Source defaults screen. For more information on setting up your Pricing Source defaults, see Pricing
Source Defaults.

Steps:

1. From the Portfolios or Benchmarks drop-down field, select Create New.

Note:  You can also click the Customize button next to Portfolios or Benchmarks.

The Create Waterfall window appears.

2. In the Waterfall Name field, enter the name of the new waterfall, then click the Save button.
 

 

The Portfolio Waterfall screen appears.

3. Choose the pricing sources you want to include in your waterfall:

• To use a predefined waterfall as the basis for your custom waterfall, from the Waterfall field, make a selection.
 

187 A hierarchy of sources used to specify the priority of pricing sources you want to use. For each day in the analysis,
instruments are priced by checking for a price from the first source in the hierarchy. If not found, the next price source on
the list is checked. The process continues until a price is found. For historical analysis such as performance attribution,
PORT looks back up to 10 business days to find prices for the start date of the analysis. From that day forward, if the
price source hierarchy fails to find a price for a given day, the last known price is carried forward.
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•
To choose your pricing sources individually, from the Available Sources section, click the add ( ) icon next to the
sources you want to add.
 

 

Note:  For information on each available source, click the Help icon (i) next to the source name.

4. If you want to reorganize the pricing sources, in the Selected Sources section, click the icon to the left of each source and
drag and drop to a new location in the list.
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Note:  Portfolio and benchmark price sources must always include Bbg Valuation (BVAL) above the Portfolio (PRTU/BBU)
or CDE custom price source. This indicates that your custom prices are only used if Bloomberg's BVAL service does not
price the bond on a given day. Special licensing is available that allows you to prioritize your custom pricing over BVAL in a
custom waterfall. Contact your account representative for more information.

5. If you want to override specific fixed income analytics with your custom data, select a data source from the Override
Calculations With drop-down menu (e.g., CDE:My Source).

Note:  You are only able to choose from data sources associated with custom fields that support analytic overrides. For a
list of available fields, see Overriding Fixed Income Analytics.

 

 

6. Save the custom pricing waterfall for use in your portfolio:

• If you created an entirely new waterfall, from the toolbar, click the Save button.
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• If you used a predefined waterfall as your base set of sources, from the toolbar, select Edit > Save As, then enter the
name of your new custom waterfall.
 

 

Note:  On the Portfolio Waterfall screen, you can also create, rename, and delete waterfalls by selecting, from the toolbar,
Edit > (Option).

7. Press <Menu>.
Your Pricing Source defaults appear.

Customizing your FX rate source waterfall is similar to the process described above. In the Available Sources section of the
Portfolio Waterfall screen, you can choose from a variety of snap times consolidated by Bloomberg from dealer sources,
which you can see in the Bloomberg FX Fixings (BFIX) function, several index vendor provider sources, and the dynamic Index
Provider source. The Index Provider source maps to an index vendor source dynamically at the time of analysis, as long as the
chosen benchmark is a single index and the vendor provides FX rates to Bloomberg. In addition, you can also set up a custom
FX rate source that you and your colleagues maintain. For more information on custom FX rates, see Using Custom FX Rates.

ATTRIBUTION CALCULATION DEFAULTS

Once you have created a view, you can customize the attribution defaults for both equity and fixed income portfolios, including
the attribution model, interaction effect, and whether the currency effect is embedded.

These instructions assume that you have created a view and are in the View Manager screen. For more information, see
Creating a View.

To set your attribution calculations defaults:

1. From the sidebar, select Calculation Settings > Attribution.
Options for the attribution calculation appear, with one column for equity portfolios and one column for fixed
income/balanced portfolios.

2. Update any of the attribution calculation settings:
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• Attribution Model: Choose which attribution model to use, either based on sector return (Brinson-Fachler) or factor
return (the others).

• Aggregation Mode: Choose the aggregation method used to calculate Allocation Effect and Selection Effect.
— Single-Level: A bottom-up approach where all aggregations are flattened first for the Allocation and Selection Effect

calculations. The aggregation ordering does not impact the attribution results (e.g., Sector by Duration = Duration
by Sector).

— Multi-Level: A top-down approach where Allocation and Selection Effect calculations are conditional on aggregation
ordering (e.g., Sector by Duration yields different results than Duration by Sector).

For more information on the top-down versus bottom-up approach, see the Nested Attribution White Paper.
• Annualization: If you want to annualize attribution results, select the Annualize Returns and Contributions checkbox.

365 days is used as the base for the annualization calculation.

Note:  Annualization is only available for the Brinson-Fachler Total Return Attribution model.
• Benchmark Hurdle Rate: Depending on your attribution model selection, this field is automatically set as relative or

absolute. Relative is your portfolio performance minus the benchmark performance.
• Interaction Effect: Choose how the interaction effect of attribution is exposed.

— Show Interaction: Exposes the Interaction Effect188 .
— Combine with Selection: Combines the Interaction Effect with the Selection Effect189 . This is the default selection.

188 The interaction between the weighting and the selection effects, which does not represent an explicit decision of the
investment manager.

189 The active return attributed to security selection decisions that differ from the benchmark. When the portfolio sector
returns exceed the benchmark return, a positive number is posted.
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— Combine with Allocation: Combines the Interaction Effect with the Allocation Effect190 .

Note:  When you attempt to outperform a benchmark based on sector bets and stock picking, Return Attribution
quantifies the effectiveness of this strategy relative to the benchmark in terms of Allocation and Security Selection,
respectively. Interaction Effect191  occurs when you pick a security on which you are simultaneously making a bet on
the sector in which that security belongs. For this reason, the interaction term is difficult to interpret because it is a
combination of sector allocation and security selection. Most portfolio managers add this interaction term to Security
Selection, which is the default in PORT.

• Linking Method: Choose how attribution is calculated.
— Arithmetic: The portfolio's performance is captured as return differences relative to the benchmark. Arithmetic returns

imply that each of the attribution factors must add up to the total.
— Geometric: The portfolio's total return is captured as a ratio to the benchmark. In this case, Alpha = 100 *

[(1+portfolio return / 100) / (1+benchmark return / 100)-1]. Geometric attribution remains consistent with the idea
that sub-period returns must be multiplied together to calculate overall return. However, it is less intuitive because
the attribution factors do not add up.

• Embed Currency Effect: Select to embed (add) the currency effect into both the selection effect and allocation effect
in attribution calculations. Currency effect is the active return due to currency exposures that differ from the benchmark.

• Parallel Shift: If you want to utilize a parallel shift, select the timeframe for which you want the shift to apply (3, 5, or
10 years). You can also choose to use a bench weighted average instead of a specific timeframe.

Note:  The Parallel Shift utilizes the change in yield of the maturity point, calculating the relative performance due to an
overall mismatch versus the index over a given duration. The resulting calculations can be seen in the Attribution Curve
Return sub-tab.

• FI Derivative Excess Return: Choose how a fixed income interest rate derivative's return is determined:

— Include in Curve: Combines the portion of a fixed income interest rate derivative's return not explicitly explained by
the curve change into the overall Curve Return.

— Include in Excess: Exposes the portion of a fixed income interest rate derivative's return not explicitly explained by
the curve change in the Excess Return.

• Performance Calc: Choose whether historical returns and performance attribution are calculated using
Holdings-based returns or Transactions-based returns. For more information on historical returns, see Historical
Returns. For more information on transactions-based attribution, see Transactions-Based Method.

• Cashflow Weights: Displays how cash flows are weighted when Transactions-based is selected for the Performance
Calc. Defaults to Inflow (begin); Outflow (end) (IBOE), meaning Bloomberg includes all inflows (buy long and short
sales) at the start of the day and all outflows (sell long, buy to cover) at the end of the day.

3. From the toolbar, click the Save button.
Your attribution calculation settings are saved.

If you want to see your view in PORT, from the toolbar, click the Run button. The view and its related settings appears.

190 The active return attributed to asset allocation decisions (e.g., sectors, countries, or market caps) that differ from the
benchmark. The allocation is generally positive when the fund is overweight for a sector in which the benchmark return
exceeds the total benchmark return.

191 The interaction between the weighting and the selection effects, which does not represent an explicit decision of the
investment manager.
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RISK FACTOR CALCULATION DEFAULTS

Once you have created a view, you can customize risk factor calculation defaults, including a default risk model.

These instructions assume that you have created a view and are in the View Manager screen. For more information, see
Creating a View.

To set your risk factor calculation defaults:

1. From the sidebar, click Calculation Settings > Risk.
Options for risk factor calculations appear. Depending on the tabs in your view, the VaR, Scenarios, and/or Tracking Error
tabs at the bottom of the screen let you set risk factor defaults for those tabs.

2. Update any of the risk factor settings:

• Risk Defaults: Set defaults that apply across the Tracking Error, VaR, and Scenarios tabs.
 

 

— Risk Model: Allows you to choose which multi-factor risk model is used to estimate the portfolio, benchmark, and
active risk values (if applicable). For more information on the available risk models, see Equity Risk and Fixed Income
Risk.

— FX Risk: Allows you to disable foreign exchange risk in risk tabs, excluding the Trends and Factor P&L sub-tabs.
— Funds Exposures: Allows you to choose how exposures are calculated for funds, using either holdings-based or

returns-based analysis by default.
— Ignore Holdings Older Than (Days): Allows you to enter a number of days beyond which holdings are ignored for the

calculation of fund exposures.
• Tracking Error: Set the risk defaults that apply to the Tracking Error tab.
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— Use Auto Selected Regional Risk Model: When selected, PORT automatically uses a risk model based on your
region. This option overrides the common risk model.

— Version: Allows you to choose the date on which the model was generated. If you select Use Latest Version, the

latest model version available prior to the As Of192  date.
— Time Horizon: The length of time by which the risk factors are scaled.
— Marginal Risk: Allows you to determine the funding assumption for marginal risk calculations: cash (default),

portfolio, or benchmark. When calculating marginal risk, PORT assumes you are selling cash, portfolio, or
benchmark, depending on your selection.

• VaR: Set the risk defaults that apply to the VaR tab.
 

192 The date for analysis. If the date is set to today, the analysis is based on current position's with the previous day's closing
prices. Analysis may be backdated up to 90 days.
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— Time Horizon: The risk forecast period in number of business days. Bloomberg calculates a one day VaR and scales
that number by multiplying it by the square root of the number of business days to include additional timeframes.

— Custom TH (Days): Displays either the percentage return (Returns %) with respect to portfolio market value or the
return value (P&L) displayed in the reporting currency.

— Methodology: The default simulation methodology. Your choice affects the default selection in the VaR - VaR
Comparison sub-tab and the selected methodology used in Distribution and Simulations sub-tabs.

— VaR Comparison Units: Allows you to select whether to use the VaR Ratio (if a benchmark is available) instead of
the default value in the VaR Summary section of the VaR Comparison sub-tab.

— Confidence Level: You can choose up to three confidence levels used in reports, especially in the VaR Summary
section of the VaR Comparison sub-tab as well as the VaR Main View sub-tab.

— Use Stressed VCV for same risk model displayed above: When selected, allows you to select a custom stressed
VCV matrix, which affects VaR numbers.

— VCV: Allows you to select the custom Variance Co-Variance (VCV) matrix.
• Scenarios: Set the risk defaults that apply to the Scenarios tab.
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— Current Set: The available stress scenarios are limited to those you have created in the Scenario Manager. For more
information, see Scenario Manager.
|Hint| To use the default set of stress scenarios, click Reset to default set.

3. From the toolbar, click the Save button.
Your risk factor settings are saved.

If you want to see your view in PORT, from the toolbar, click the Run button. The view and its related settings appears.

CASH FLOW CALCULATION DEFAULTS

Once you have created a view, you can customize the cash flow summary defaults that control your cash flow projection view.

These instructions assume that you have created a view and are in the View Manager screen. For more information, see
Creating a View.

To set your cash flow projection defaults:

1. From the sidebar, select Calculation Settings > Cash Flows.
Options for cash flow projections appear.

2. Update any of the cash flow summary settings:

 



>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //206

 

• Time Horizon: Set the default time horizon for the cash flow projection summary as a specific number of days, months,
quarters, or years.

• Cash Flow Periodicity: Choose whether the summary displays daily, monthly, quarterly, semi-annual, or annual cash
flow payments.

• Workout Convention: Select the default Workout Conv193  for the cash flow projection.
• Startup Mode: Choose whether the cash flow summary appears as a chart or a table.

3. From the toolbar, click the Save button.
Your cash flow calculation settings are saved.

If you want to see your view in PORT, from the toolbar, click the Run button. The view and its related settings appears.

LIQUIDITY RISK DEFAULTS

Once you have created a view, you can customize the liquidity risk defaults that control the calculation of liquidity risk in the
Characteristics-Liquidity Risk sub-tab.

These instructions assume that you have created a view and are in the View Manager screen. For more information, see
Creating a View.

To set your liquidity risk defaults:

1. From the sidebar, select Calculation Settings > Liquidity Risk.
Default options for liquidity risk analysis appear.

2. Update any of the liquidity risk settings:

 

193 In the Cash Flow Summary sub-tab, allows you to choose the cash flow projection methodology, which provides an
assumption as to when you are going to recover your principal. The options are:

— To Worst: Selects a workout date that produces the worst yield based on the price of the bond. The date may be a
maturity or call date.

— To Next Call: Assumes the bond is called at its next call date.
— To Maturity: Assumes the bond is called on its maturity.
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• Default View: Select the default analytic194  view to appear when you access the Liquidity Risk sub-tab.
• Default Participation %: Select the participation rate you want to analyze by default. The participation rate is the

percentage of the portfolio you are willing to liquidate on a given day.
• Default Liquidity Horizon: Select the percentage of the portfolio's total market value you want to liquidate over a

specified timeframe when analyzing the liquidity horizon.
• Default Volume History: Select the amount of trade history you want to use when calculating the days to liquidate.

This defines the cell in the Liquidity Summary table to which the Liquidity Risk sub-tab defaults if multiple volume
histories are displayed.

• Volume Indicator: Determine whether you want to calculate the average or median number of days to liquidate based
on daily price volume or VWAP volume.

• Use Any Available Trade History: Select Yes to ensure that all securities are included in the analysis despite the
amount of trade history. If you select No, securities with limited trade history may be excluded from the analysis if the
volume history selected is too long.

• Volume Gauge: Select whether you want to measure volume using the average volume or the median volume.
• Use Volume from Composite Ticker: If set to Yes, the BLOOMBERG PROFESSIONAL® service uses the trade

volume associated with a security's composite ticker.

Note:  Bloomberg sets this option by default; you cannot edit this setting.
• Use Underlying Volume for Receipts: If set to Yes, Bloomberg uses the trade volume associated with the security

underlying the receipt. If set to No, Bloomberg uses the volume associated with the local shares of the receipt, which
may trade more actively.

Note:  Bloomberg sets this option by default; you cannot edit this setting.

194 The liquidity risk calculation selected for your portfolio analysis within the Characteristics-Liquidity Risk sub-tab. For
descriptions of each available view, see Liquidity Risk.
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• Select Up To 6 Liquidity Buckets: Set up your liquidity buckets to categorize your positions by degree of liquidity,
from highly liquid to illiquid, based on the number of days needed to liquidate the position. You can enter any exclusive
range and select the default bucket that appears in the Breakdown section of the Liquidity Risk sub-tab.

3. From the toolbar, click the Save button.
Your liquidity risk settings are saved.

If you want to see your view in PORT, from the toolbar, click the Run button. The view and its related settings appear.

Note:  For information on analyzing the Liquidity Risk sub-tab, see Liquidity Risk.

SHARING VIEWS/WATERFALLS

If you license AIM Analytics, you are permitted to share views with other users. If the view is configured to point to a custom
waterfall for Fixed Income & Private Equity Historical Data or FX Historical Data, the shared view also points to the same
waterfall. If you create a copy of the shared view, a local copy of the referenced waterfall is also created upon saving the view.
At this point, while the original waterfall and the new copy have the same name, they are no longer linked. If there is a name
conflict between any existing custom waterfall you have created and the waterfall created as a result of copying the shared
view, a number is appended to the new waterfall name (e.g., Waterfall1) to distinguish the waterfalls.

For more information setting up custom pricing source waterfalls, see Customizing Price Waterfall.

FULL VALUATION SCENARIO SETTINGS

Full valuation scenarios reference a set of global defaults, which manage the behavior of interest rate shifts, equity shifts, and
FX and commodity volatility shifts in full valuation scenarios. You can customize the global settings so you can run scenarios
based on your preferences.

These instructions assume that you are in the Scenario Manager screen. For more information on accessing the Scenario
Manager screen, see Accessing Scenarios.

To customize full valuation scenario global settings:

1. From the Scenario Methodology field, select Full Valuation.
 

 

The Settings button in the toolbar activates.

2. Click the Settings button.
The Global Settings window appears.

3. Update your interest rate, equity price shift, and FX and commodity volatility shift settings:
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• Swap Curve Path Progression Choice: Choose how swap curves are simulated on the horizon date.
— Shift at Horizon Date: The swap curve is progressed to the horizon date, then the shift is applied.
— Shift Today: The shift is applied to the curve as it exists today, then the shifted curve is progressed to the horizon

date.
— Linear Progression: The shift is an interpolated, gradual shift between today and the horizon date. For more

information on incorporating a reinvestment rate into horizon scenario analysis, see the document SWPM Horizon
Analysis.

• Swap Curve Evolution to Forward: Choose the rate to which the shift at the horizon date is applied.
— Yes: Applies shift at the horizon date to the forward rates.
— No: Applies shift at the horizon date to the current market rates.

• Floor Interest Rates to 0.0: Determine the behavior of the scenario if the shifted interest rate is negative.
— Yes: Always overrides negative interest rates to 0.
— No: Uses the shifted rate even if it is negative.

• Apply Index Propagation: Choose how to apply beta propagation shifts based on Bloomberg-defined equity indexes.
— Yes: Applies beta propagation to Bloomberg-defined equity indexes. For example, an equity index shift of 10% will

result in a (10% * beta) move in the equity.
— No: Does not apply beta propagation to equity indexes, so equity index price shifts have no impact on single

equities.

Note:  Bloomberg-defined beta values are maintained in the Beta Calculations (BETA) function. For more information,
see BETA <Help>.

• Override Default Beta Index: Enter an equity index to override the default index in beta propagation. If this field is
blank and Apply Index Propagation is set to Yes, beta propagation is based on a Bloomberg-defined beta index.

• Equity Beta Type Choice: Choose how the equity beta is used in shift calculations.

bbg://screens/IDOC #2070021
bbg://screens/IDOC #2070021
bbg://screens/HELP BETA
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— Use Raw Beta: Measures the risk of a security relative to the market (represented by the index).
— Use Adjusted Beta: Uses historical data and assumes that the security's beta moves towards the market average as

time progresses. The calculation for Adjusted Beta is: (0.67 * Raw Beta) + (0.33 * 1.0).
• FX and Commodity Vol Stick Choice: Choose how changes in the price of the underlying instrument impact the

implied volatility.
— Stick to Strike: If the price of the underlying instrument changes (i.e., FX spot rate), then the implied volatility of an

option with a given absolute strike does not change. For example, if the market price goes from $100 to $120, stick
to strike assumes the implied volatility for a $120 strike option does not change.

— Stick to Moneyness: If the price of the underlying instrument changes (i.e., FX spot rate), then the implied volatility of
an option with a given moneyness (delta) does not change. In this case, for example, if the market price goes from
$100 to $120, the implied volatility for a $120 strike option to change changes to whatever the $100 strike option
implied volatility was prior to the shift.

4. Click the Save button.
Your global settings are saved and are referenced by default if not overridden within specific scenarios.

ADDING/REMOVING FIELDS

In any Main View sub-tab you can easily add or remove fields (columns) to the display, so you can narrow your portfolio and
risk analysis.

To add or remove a field:

1. Right-click any of the column headers and select Add/Remove Fields.
 

 

The Edit Template window appears with all available fields on the left in the Available Fields section and all currently
selected fields on the right in the Selected Fields section.

2. Choose your columns:
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• To add a field to the selected tab, in the Available Fields section, browse the menu tree and select a field.

The field appears in the Selected Fields section. To learn more about a particular field, click the information ( ) icon.
• To access more fields, click the More (Asset Class) Fields button. For information on using this window, see

Additional Fields (Characteristics).

Note:  Additional asset class fields are not available on all tabs.
• To hide or display data for the benchmark and/or the difference between the benchmark and the portfolio, in the

Selected Fields section, select or deselect the Bmrk or +/- checkboxes.
•

To rearrange the order of the columns in the tab, in the Selected Fields section, click the drag and drop ( ) icon on
the left and move the column to the desired placement.

•
To remove a column from the tab, in the Selected Fields section, click the delete ( ) icon next to the field you want to
delete.

3. If you want to adjust the parameters of a selected field, such as the number of decimals that appear for the column data, in

the Selected Fields section, click the pencil ( ) icon.
Depending on the field, various options appears. For a description of each option, see Definitions. When you are finished
modifying the field parameters, click the Update button.

4. Repeat step 4 with any other fields you want to modify.
5. From the Edit Template window, click the Update button.

The view appears and reflects your field (column) changes.

CREATING NEW CLASSIFICATIONS

If one of the standard Bloomberg classifications models does not provide the breakdown you need, you can create and
customize a new classification.
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For information on using portfolio classifications, see Selecting Classifications.

To create a new classification:

1. From any Main View sub-tab, from the by field, select [More Options...].
 

 

The Select Classification window appears.

2. Click the More button.
 

 

The Create Classification screen appears.

3. Search for available fields by browsing the tree or entering a keyword in the search field.

Note:  Custom fields that you have set up in the Custom Sector Classifications (PCLS) function or in the Custom Data
Editor (CDE) function are found in the Custom category in the Available Fields tree. For more information on these
functions, see PCLS <Help> or CDE <Help>.

bbg://screens/HELP PCLS
bbg://screens/HELP CDE
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4.
Click the add ( ) icon next to the field(s) you want to add to your classification.
Each subsequently added field is placed at the next classification level. For example, if you click Country of Domicile then
Asset Type, the classification order is Country of Domicile > Asset Type.

Note:  Custom classifications support up to four breakdown levels.
5. In the Classification Name field, enter the name of the custom classification (if you want it to have a different name than the

default).
 

 

6. Click the Save button.
The Select Classification window appears with your new saved classification selected.

7. If you want to use your new classification in your portfolio analysis, click the Select button.
 

 
PORT updates based on the selected classification.
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USING CUSTOM FX RATES

PORT allows you to upload and access custom FX rates for use in customizing your FX rate source waterfall. Setting up your
custom FX rate source requires that you create a field in the Custom Date Editor (CDE) function and populate the field with
custom FX rates using CDE or the Bloomberg Uploader (BBU) function.

For more information on CDE and BBU, see CDE <Help> and BBU <Help>.

To set up your custom FX rate source:

1. Using the Custom Data Editor (CDE) function, create a custom field with a Content Type of Price, then choose a specific
Data Source intended for your custom FX rates. For more information on using CDE to create custom fields, click here .

Note:  By default, new custom data fields are configured to carry forward the currencies from the last date on which a rate
is specified until a new rate is provided. To ensure that FX rates fall through to an alternative source in your waterfall when a
rate is not provided for a particular date, change the Carry Forward Days setting in the field's Advanced Options to None
or Custom.

2. Add currency tickers to the custom fields:

• Using CDE, select the Price field you created, then add currency securities and custom rates for specific as of dates.
For more information on using CDE to update custom fields, click here .

• Using the Bloomberg Uploader (BBU) function, upload currency tickers and rates, then map your bespoke FX rates to
the custom Price field. For more information on using BBU to upload data to a custom data field, click here .

Note:  All currency rates must be represented relative to USD, either as units per USD or USD per unit based on the
related currency convention.

3. Add the data source to your FX rate source custom waterfall by applying the instructions in Customizing Price Waterfall to
the FX source field in your Pricing Source defaults.

Note:  Custom data sources are denoted by "CDE" in the source name.

Your FX rate waterfall is saved and your custom FX rates are referenced in your portfolio when using this view. After each
upload of FX rates to the custom data field, once you launch your portfolio in PORT, your portfolio positions recalculate using
the updated FX rates.

INTRADAY TAB

MULTIPLE PORTFOLIOS IN INTRADAY CHART

You can monitor multiple portfolios in the intraday monitor chart. This graphical feature can be used to supplement the
monitoring of multiple portfolios in the main part of the Intraday Main View sub-tab.

For a general introduction to the intraday monitor chart, see Intraday Monitor Chart.

To see a group of portfolios in the intraday monitor chart:

1. Click the Port drop-down menu and select your portfolio group.
The group of portfolios appears. "P" icons indicate each portfolio.
 

bbg://screens/HELP CDE
bbg://screens/HELP BBU
bbg://screens/LPHP CDE:0:1 813306
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bbg://screens/LPHP BBU:0:1 1014962
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Note:  If you have not created a portfolio group, you can do so using the Portfolio Groups Setup (PGPS) function. For
more information, see PGPS <Help>.

2. If the intraday monitor chart is not open, from the toolbar, select Settings > Show Intraday Chart.
The intraday monitor chart at the bottom of the screen tracks your portfolio performances throughout the day.
 

 

PERCENTAGE GROSS WEIGHT

In the Intraday Main View sub-tab, you can monitor % Gross Weight195  exposures, with weights displayed as positive
numbers. Along with this option, you can display an intraday heat map or similar chart to see short positions.

To monitor percentage gross weight exposures:

1. Right-click any column header and select Add/Remove Fields.
The Edit Template window appears.

2. In the Available Fields section, under the Position / Price category, click the add button (+) next to % Gross Weight.
 

195 The current gross exposure of the instrument or grouping divided by the total current gross exposure of the portfolio,
expressed as a percentage.

bbg://screens/HELP PGPS
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Your selection is shaded blue and appears in the Selected Fields section. You can adjust the column order by dragging

and dropping the selected columns, as well as assign the field to the benchmark (Bmrk196 ) and difference (+/-197 )
applications.

3. Click the Update button.
The % Gross Weight columns appear in your intraday monitoring table.
 

 

196 Indicates the benchmark against which you are comparing your portfolio, which can be an index, portfolio, or fund.
• In the Characteristics - Characteristics Summary sub-tab, the benchmark indicator value.
• In the View Manager, allows you to choose which fields appear in the benchmark column (for each tab).

197 The difference between the portfolio and the benchmark.
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4. To display the corresponding heat map, click the expander bar to see the chart options and map.
 

 

The heat map automatically displays short positions.

5. Analyze the heat map:

• To see descriptive information about each sector or position (including total return, contribution to return, P&L, number
of instruments, weight, and price), position your cursor over a section of the heat map.
 

 

• To analyze intraday short position data in a different chart format, choose an option from the Chart field:
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The chart updates based on your selection.

Note:  When you leave the Intraday tab and then return to it, the chart defaults to the heat map.

ATTRIBUTION CALCULATION ASSUMPTIONS

The Intraday tab supports the calculation of attribution effects for equity and fixed income portfolios. The Allocation Effect198

, Selection Effect199 , and Currency Effect200  values are calculated using the same approach utilized in the Attribution tab.
However, the time horizon is one day, using live market prices, relative to yesterday's close of market. As in the Attribution tab,
Interaction Effect201  is embedded within Selection Effect202 .

For complete information on the calculation assumptions for attribution effects, see Return Attribution.

Note:  For multiple levels of aggregation (e.g., Country by Sector), multi-level attribution logic is assumed. For more
information on nested attribution, see the Nested Attribution White Paper.

CHARACTERISTICS TAB

198 The active return attributed to asset allocation decisions (e.g., sectors, countries, or market caps) that differ from the
benchmark. The allocation is generally positive when the fund is overweight for a sector in which the benchmark return
exceeds the total benchmark return.

199 The active return attributed to security selection decisions that differ from the benchmark. When the portfolio sector
returns exceed the benchmark return, a positive number is posted.

200 The active return due to currency exposures that differ from the benchmark.
201 The interaction between the weighting and the selection effects, which does not represent an explicit decision of the

investment manager.
202 The active return attributed to security selection decisions that differ from the benchmark. When the portfolio sector

returns exceed the benchmark return, a positive number is posted.

bbg://screens/BPS L#2278751
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ADDITIONAL FIELDS (CHARACTERISTICS)

In the Characteristics Main View sub-tab, you can choose many other fields from Bloomberg's vast fundamental database or
select custom fields you upload and maintain in the Custom Data Editor (CDE) function.

Additionally, in the Characteristics tab (as well as the Holdings tab), you can add a field (# of Instruments203 ) that displays a
count of the number of instruments in the portfolio and benchmark. You can use this field as a quick check to ensure that all of
your holdings are properly uploaded in the portfolio and represented in PORT.

To add additional fields in the Characteristics Main View tab:

1. Right-click any of the column headers and choose Add/Remove Fields.
 

 

The Edit Template window appears with all available fields on the left in the Available Fields section and all currently
selected fields on the right in the Selected Fields section.

2. Click the More (Asset Class) Fields button.
 

203 In the Characteristics and Holdings tabs, displays a count of the number of instruments in the portfolio and benchmark.
You can use this field as a quick check to ensure that all of your holdings are properly uploaded in the portfolio and
represented in PORT.
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The Select Field window appears.

3. Select the field you want to add:

• To search for a field, enter a search term in the text field, then select an option from the menu that appears.
• To browse the available fields, click the Fields button. In the Browse Fields window that appears, find the field you

want to use, then click the Select button.
The field name appears in the Select Field window. Depending on your selection, the date drop-down menu, Growth
button, Revision button, and/or Info button appear.

4. Customize the field or find more information:

• From the drop-down menu to the right of the selected field, select a time period (e.g., Latest Filing, Latest Calendar
Year) for the field calculation.

• Click the Growth button to access the Criteria Wizard window, where you can add specific equity screening growth
criteria.

Note:  The Criteria Wizard is also available in the Equity Screening (EQS) function. For more information on setting up
growth analysis through the EQS Criteria Wizard, click here.

• Click the Revision button to access the Configure Estimates Revision Consensus window, where you can customize
the fiscal period and analysis type for fields that display revised data.

• Click the Info button to access the Browse Fields window, where you can find more information on the selected field.

5. Click the Select button.
The field is added to the Selected Fields list in the Edit Template window.

6. Modify the field by following the instructions in Adding/Removing Fields.
 

bbg://screens/LPHP EQS:0:1 1469297
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7. Click the Update button.
The Characteristics Main View appears and reflects your field (column) changes.

CUSTOM TARGET PRICES

You can upload or enter custom target prices for your positions using the Custom Data Editor (CDE) function, so you can
monitor when the price of an instrument you hold approaches the target price at which you want to sell.

To set up your custom target price analysis:

1. In CDE, create a custom data field using the content type Target Price and enter or upload the securities, your custom
target prices, and as of dates.

For complete instructions on creating a custom data field in CDE, click here .

Note:  You can associate the CDE Target Price field with any of your CDE data sources.

2. In PORT, select the Characteristics tab, then right-click a column header and select Add/Remove Fields.
 

bbg://screens/LPHP CDE:0:1 813306
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The Edit Template window appears.

3.
From the Available Fields list, search for the custom data field you created in CDE, then click the add ( ) icon to add it
to your Selected Fields.

4. Next to the custom target price field, click the pencil icon.
 

 

The field customization window appears.

5. From the Target Price Display Type field, select how you want the custom data to appear:
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• Price: Displays the custom target price you entered in CDE.
• Difference: Displays the difference between the custom target price and the most recent closing price (Target Price -

Close Price). The value displayed can be positive or negative.
• Percentage Difference: Displays the percentage difference between your custom target price and the most recent

closing price [(Target Price - Close Price) / Close Price]. The percentage displayed can be positive or negative.

6. To use a different display name for the field in the portfolio, enter a Custom Name204  for the field (e.g., Target Upside Diff
for a field using the Difference display type).
|Hint| It is recommended that you assign a custom display name for the field, which allows you to add and differentiate

multiple instances of the same custom target price column representing different Target Price Display Type205  options.
 

204 Allows you to override the name of a column that appears in your portfolio.
205 Allows you to select how you want the target price data for your custom field to appear. If you select Price, the field

displays the target price you entered in or uploaded to the custom data field. If you select Difference, the field displays
the difference between your custom target price and the most recent closing price for the instrument, i.e., custom target
price - last close. If you select Percentage Difference, the field displays the percentage difference between your custom
target price and the most recent closing price.
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7. If you want to customize the field further, update the other options.
For descriptions of the fields that appear, see Definitions.

8. Click the Update button.
The Edit Template window appears. If you modified the field's custom name, the field name updates in the Selected Fields
list.

9. Click the Update button.
The fields appear in the Characteristics tab.

ADDING FIELD VARIATIONS

In the Characteristics tab, you can add multiple versions of the same field, so you can apply different aggregation methods for
side-by-side comparison. You can also rename the duplicate field.

To add multiple versions of a field:

1. Add a new field by right-clicking a column header and selecting Add/Remove fields.
 

 
The Edit Template window appears.

2. From the Available Fields column, select the field you want to duplicate, then click the pencil (editing) icon.
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A window where you can edit the field's parameters appears.

Note:  To learn more about options for adding fields, see Adding/Removing Fields.

3. Update the Display (Decimal and Custom Name) and aggregation calculation options, then click Update.
 

 

The duplicate field appears in the Add/Remove Fields window.

4. Click the Update button.
The duplicate field appears in the tab. If you changed the name of the field, you can position your mouse over the column
header to display the original field name in a tooltip.

CALCULATIONS AND OUTLIER HANDLING

The Characteristics tab provides multiple options for calculating the field and handling outliers. These options are accessed by
clicking the pencil (editing) icon when adding or removing fields to the tab.



>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //226

 

 
|Hint| For information on adding/removing field options, see Adding Field Variations.
 

 
• Aggregation Methodology: Select the methodology you want to use to aggregate values for the field calculation. Your

selection in this field determines the options in the Aggregation Weights field.
• Override N/A Values: Specify a value to use in place of N/A. By enabling this option and specifying a replacement value,

all instruments which were previously dropped from the aggregate will now be included with that value. This is available for

all aggregation methods except Index Method206 .
• Set Outlier Minimum: Set a minimum value for an instrument to be included in the calculation of the portfolio aggregate.

If this is checked, instruments whose values are less than the specified minimum can either be removed from the aggregate
or replaced with the minimum value.

206 As an aggregation method, Index Method is available only for certain equity fields, such as price ratios and growth ratios.
With the Index Method, calculation of the aggregate Price to Earnings ratio includes companies with negative earnings.
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• Set Outlier Maximum: Set a maximum value for an instrument to be included in the calculation of the portfolio aggregate.
If this is checked, instruments whose values are greater than the specified maximum can either be removed from the
aggregate or replaced with the maximum value.

• Aggregation Weights: When choosing Weighted Average or Weighted Harmonic Average for the Aggregation
Methodology of an equity field, set the Aggregation Weights to either Gross or Net:

— Gross: PORT first takes the absolute value of the security weights and then perform the aggregation.
— Net: Short positions should be aggregated using their associated negative weight. It is recommended that Override N/A

Values is set to zero when net aggregation is used. In this way, cash weights are included in the calculation so that net
weights sum to 100%. Otherwise cash is excluded for many fundamentals aggregations (because cash does not have
a defined value) causing the portfolio to be re-weighted to 100% without cash, and possibly producing non-intuitive
results.

Note:  Fixed income characteristics are always aggregated using net weights.

TRACKING ERROR TAB

RISK TRANSPARENCY SCREEN

The Risk Transparency screen provides full transparency into the calculation of style factor exposures for fundamental
equity risk models. Each factor exposure is calculated as the weighted average of one or more factor descriptors, which are
calculated using company fundamentals.

The Risk Transparency screen appears when you click any cell in the Tracking Error - Exposures sub-tab. For more information
on analyzing exposures, see Analyzing Exposures.

Note:  Factor exposure transparency is available for up to three months.

The screen is organized into a control area, a list of descriptors, information on the descriptor components, and a related
historical chart.
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• Control Area: Allows you to specify the model, calculation date, style factor, and security for the risk transparency
analysis, and export the exposure data to Microsoft® Excel.

• Descriptors: Displays data on the individual descriptors used to calculate the total factor exposure. Each factor has one or
more descriptors. For each descriptor, the BLOOMBERG PROFESSIONAL® service calculates the original value, as well
as the average and standard deviation of all values in the universe.

• Components: Provides the raw data and calculation formulae for each component that comprises the selected descriptor.
• Historical Chart: Provides a bar chart of the selected descriptor or specific component over time. Your selections in the

descriptors and components sections determine the data illustrated in the chart.

For information on analyzing risk exposures in the Risk Transparency screen, see Analyzing Risk Transparency.

ANALYZING RISK TRANSPARENCY

You can evaluate the risk transparency of a specific security by analyzing its factor components in table or chart format. You
can update the factor, factor model, and calculation date to further analyze the security's risk exposures.

Note:  These instructions assume you are in the Risk Transparency screen, accessible from the Tracking Error-Exposures
sub-tab in PORT. For information on the Exposures sub-tab, see Analyzing Exposures.

To evaluate a security's risk exposures:

1. From the Factor drop-down menu, choose the factor you want to evaluate (e.g., US Growth).
 

 

The descriptors, components, and historical chart sections update based on your selection.

2. From the descriptors table, select an action:

• To analyze the raw data and formula for a specific component, click the component name (e.g., EG {Earnings Growth}).
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The components and chart sections update to reflect your selection.
• To display the iterations involved in calculating a factor exposure or component, click the corresponding notes icon next

to the Standardized column.
 

 

The Iterations for {Factor or Descriptor} window appears.
• To display more precision (i.e., more decimal places) for all values, from the control area, select Extra Precision.

 

 

• To display additional fundamental analysis (e.g., the origin of the values used in calculations) for any component, from
the components section, click the corresponding notes icon.
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The Risk Transparency screen updates based on your selections.

EX-ANTE RISK

WHAT IS RISK?

Using a basic understanding of risk, we can calculate historical risk for a given portfolio. Historical portfolio risk is sometimes
referred to as "ex-post" risk.

Risk management, however, deals with forward-looking risk. Forward-looking risk refers to risks that a given portfolio might
be facing going forward. Such risk is referred to as "ex-ante" risk. Over the last 50 years, a vast body of academic and
industry research was produced that covered the issue of forward-looking risk modeling. Therefore, this problem is now well
understood.

To estimate portfolio risk, we need to be able to estimate risks of securities that make up a given portfolio and then be able to
aggregate individual security risks to the portfolio level.

Risk is expressed as the standard deviation of portfolio returns and is used as a gauge for the portfolio's expected volatility. The
following terms explain risk measurements in PORT:

Measurement Description

Isolated Risk (Std) The standard deviation of the distribution of returns, expressed as either a percentage return
or portfolio profit and loss (P&L). This measure represents portfolio risk (expressed as the
standard deviation of portfolio returns) or active risk (expressed as the standard deviation of
portfolio active returns).

Active Return The difference between portfolio return and benchmark return. If you are using the geometric
method, then active return = 100 * [(1 + portfolio return / 100) / (1 + benchmark return / 100)
- 1].
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Measurement Description

Contribution to Risk The fraction of risk that a particular factor or factor group contributes to total risk.
Contribution to Risk (%)207  is expressed in percentage points so Total Risk208  sums up to
100%.

Total Risk209  is broken down into factor and residual groups. Factor groups are model-specific. For information on interpreting
risk outputs, see Documents and Definitions.

RISK MODEL UPDATES

Equity risk models are updated on a weekly basis. For information on equity risk models, see Equity Risk.

Fixed income risk models are updated on a monthly basis. For information on fixed income risk models, see Fixed Income Risk.

FACTOR TRANSPARENCY

You can see the correlation and variance/co-variance matrix of risk factors from the Tracking Error and VaR tabs, so you can
validate risk numbers and understand the sources of risk results.

The Factor Transparency screen appears when you select a factor in the VaR-Factor Breakdown sub-tab or the Tracking Error
> Factors sub-tab. For more information on analyzing factors in these sub-tabs, see VaR Factor Breakdown and Analyzing
Factor Groups.
 

207 Used to determine a fraction of risk that a particular factor/factor group contributes to total risk. Contribution to Risk (%)
is expressed in percentage points so that Total Risk sums up to 100%.

208 Total risk is broken down into the Factor and non-factor groups. Factor groups are model-specific.
209 Total risk is broken down into the Factor and non-factor groups. Factor groups are model-specific.
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• Control Area: Allows you to select the factors you want to analyze, update the date of the values displayed in the
transparency data section, and export the factor analysis to Microsoft® Excel.

• Transparency Data: Displays the %Contrib210 , Factor Vol211 , and Return (x100)212  for each factor, and the Correlation

Matrix213  or VCV Matrix214 , which compares the displayed factors. The date and display options in the control area
determine the data displayed in the matrix.

• Transparency Chart: Displays a chart illustrating the return of the selected factor or a historical time series representing
the correlation or variance/co-variance of two factors. The value selected in the transparency data section determines the
data that appears on the chart.

For more information on analyzing factors in the Factor Transparency screen, see Analyzing Factor Transparency.

ANALYZING FACTOR TRANSPARENCY

You can see the correlation and variance/co-variance matrix of risk factors from the VaR and Tracking Error tabs, so you can
validate risk numbers and understand the sources of risk results.

To analyze factor transparency:

1. From the VaR-Factor Breakdown or Tracking Error > Factors sub-tab, click the factor you want to analyze.
The Factor Transparency screen appears in another window. The selected factor appears in the first row, and the top
nine factors with the highest contribution to factor risk appear in the subsequent rows. For a description of the Factor
Transparency screen, see Factor Transparency.

2. From the control area, update the factor transparency settings, then press <Go>:

 

 

• Display: Select whether the correlation matrix215  or VCV matrix216  (variance/co-variance) appears.

210 In the Factor Transparency screen, the percentage of the overall portfolio riskiness contributed by the factor for the
selected Relative to Matrix as of date.

211 In the Factor Transparency screen, the daily factor volatility for the selected Relative to Matrix as of date.
212 In the Factor Transparency screen, the latest return for the factor for the selected Relative to Matrix as of date. The return

frequency is daily for VaR and weekly for tracking error.
213 In the Factor Transparency screen, displays a matrix of correlation between related factors from the specified Relative to

Matrix as of date.
214 In the Factor Transparency screen, displays a matrix of variance/co-variance values between related factors from the

specified Relative to Matrix as of date.
215 In the Factor Transparency screen, displays a matrix of correlation between related factors from the specified Relative to

Matrix as of date.
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• Relative to Matrix as of: Select the date for which the transparency data appears.
The transparency data section updates based on your selections.

Note:  The transparency chart does not rely on these settings.

3. If you want to select a different set of factors, from the toolbar, click the Select Factors button. From the Select Factors
window that appears, click the add button next to the factors you want to see, then click the Update button.

Note:  You can select up to 20 factors for simultaneous analysis.

 

 

The factor list updates.

4. If you want to evaluate a specific factor's return over time or see the historical movement of correlation or covariance

between factors, click a value in the Factor Vol217 , Return (x100)218 , Correlation Matrix219 , or VCV Matrix220  column.
The transparency chart updates to reflect the selected cell.

5. If you want to modify the chart, select a different chart type or timeframe:

• For factor vol221  values, you can evaluate a time series of data going back two months, with a default timeframe222  of
45 days.

• For return (x100)223  values, you can choose to see the data as a Time Series224  chart, Cumulative225  chart, or a
Histogram226 , and update the timeframe227  to a relevant historical period.

216 In the Factor Transparency screen, displays a matrix of variance/co-variance values between related factors from the
specified Relative to Matrix as of date.

217 In the Factor Transparency screen, the daily factor volatility for the selected Relative to Matrix as of date.
218 In the Factor Transparency screen, the latest return for the factor for the selected Relative to Matrix as of date. The return

frequency is daily for VaR and weekly for tracking error.
219 In the Factor Transparency screen, displays a matrix of correlation between related factors from the specified Relative to

Matrix as of date.
220 In the Factor Transparency screen, displays a matrix of variance/co-variance values between related factors from the

specified Relative to Matrix as of date.
221 In the Factor Transparency screen, the daily factor volatility for the selected Relative to Matrix as of date.
222 In the Factor Transparency screen, allows you to select the date range illustrated in the transparency chart.
223 In the Factor Transparency screen, the latest return for the factor for the selected Relative to Matrix as of date. The return

frequency is daily for VaR and weekly for tracking error.
224 In the Factor Transparency screen, displays a bar chart illustrating the weekly positive and negative returns attributed to

the selected factor over the specified timeframe.
225 In the Factor Transparency screen, displays a line chart representing the total cumulative return of the selected factor

over the specified timeframe.
226 In the Factor Transparency screen, displays a histogram illustrating returns attributed to the selected factor over the

specified timeframe.
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• For correlations or variance/co-variance values, you can evaluate a time series of data going back two months, with a
default timeframe228  of 45 days.

The chart updates based on your selections.
6. If you want to export the data that appears to a Microsoft® Excel spreadsheet, from the toolbar, click the Export to Excel

button.
 

 
A new spreadsheet appears with the data.

Note:  Each data point on the displayed chart appears in the spreadsheet.

ATTRIBUTION TAB

TRANSACTIONS-BASED METHOD

When incorporating transactions into the return, Bloomberg assumes inflows beginning of day and outflows end of day
(IBOE). In other words, for weighting the impact of trades, Bloomberg includes all inflows (buy long and short sales) at
the start of the day and all outflows (sell long, buy to cover) at the end of the day. To calculate the P&L for a purchase
today, Bloomberg compares the total cost of the purchase (total number shares purchased times the purchase price) to the
close-of-day market value (total number shares purchased times the close of day price).

For example, consider the following trade:

• Inflow (Purchase): Twitter

• Trade Price on 11/07/2013: $26 (IPO price)
• Shares: 5,000

• Total Cost: $130,000

• Close-of-date Price on 11/07/2013: 44.90

• Close-of-day Value: $224,500

• Profit/Loss: $94,500

• 1-Day Return: 72.69%

Since this is an inflow, this trade is included for the entire day's performance from the beginning of 11/07/2013, so the
beginning-of-period weight assigned to this trade is the total cost value of the Twitter position ($130,000). Since this is the
only holding in this example, Twitter's beginning-of-period weight is 100%. Had there been other holdings in the portfolio,
Twitter's portfolio weight would be $130,000 divided by the entire market value of all the holdings (including Twitter) as of the
beginning of 11/07/2013.
 

227 In the Factor Transparency screen, allows you to select the date range illustrated in the transparency chart.
228 In the Factor Transparency screen, allows you to select the date range illustrated in the transparency chart.
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Note:  This example assumes that the portfolio held $130,000 cash in the portfolio the prior day (11/06/2013) in order to pay
for the purchase of Twitter on 11/07/2013. If the portfolio had no initial cash, for return calculation purposes, the portfolio is
assumed to have gone short $130,000 cash to fund the 5,000 shares of Twitter stock at $26 per share.

Now, assume that on 11/08/2013, you decide to sell the Twitter shares. The following trade details now apply:
• Outflow (Sale): Twitter
• Trade Price on 11/08/2013: $43
• Shares: 5,000
• Total Proceeds: $215,000
• Close-of-date Price on 11/07/2013: 44.90
• Close-of-day Value: $224,500
• Profit/Loss relative to prior close: $9,500
• 1-Day Return: -4.23%

The 1-day total return was -4.23% because the shares were sold at $43 per share, below the prior day's closing price of
$44.90. However, the transaction return was positive 3.01%, because if the Twitter shares were held until the end of 11/08/13
when Twitter closed at 41.65 per share, the 1-day return would have been -7.24%. By selling the shares at $43 per share
prior to market close on 11/08/13, you mitigated the 1-day loss by 3.01%.

The illustration below highlights the transaction return and total return for this trade in PORT.
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UPLOADING TRANSACTIONS

Transactions-based attribution in PORT requires that you upload two files: your daily close-of-day holdings file, which includes
corporate action and trade-adjusted trade-date positions, including trade-date cash; and a file including trades only. There are
separate file formats for both. If you are already uploading daily holdings, you only need to integrate the transaction file; you do
not need to re-upload your historical holdings. Transactions must be uploaded via the Bloomberg Uploader (BBU) function and
can be automated.

Note:  Bloomberg does not adjust each day's positions based on the prior day's holdings and trades/corporate actions.
Therefore, it is important that the daily holdings submitted from accounting systems are adjusted for any corporate actions and
trades.

|Hint| AIM Analytics subscribers have the option of having their daily holdings calculated based on trades and Bloomberg's
corporate action database. For more information on AIM Analytics, contact your account representative.

For instructions on uploading a transactions file via BBU, click here .

ENABLING TBA

Once the trades have been uploaded to a portfolio using BBU, you can enable transactions-based attribution for your portfolio
within PORT.

For instructions on uploading transactions to your portfolio using BBU, click here .

To enable transactions-based attribution in PORT:

1. From the toolbar, select View > Edit Current View.
The View Manager appears.

2. From the sidebar, select Calculation Settings > Attribution.
The Attribution settings appear.

3. From the Performance Calc field, select Transactions-based.
 

 

4. From the toolbar, click the Save button.
The view is saved.

Note:  You can interactively enable/disable transactions from the total return calculation in PORT. This feature is useful
because if the transaction data has not been integrated properly, you can easily revert back to the holdings-based
performance calculation.

bbg://screens/LPHP BBU:0:1 1946619
bbg://screens/LPHP BBU:0:1 1946619
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USING TRANSACTIONS

You can observe and evaluate transactions-based returns in the Attribution and Performance tabs.
• From the Attribution tab, you can right-click a portfolio or individual security and select Explain Return Calculation.

The Performance Data Dashboard appears in a separate window, where you can drill down into an individual day's
performance to access the underlying trade information used in calculating the return on that day. You can use this as a
diagnostic tool to validate transaction returns.

For example, as illustrated in Transactions-Based Method, you can see that the return on 11/08/2013 was -4.23% and
5,000 Twitter shares were sold for total sales proceeds of $215,000.

• From the Performance tab, you can analyze total return incorporating transactions over multiple time periods
simultaneously.

PORTFOLIO OPTIMIZATION

BACKTESTING OPTIMIZATION

You can enable backtesting for a portfolio optimization, which allows you to specify parameters to see how a particular portfolio
construction strategy performed historically. Backtesting utilizes portfolio maintenance functionality to automatically adjust
portfolio positions for corporate actions on the backtest portfolio. The following portfolio maintenance rules apply:
• Cash dividends are reinvested
• Cash is adjusted for coupon payments
• Options in money are exercised on expiration day

For more information on maintaining portfolios in the Creating & Updating Portfolios (PRTU) function, click here .

The Backtest tab provides feedback and transparency into the backtesting process, allowing you to more quickly evaluate the
results of your backtest. As the backtesting progresses, you can see a chart updating on this tab with the analytic results of the
backtest. You can click the points on the chart to see the trades suggested by the Optimizer for that date.

To enable backtesting:
1. In the Portfolio Optimizer, update any optimization parameters, such as the goals, trade universes, etc., you want to use for

the backtest.

For more information on these options, see the overview information and specific steps in Portfolio Optimization.
2. At the top right, click the Backtest button.

 

 
The Backtest Settings window appears.

3. Choose the backtesting parameters you want to use:

bbg://screens/LPHP PRTU:0:1 2552346
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• Enable Backtest: Select to activate backtesting within the Portfolio Optimizer.
• Rebalance Frequency: Select how often the backtest is calculated.
• Date Range: Choose the timeframe for the backtest calculation:

— In the Start From and End At fields, select the date range for the backtest calculation.
— Select Enter Exact Date Range, then in the Start Date and End Date fields, select the specific date range of the

backtest calculation by clicking the calendar icon or entering dates in the fields.
• Liquidate Non-Universe Securities: Specify that all portfolio positions not specified in the Trade Universe section,

which determines the securities included in the optimization, are liquidated when the backtest is run.
• Create New Portfolio: If you want to create a new portfolio from the backtest, enter the unique name of the

new portfolio or use the automatically generated name (e.g., the name of the original portfolio appended with
"_BACKTEST").

• Output Name: If you want to update an existing portfolio from the backtest, select the portfolio name.
4. Click the Run button.

You are automatically directed to the Backtest tab, where a chart begins monitoring the analytic results as the backtest
progresses. You can click points on the chart to see the trades suggested by the Optimizer for that date.

A MSG with a link to the portfolio is sent to you when the optimization is complete.

Note:  The amount of time required for the backtest calculation varies.

ADDING A FRONTIER

Adding a frontier allows you to generate a set of optimal portfolios based on a range of values for a given constraint. The plot of
goal versus constraint range values for these portfolios is called the efficient frontier.

For example, you can minimize portfolio active total risk while allowing maximum portfolio turnover to vary from 10% to 20%.
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To add a frontier:

1. In the Setup tab, click the Add Frontier button.
 

 

Note:  This option cannot be used when the Backtest Enabled field (in the upper-right corner) is selected.

The Add Constraint window appears.

2. From the Select Field column, choose the Constraint Field229  you want as your frontier. You can select any field option to
see a definition in the Description column.

Note:  You can only select one frontier.

Constraint level options appear at the bottom of the window. Depending on your selection, the fields and the
corresponding options vary.

3. Define frontier parameters by updating constraint fields.
 

 

229 In the Setup tab of the Portfolio Optimization screen, specifies which fields should be constrained by the optimizer to
generate your optimal portfolio.
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Note:  Scenarios that are available on the Scenarios tab can be added as constraints. They are located under Scenario
(P&L %). Multiple scenarios can be added as constraints.

4. Click the Add Constraint button.
The constraints appear in the Constraints section and the Add Frontier button is greyed out.

5. From the toolbar, click the Run button.
 

 

The Frontier tab opens and displays results for the efficient frontier. For an overview of the tab, see Optimization Frontier.

LIMITING AMOUNT OF TRADES

In the Security Properties section of the Portfolio Optimization screen, you can limit the amount of trading to a fixed
percentage of average daily volume (ADV). You can also incorporate Bloomberg-provided round lot values into your
optimization.

To constrain your trades to a fixed percentage of ADV:

1. Click the pencil icon on the right side of the section.
 

 

The Security Constraint Editor window appears.

2. Click the Fields button in the Max Trade row.
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The Select Field to Link window appears with a list of suggested ADV fields.

3. Select the appropriate ADV measure, then click the Select button.
The Max Trade field displays your selection.

4. Set the Multiplier value for Max Trade to the desired value.
For example, if you want to limit trading to 10% of the ADV, set the multiplier to 0.1.

5. If you want to use the Bloomberg-provided round lot value, click the Fields button in the Lot Size row, choose Round Lot
Size from the list of suggested fields, then click Select.
 

 

The Lot Size field reflects your selection.

6. Click the Save button.

The Max Trade field in the Security Properties section displays your settings. Continue optimizing your portfolio as needed.
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For more information on optimizing your portfolio, including detailed discussions of each section of the Portfolio
Optimization screen, see Portfolio Optimization and Portfolio Optimization .

TROUBLESHOOTING

The Trades tab in the Portfolio Optimization screen displays the results of your portfolio optimization settings and lets you
export trade data. You can also troubleshoot issues with the optimization.

In the top-left corner of the screen, the Status field indicates whether the portfolio optimization has succeeded (Success) or
failed. If "Failed" or "Infeasible" appears, you can troubleshoot problems with the optimization.

To see the error(s) and recommended actions, click the Details button. The Invalid Initial Portfolio window appears and
displays errors and recommended instructions (if available).
 

 

EXPORTING TRADES

After running a portfolio optimization task, you can download the trade list to a Microsoft Excel® spreadsheet from the Trades
tab in the Portfolio Optimization screen.

In the Result tab, click the Export Trades button.
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A spreadsheet appears with a list of trades.

PREDEFINED TASKS

In the Portfolio Optimization screen, you can use pre-defined tasks, which are created by Bloomberg and available for quick
reuse. The tasks are based on simple optimization rules, such as targeting a certain portfolio duration or increasing portfolio
dividend yield, thereby allowing you to quickly simulate trades in a given scenario.

To use a pre-defined task:

1. In the Setup tab, from the toolbar, select Tasks > Load Task.
 

 
The Load Task window appears.

Note:  If you were previously updating a task, the Load Task window appears warning that loading the task will override
changes made to the current task.

2. From the Category column, select the category of tasks you want to browse, e.g., Equity Tasks.
 

 

Note:  If you select My Tasks, a list of your saved optimization tasks appears.

The available tasks appear in the Tasks column.
3. Select the task you want to run, then click the Select button.

For more information on the optimization parameters available in the Portfolio Optimizer, see Optimization Goals, Optimization
Universe, Optimization Constraints, and Security Properties.
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TASK DEFAULTS

In the Portfolio Optimization screen, you can set tasks as defaults so you do not need to recreate/load them each time you
want to optimize your portfolio with certain conditions.

To set a task as your default:

1. Set up your task, as outlined in Setting Up Tasks.

2. From the toolbar, select Tasks > Load Task.
The Load Task window appears.

3. Select the task you want to set as your default, then click the Make This Task Default button.
 

 

The task is saved as your default and appears each time you access the Portfolio Optimization screen.

An asterisk (*) indicates your default task in the Load Task window.

SAVING TASKS

In the Portfolio Optimization screen, you can edit and save optimization tasks.

From the toolbar, select Tasks > Save Task or Save Task As.
• Save Task: Overrides any changes you have made for that task.
• Save Task As: Allows you to assign a new task name, thereby creating a new task from which to choose. In the Save

Task As window, enter the name of the task, then click the Save button.
The task is saved.

SHARING TASKS

In the Portfolio Optimization screen, you can share saved optimization tasks with other BLOOMBERG PROFESSIONAL®

service users.

1. From the toolbar, select Tasks > Share Task.
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The Task Sharing window appears.

2. Enter the user(s) with whom you want to share the task:

• To share the task with an individual user, enter the user's speed dial name in the Enter SPDL Group/User field, then
choose the permission level for the user.

• To share the task with a speed dial list, enter the list name in the Enter SPDL Group/User field, then choose the
permission level for each user in the group. Depending on the information you enter, the Searching for: (Name) screen
may appear from which you can select the SPDL ID.

Note:  For more information on setting up and accessing speed dial contacts, see SPDL <Help>.
3. Click the Update button.

The user or speed dial group can now access the task in the Portfolio Optimization screen.

DELETING TASKS

In the Portfolio Optimization screen, you can remove saved optimization tasks.
1. With the task that you want to delete loaded, from the toolbar, select Tasks > Delete Task.

The Delete Task window appears.
2. Click the Confirm button.

The task is removed from your saved list (My Tasks).

Note:  You cannot delete a predefined, Bloomberg task.

EXAMPLE: MAXIMIZE EXPECTED RETURNS

A common way of using the Portfolio Optimizer is to maximize your expected returns for the portfolio, while respecting an upper
bound on your portfolio tracking error (i.e., Active Total Risk). A variation on this simulation is to maximize expected return while
simultaneously minimizing portfolio risk.

This topic provides an example of using the Portfolio Optimizer to maximize expected returns and limit Active Total Risk.

To optimize the portfolio with your expected returns:

1. In PORT, select the portfolio and benchmark you want to use for the optimization, then from the toolbar, select Trade
Simulation > Launch Optimizer.

For more information on setting up your PORT analysis, see Getting Started.
The Portfolio Optimization screen appears.

2. Add a goal to maximize the expected return:

bbg://screens/HELP SPDL
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a) Click the Add Goal button.
b) From the Select Field column in the Add Goal Term window that appears, select Security Level Data > Expected

Return (User-defined).
c) Click the Select button
The Expected Return (User-defined) goal appears in the Goals section and the Exp. Return (%) column appears in the
Security Properties section.

3. Populate the Exp. Return (%) column by dragging and dropping expected return values from Microsoft® Excel:

a) To generate the Excel template, in the Security Properties section, click the Export button.
b) Once the file is open in Excel, populate column A ("Security") with security identifiers and column G ("Exp. Return (%)")

with expected returns.
c) Select the values in columns A through G, then position your mouse over the border of the selection until a pointer with

a four-way arrow appears. Drag and drop the selection into the Security Properties table in the Optimizer.
The user-defined expected returns are populated in the optimization.

4. Add a constraint on the active total risk of the portfolio:

a) Click the Add Constraint button.
b) From the Select Field column in the Add Constraint window that appears, select Risk > Risk (Ex Ante) > Active

Total Risk.
c) Click the Add Constraint button.
The Active Total Risk constraint appears in the Constraints section.

5. In the Max field corresponding to the Active Total Risk constraint, enter the upper bound for your active total risk.
6. From the toolbar, click Run.

 

 

The optimization begins and the Trades tab appears. You can analyze the optimizer progress and results in the Trades tab,
from which you can launch PORT to further analyze the optimal portfolios. For information on analyzing in PORT, see
Analyzing in PORT.
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SCENARIO MANAGER

FACTOR MODEL SHIFTS

Factor model methodology is available when creating scenarios that either shock variables individually in an explicit scenario, or
stress the entire universe of variables at once using a historical or propagated scenario.

You can create factor model scenarios in the Scenario Manager. For more information on using the Scenario Manager screen
to create factor model scenarios, see Factor Model Scenarios.

The types of shifts available for a factor model scenario include:

Shift Description

Macro Factors Allows you to shift macroeconomic variables such as commodities (gold and oil), indices
(equity and rates), and volatility.

IR (Interest Rates) Allows you to indicate a parallel, non-parallel, or custom shift in the swap curve or treasury
curve.

FX Allows you to shift foreign exchange rates between arbitrary currencies and USD.

Model Factors Allows you to shift equity risk model factors from all factor models available via the
BLOOMBERG PROFESSIONAL® service.

FULL VALUATION SHIFTS

Full valuation methodology is available when creating scenarios for shifting and analyzing your portfolio.

You can create full valuation scenarios in the Scenario Manager. For more information on using the Scenario Manager screen
to create full valuation scenarios, see Full Valuation Scenarios.

The types of shifts available for a full valuation scenario include:

Shift Description

IR (Interest Rates) Allows you to indicate a parallel, non-parallel, or custom shift in the swap curve or treasury
curve, or on the implied volatility.
• Swap Curve Shift: Allows you to shift currencies and curves or change the shape of the

swap or treasury curve. This shift impacts OTC derivatives, listed derivatives (including
interest rate futures, bond futures, and options on interest rate and bond futures), treasury
and corporate bonds, convertibles, inflation-linked bonds, fixed income structured notes,
and loans.

• Treasury Curve Shift: Allows you to shift government/treasury bonds where sovereign
curves are used in valuations.

• IR Vol Shift: Allows you to perform a parallel shift on the implied volatility calculated for
listed and OTC options.
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Shift Description

Credit Allows you to shift CDS curves and option adjusted spreads. CDS curve shifts impact
convertible bonds and OTC deals, which are saved in the Credit Default Swap Valuation
(CDSW) function. For more information on CDSW, see CDSW <Help>.
• CDS/OAS Shift: Allows you to shift CDS curves or option adjusted spread based on a

sector or a specific reference name. You can apply shifts to CDS curves and the option

adjusted spread (OAS)230  of corresponding bonds by simply selecting the OAS option in
the CDS Curve Shift section of the Credit tab.

• Bond Recovery Rate Shift: Provides the ability to explore the impact of recovery rate
changes on credit default swap and convertible bond valuation, and on bond valuation in
general if your pricing preferences are set to use the CDS curve. You can specify explicit
recovery rate shifts for CDS contracts based on the reference entity, currency, and debt
type.

Equity Allows you to perform shifts on underlying price, volatility, and dividend yield for equity
instruments.
• Equity Price Shift: Allows you to aggregate equities by country, sector, and with or

without Beta propagation, or to shift equities specifically based on the ticker, index ticker,
or index future.

• Equity Vol Shift: Allows you to shift implied volatility for listed and OTC options, or the
entire volatility surface of a specific equity or index ticker.

• Dividend Yield Shift: Allows you to shift dividends by country and sector, or by ticker.
Dividend yields can be explicitly provided or can be shifted by absolute or a percentage.

Commodity Allows you to shift the underlying future price and implied volatility for commodities.
• Commodity Future Curve Shift: Allows you to shift underlying future prices by category

(e.g., Agriculture or Livestock) or generic active futures contract, which propagates to all
applicable futures contracts (e.g., BOA Comdty impacts all futures listed in BOA Comdty
CT <Go>).

• Commodity Vol Shift: Allows you to perform a parallel shift on the implied volatility for
listed and OTC options that can be valued by the Option Valuation (OVML) function. For
more information on this function, see OVML <Help>.

Inflation Allows you to shift the inflation swap curve rates available in the Inflation Bond/Swap Settings
(SWIL) function. For more information on this function, see SWIL <Help>.
• Inflation Curve Shift: Allows you to shift either the zero-coupon inflation curve or the

year-on-year inflation curve, depending on the product.
• Inflation Vol Shift: Allows you to perform a parallel shift on the implied volatility for

inflation linked options that can be valued by the Swap Manager (SWPM) function. For
more information on this function, see SWPM <Help>.

230 The option adjusted spread. The flat spread that must be added to the yield curve in a pricing model to discount a
security payment to match its market price.

bbg://screens/HELP CDSW
bbg://screens/HELP OVML
bbg://screens/HELP SWIL
bbg://screens/HELP SWPM
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Shift Description

FX Allows you to shift foreign exchange spot rates and volatilities.
• FX Rate Shift: Allows you to enter absolute shifts, percentage shifts, or override values

for foreign exchange rates. You can use one of the following modes:

— Home Currency Mode: FX spot rate shifts are calculated as a percentage change
against one base currency. This mode allows for cross rate shifts based on two
predefined currency pairs. For example, if the home currency is USD and two currency
pair shifts defined for a scenario are USDBRL and EURUSD, then the scenario can
generate a shift value for EURBRL from those two pre-defined shifts.

Note:  In cases where the quotation format of the FX deals found in a portfolio differ
from the format defined in the Scenario Manager configuration, the opposite shift
applies. Following the example above, when USD is strengthening, an FX spot deal of
EURUSD results in a shift where EUR is weakening.

— Currency Pair Mode: FX spot rate shifts are calculated based on the currency pair
format defined in the shift, ignoring any concept of base (or home) currency. In this
mode, no cross rate shifts are performed, meaning that if a specific currency pair is not
defined within the scenario, then a trade based on that currency pair is not shifted.

• FX Vol Shift: Provides the ability to perform shifts on the foreign exchange option implied
volatility surface. You can specify an absolute parallel shift or a percentage parallel shift
across the entire volatility surface.

Mortgages Allows you to perform scenario analysis on the main factors of the Bloomberg Prepayment
Model (BPM) for mortgage instruments. For example, you can analyze the Prepayment
Speed, where you can enter an override value to shift the estimated rate at which mortgagors
pay off their loans ahead of schedule.

CUSTOM IR CURVE SHIFTS

When creating a factor model231  or full valuation232  scenario in the Scenario Manager, you can set up a custom shift for
interest rates in the IR tab. Custom shifts apply an absolute shift, percentage shift, or override to the currency curves selected
in the IR tab, based on custom values you enter at the terms on the curve.

To create a custom curve shift:

1. In the Swap Curve Shift or Treasury Curve Shift sub-tab, choose the Currency and Mode for the interest rate shock.

Note:  For more information on setting up interest rate shifts, see step 5 in Factor Model Scenarios.

2. From the Type drop-down field, select Custom.
 

231 Allows you to shock your portfolio by shifting macroeconomic factors, interest rates, foreign exchange rates, and model
factors in a scenario analysis.

232 Allows you to evaluate your portfolio on a forward horizon date by shifting interest rates, option adjusted spreads, credit
curves, and many more variables in a scenario analysis.
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The Curve Shift window appears. The shift or override fields in the Curve Shift window reflect whether you apply an
Absolute Shift, Percent Shift, or Override Value to the curve(s).

3. In the Edit value section, enter the value of the shifts to apply at any term on the curve, then press <Go>.
The Value in table on the right updates to reflect the shifts entered.

4. Choose the interpolation/extrapolation setting for the custom analysis.
The Value in table on the right updates to reflect the method you select.

5. To add the custom curve shift to your scenario, click the Add button.
 

 

The IR tab updates to reflect the added custom shift.

For more information on setting up scenarios, see Historical Scenarios, Factor Model Scenarios, and Full Valuation Scenarios.

EDITING SCENARIOS

You can only edit scenarios for which you have read/write permissions.
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To edit a scenario:

1. In the Scenarios tab, from the Set field, select Edit / Create New....
 

 

The Scenario Manager screen appears.

Note:  For more information on the Scenario Manager, see Scenario Manager.

2. In the Scenario Repository, select the group where the scenario you want to edit resides.
Your selection is shaded in blue and associated scenarios appear in the Scenario Group Details section.

3. Click the info icon (i) to the right of the scenario you want to edit.
The Scenario Details section appears and displays the details of the scenario.

4. Edit the tabs and parameters (e.g., Stress FX Rates, Propagation) as outlined in Historical Scenarios, Factor Model
Scenarios, or Full Valuation Scenarios, based on your analysis needs. Depending on whether the scenario uses the factor
model or full valuation methodology, your options vary.

COPYING SCENARIOS

You can copy individual scenarios that you and members of your firm have created.

To copy a scenario:

1. In the Scenarios tab, from the Set field, select Edit / Create New....
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The Scenario Manager screen appears.

Note:  For more information on the Scenario Manager, see Scenario Manager.

2. In the Scenario Repository, select the group where the scenario you want to copy resides.
Your selection is shaded in blue and associated scenarios appear in the Scenario Group Details section.

3. Click the info icon (i) to the right of the scenario you want to copy.
 

 

The Scenario Details section appears and displays the details of the scenario. You can click through the tabs to see
corresponding information.

4. From the toolbar, select Actions > Save As.
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The Scenario Details window appears.

5. Enter the name of the new scenario in the Name field and choose a group where the scenario should be added, then click
the Save button.
 

 

The scenario saves, and the Scenario Manager screen appears. The new copy of the scenario appears at the end of the list
of scenarios in your selected group.

DELETING SCENARIOS

You can only delete scenarios for which you have read/write permissions.

To delete a scenario:

1. In the Scenarios tab, from the Set field, select Edit / Create New....
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The Scenario Manager screen appears.

Note:  For more information on the Scenario Manager, see Scenario Manager.

2. In the Scenario Repository, select the group where the scenario you want to delete resides.
Your selection is shaded in blue and associated scenarios appear in the Scenario Group Details section.

3. Click the info icon (i) to the right of the scenario you want to delete.
The Scenario Details section appears and displays the details of the scenario.

4. From the toolbar, select Actions > Delete.
 

 

The Delete Scenario window appears.

5. Click the Delete button.
The scenario is removed from the Scenario Manager.
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EDITING SCENARIO GROUPS

You can only edit scenario groups that you have created.

To edit a scenario group:

1. In the Scenarios tab, from the Set field, select Edit / Create New....
 

 

The Scenario Manager screen appears.

Note:  For more information on the Scenario Manager, see Scenario Manager.
2. In the Scenario Repository section, click the group that you want to edit.

Your selection is shaded in blue and associated scenarios appear in the Scenario Group Details section.
3. From the toolbar, select Edit > Edit Scenario Group.

The scenarios available to that group appear.
4. Update the group:

• To change the name of the group, enter the new name in the Name field.
• To add a scenario to the group, select the corresponding checkbox(es).

5. From the toolbar, select Actions > Save.
Your changes to the scenario group are saved.

COPYING SCENARIO GROUPS

You can copy an entire group of scenarios that you and members of your firm have created.

To copy a scenario group:

1. In the Scenarios tab, from the Set field, select Edit / Create New....
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The Scenario Manager screen appears.

Note:  For more information on the Scenario Manager, see Scenario Manager.

2. In the Scenario Repository, select the scenario group you want to copy.
Your selection is shaded in blue and associated scenarios appear in the Scenarios section.

3. From the toolbar, select Actions > Copy.
 

 

The copy of the group appears in the My Scenario Groups list in the repository. You can click the group to access the
corresponding scenarios.

DELETING SCENARIO GROUPS

You can only delete scenario groups you have created.

To delete a scenario group:
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1. In the Scenarios tab, from the Set field, select Edit / Create New....
 

 
The Scenario Manager screen appears.

Note:  For more information on the Scenario Manager, see Scenario Manager.
2. In the Scenario Sets section, select the group that you want to delete.

Your selection is shaded in blue and associated scenarios appear in the Scenarios section.
3. From the toolbar, select Actions > Delete.

 

 
The Delete Scenario Set window appears.

4. Click the Yes button.
The scenario group is removed from the Scenario Manager.

REPORTING



>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //258

CREATING REPORT TEMPLATES

You can create and save custom report templates that allow you to mix and match information from any of PORT's tabs into
one report. You can create custom templates from scratch or begin with a standard Bloomberg template.

To create and save a report template:

1. From the toolbar, select Actions > Create/Edit Templates.
 

 
The Edit Report Template window appears. Existing saved report templates appear under Personal Templates.

2. In the Available Sections list, select the tabs or sub-tabs (e.g., VaR > Main View) that you want to include in your report,

then click the add ( ) icon. You can preview a tab prior to adding it to the report by clicking the report image in the
Selected Sections list.
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Note:  You can also build your template from a standard Bloomberg report by selecting a report from the Generate
Report (Bloomberg) section, then modifying the tab organization. For more information on Bloomberg reports, see Using
Bloomberg Reports.

3. You can modify the selected tabs:
• To edit the reporting options for a tab in the Selected Sections list, click the edit icon. Some examples of reporting

options include choosing the type of chart that appears in the report, selecting how data is sorted, or entering a custom
timeframe for the report analysis.
 

 
|Hint| The edit icon only appears for tabs that can be modified.

The Edit (Tab Name) window appears. Modify any of the reporting indicators, then click Update.
•

To remove a tab from the Selected Sections list, click the delete ( ) icon.

The tab is automatically removed from the list.
4. In the Template field, enter a name for the template, then select the output type (PDF or Excel).

 

 
5. To choose how exceptions how treated in the report, click the Report Notices drop-down menu and select from the

show/hide options.
 

 
|Hint| An exception is a security that is not covered by PORT analytics.

6. Click the Save Template button (for a new template) or the Save Template As button (for a new template based on an
existing template).
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The template appears on the left in the Personal Templates list.

7. To launch the report, click the Generate Report button.
The report generates in the format specified.

Note:  For information on accessing saved reports, see Accessing Custom Reports.

ACCESSING CUSTOM REPORTS

You can access custom report templates created and saved within the Edit Report Template window.

To access the saved template, from the toolbar, select Actions > Generate Report (Custom) > (Template Name).
 

 

The report generates.

Note:  If your report template includes a chart or a sorting order that uses a field not present in the View you are using,
a Warning appears with options: 1) Generate the report anyway, 2) Edit the template to remove the problem field, or 3)
Close (so you can add the field to the view and then re-run the report).
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DEFINITIONS

Term Definition

# of Instruments In the Characteristics and Holdings tabs, displays a count of the number of instruments
in the portfolio and benchmark. You can use this field as a quick check to ensure that all
of your holdings are properly uploaded in the portfolio and represented in PORT.

#Pos In the VaR Comparison sub-tab, displays the number of positions (securities) covered
in the VaR comparison analysis.

% Contribution to VaR Measures how much of total risk can be attributed to a particular factor/group.
Contribution to Risk is expressed in percentage points so that Total Risk sums up to
100%.

% Gross Weight The current gross exposure of the instrument or grouping divided by the total current
gross exposure of the portfolio, expressed as a percentage.

% of Total Notional Exposure The current Notional value of the instrument or grouping divided by the total current
notional value of the portfolio, expressed as a percentage.

% Weight (+/-) The relative market value of the portfolio/sectors in percentage terms. Calculated as
%Wgt (Port) - %Wgt (Bench).

% Weight (Bench) The market value of the benchmark/sectors in percentage terms.

% Weight (Port) The market value of the portfolio/sectors in percentage terms.

%Bmrk In the Holdings - Allocation Summary, sub-tab, the benchmark weight in the sector.

%Contrib In the Factor Transparency screen, the percentage of the overall portfolio riskiness
contributed by the factor for the selected Relative to Matrix as of date.

%Port In the Holdings - Allocation Summary, sub-tab, the portfolio weight in the sector.

+/- The difference between the portfolio and the benchmark.

Action Allows you to minimize or maximize an optimization goal (tied to Field).

Active Exposure (Absolute) The absolute value of the active return's sensitivity.

Active Return The difference between portfolio return and benchmark return. If you are using the
Geometric Method:

Active return = 100 * [(1 + portfolio return / 100) / (1 + benchmark return / 100) - 1]

Active Risk Expressed as the standard deviation of portfolio active returns. Active risk is also
known as tracking error.

Aggregation Methodology Allows you to determine the method by which instrument values are aggregated at the
position and portfolio levels. For a description of the weighted average aggregation
method, see Index Method Aggregation.

Aggregation Weights Allows you to determine how aggregations of the specific field are weighted. If you
select Gross, the market values of all instruments are added together to calculate the



>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //262

Term Definition

aggregate; if you select Net, the market values of all instruments are divided by the
position exposure, then summed to calculate the aggregate.

Allocation In the Attribution Summary sub-tab, the active return attributed to asset allocation
decisions (e.g., sectors, countries, or market caps) that differ from the benchmark. The
Allocation is generally positive when the fund is overweight for a sector in which the
benchmark return exceeds the total benchmark return.

Allocation Effect The active return attributed to asset allocation decisions (e.g., sectors, countries, or
market caps) that differ from the benchmark. The allocation is generally positive when
the fund is overweight for a sector in which the benchmark return exceeds the total
benchmark return.

Alpha A coefficient of the Capital Asset Pricing Model which measures risk-adjusted
performance, factoring in the unsystematic risk rather than market risk (systematic risk).
This provides an indication of how the portfolio has performed after accounting for the
systematic risk. Intercept of the regression line of the portfolio and benchmark daily
returns over the stated timeframe.

Analytic The liquidity risk calculation selected for your portfolio analysis within the
Characteristics-Liquidity Risk sub-tab. For descriptions of each available view, see
Liquidity Risk.

Annualization The rescaling into annual terms of a total return or risk measure that has been evaluated
over some timeframe. Annualization is typically used only when the original timeframe is
greater than one year. Total return and return attribution measures are annualized based
on a 365 calendar day factor. Risk measures, such as Standard Deviation (Annualized)
and Sharpe Ratio, are annualized in accordance with the periodicity of the calculation
and the number of trading periods in one year. This number is 261 when the periodicity
is daily, 52 when the periodicity is weekly, 12 when the periodicity is monthly, etc. For
example, a Standard Deviation (Annualized) based on a daily periodicity is calculated
as Standard Deviation * SQRT(261).

As Of The date for analysis. If the date is set to today, the analysis is based on current
position's with the previous day's closing prices. Analysis may be backdated up to 90
days.

Asset Class In the Tracking Error sub-tabs, allows you to filter factors by asset class.

Average Regarding aggregation methods: The simple mean of the instruments' values without
consideration for the weight of each instrument in the portfolio or sector grouping.

Avg Difference The average of the total winning or losing return periods over the selected period.

Avg Sequence The average number of positive or negative return periods for the fund occurring
sequentially.

Bear Alpha A coefficient of the Capital Asset Pricing Model which measures risk-adjusted
performance, factoring in the unsystematic risk rather than market risk (systematic risk).
This provides an indication of how the portfolio has performed after accounting for the
systematic risk. Intercept of the regression line of the portfolio and benchmark daily
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returns over the stated timeframe, only using the days on which the benchmark return
was negative.

Bear Beta A coefficient of the Capital Asset Pricing Model which measures systematic risk. A
beta greater than 1 is more volatile than the benchmark, while a beta less than 1 is less
volatile. Slope of the regression line of the portfolio and benchmark daily returns over
the stated timeframe, only using the days on which the benchmark return was negative.

Bear Capture Ratio A measure of how well the portfolio is performing relative to the benchmark. Defined as
the ratio of the portfolio return to the benchmark return, calculated only using the days
when the benchmark return was negative and averaged over the selected timeframe.

Bear Correlation Correlation coefficient between the portfolio and the benchmark daily returns over the
stated timeframe, only using the days on which the benchmark return was negative.
Ranges between -1.0 and 1.0.

Bear Information Ratio A risk-adjusted measure that calculates the excess return over the benchmark, per unit
of tracking error volatility. [Annualized Bear Mean Excess Return / Annualized Tracking
Error]. The higher the Information ratio, the better. It measures the consistency with
which the portfolio is beating the benchmark. Calculated using daily returns over the
stated timeframe, only using the days when the benchmark return was negative.

Bear Jensen Alpha A risk-adjusted measure that calculates the actual return of the portfolio over and
above the return predicted by the Capital Asset Pricing Model (CAPM), given the
portfolio's beta and the benchmark return. [Portfolio Return - (Risk Free Rate + Beta x
(Benchmark Return - Risk Free Rate))]. Calculated using the annualized mean of daily
returns of the portfolio and benchmark over the stated timeframe, only using the days
when the benchmark return was negative.

Bear Mean Excess Return
(Annualized)

The average daily relative total return over the stated timeframe, only on days when the
benchmark return was negative, annualized and expressed as a percentage.

Bear R-Squared A measure of how well the portfolio's performance correlates with the performance
of the benchmark, and thus a measure of what portion of its performance may be
explained by the performance of the benchmark. Values for R-Squared range from 0
to 1, where 0 indicates no correlation and 1 indicates perfect correlation. Calculated
using daily returns over the stated timeframe, only using the days on which the
benchmark return was negative.

Bear Sortino Ratio Vs. Index A risk-adjusted measure that calculates the excess return over the benchmark, per
unit of semivariance (volatility of negative returns). [(Annualized Bear Mean Excess
Return) / Annualized Semivariance of Returns]. The higher the Sortino ratio, the better
the portfolio's historical risk-adjusted performance. Calculated using daily returns over
the stated timeframe, only using the days when the benchmark return was negative.

Bear Tracking Error
(Annualized)

The standard deviation of the daily excess returns relative to the benchmark over the
stated timeframe, only on days when the benchmark return was negative, expressed as
an annualized percentage.

Benchmark Exposure The benchmark's sensitivity to a given factor.

Benchmark Exposure (Absolute) The absolute value of the benchmark's sensitivity.
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Benchmark Return In the Attribution Summary sub-tab, the total return percentage of the benchmark over
the specified timeframe.

Beta In the Characteristics and Intraday tabs, the security's adjusted beta, which is derived
by default from the past two years of weekly prices as of the analysis date (you can
override the calculation timeframe when adding the field to the tab). Each security's
default index is used for the beta calculation. At the sector and portfolio levels, beta is
calculated using the weighted average aggregation methodology.

Beta (ex-post) A coefficient of the Capital Asset Pricing Model which measures systematic risk. A
beta greater than 1 is more volatile than the benchmark, while a beta less than 1 is less
volatile. Slope of the regression line of the portfolio and benchmark daily returns over
the stated timeframe.

Bmrk Indicates the benchmark against which you are comparing your portfolio, which can be
an index, portfolio, or fund.
• In the Characteristics - Characteristics Summary sub-tab, the benchmark indicator

value.
• In the View Manager, allows you to choose which fields appear in the benchmark

column (for each tab).

Breakdown by Determines the classification by which your portfolio is broken down (segmented), such
as country of origin, industrial sector, and market capitalization.

Bull Alpha A coefficient of the Capital Asset Pricing Model which measures risk-adjusted
performance, factoring in the unsystematic risk rather than market risk (systematic risk).
This provides an indication of how the portfolio has performed after accounting for the
systematic risk. Intercept of the regression line of the portfolio and benchmark daily
returns over the stated timeframe, only using the days on which the benchmark return
was positive.

Bull Beta A coefficient of the Capital Asset Pricing Model which measures systematic risk. A
beta greater than 1 is more volatile than the benchmark, while a beta less than 1 is less
volatile. Slope of the regression line of the portfolio and benchmark daily returns over
the stated timeframe, only using the days on which the benchmark return was positive.

Bull Capture Ratio A measure of how well the portfolio is performing relative to the benchmark. Defined as
the ratio of the portfolio return to the benchmark return, calculated only using the days
when the benchmark return was positive and averaged over the selected timeframe.

Bull Correlation Correlation coefficient between the portfolio and the benchmark daily returns over the
stated timeframe, only using the days on which the benchmark return was positive.
Ranges between -1.0 and 1.0.

Bull R-Squared A measure of how well the portfolio's performance correlates with the performance
of the benchmark, and thus a measure of what portion of its performance may be
explained by the performance of the benchmark. Values for R-Squared range from 0
to 1, where 0 indicates no correlation and 1 indicates perfect correlation. Calculated
using daily returns over the stated timeframe, only using the days on which the
benchmark return was positive.
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Bull Information Ratio A risk-adjusted measure that calculates the excess return over the benchmark, per unit
of tracking error volatility. [Annualized Bull Mean Excess Return / Annualized Tracking
Error]. The higher the Information ratio, the better. It measures the consistency with
which the portfolio is beating the benchmark. Calculated using daily returns over the
stated timeframe, only using the days when the benchmark return was positive.

Bull Jensen Alpha A risk-adjusted measure that calculates the actual return of the portfolio over and
above the return predicted by the Capital Asset Pricing Model (CAPM), given the
portfolio's beta and the benchmark return. [Portfolio Return - (Risk Free Rate + Beta x
(Benchmark Return - Risk Free Rate))]. Calculated using the annualized mean of daily
returns of the portfolio and benchmark over the stated timeframe, only using the days
when the benchmark return was positive.

Bull Mean Excess Return
(Annualized)

The average daily relative total return over the stated timeframe, only on days when the
benchmark return was positive, annualized and expressed as a percentage.

Bull Sortino Ratio Vs. Index A risk-adjusted measure that calculates the excess return over the benchmark, per
unit of semivariance (volatility of negative returns). [(Annualized Bull Mean Excess
Return) / Annualized Semivariance of Returns]. The higher the Sortino ratio, the better
the portfolio's historical risk-adjusted performance. Calculated using daily returns over
the stated timeframe, only using the days when the benchmark return was positive.

Bull Tracking Error (Annualized) The standard deviation of the daily excess returns relative to the benchmark over the
stated timeframe, only on days when the benchmark return was positive, expressed as
an annualized percentage.

by Allows you to analyze your portfolio and benchmark broken down by various
classification schemes, such as by country/region, industry sector, long/short, and
currency. You can also set a default classification for the view you are customizing. You
do not, however, have to choose a classification.

Note:  For more information on breaking down your portfolio analysis by classifications,
see Selecting Classifications.

Capture Ratio A measure of how well the portfolio is performing relative to the benchmark. Defined as
the ratio of the portfolio return to the benchmark return, calculated on a daily basis and
averaged over the selected timeframe.

Cashflow The cash flow for the portfolio attributed to the scenario as of the horizon date.

Closing Market Value The value of your investment in or exposure to an instrument as of the previous market
close, calculated as your position in that instrument multiplied by its closing price
multiplied by the exchange rate. At the sector and portfolio levels, this is the sum of the
market values of the individual instruments.

For a portfolio with short positions, market value at the portfolio level is calculated as
the total market value of long positions minus the total market value of the shorts, plus
cash and any margin set aside to cover the shorts.

CLvl See Confidence Level.

Component Table Displays the formula components corresponding to the Descriptor.
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Conditional VaR Abbreviated as CVaR in the VaR tab. Measures the expected loss in the underlying
currency of the portfolio when the confidence level is surpassed. This measure of tail
risk is also called Expected Shortfall.

For VaR methodologies Monte Carlo and Historical, the average of the P&L generated
for each scenario located in the tail of the distribution is used. This can be expressed in
P&L and % terms. If expressed in percentage, the conditional VaR in P&L is divided by
the active/ difference portfolio market value at that node.

Confidence Level A measure of the degree of confidence for a random variable of interest. A confidence
interval of X is defined as the probability that, given the underlying distribution of the
random variable, the set of possible outcomes lies in a range greater than or equal to a
pre-determined value. For example, a confidence level of 95% means that you are 95%
confident that the portfolio will be subject to no more than the maximum loss indicated
by the VaR computation.

Constraint Field In the Setup tab of the Portfolio Optimization screen, specifies which fields should be
constrained by the optimizer to generate your optimal portfolio.

Constraint Level In the Setup tab of the Portfolio Optimization screen, specifies the set of securities
for which the field should be calculated when determining constraints. Portfolio-level
constraints will set boundaries on top-level values calculated for the entire optimal
portfolio. You can also specify constraints that only apply to values aggregated up to
the group-level, using many of the most popular breakdowns available in PORT.

Contribution % In the Tracking Error Factors and Risk Bets tabs, the factor contribution to active risk.
Contribution to active risk displays the tracking error decomposition into components
that add up to the overall portfolio tracking error. Contribution to risk is expressed as a
percentage of active risk.

Contribution to Active Risk Percentage of risk attributed to the factors.

Contribution to Risk Used to determine a fraction of risk that a particular factor/factor group contributes to
total risk. Contribution to Risk (%) is expressed in percentage points so that Total Risk
sums up to 100%.

Contribution to Risk (%) Used to determine a fraction of risk that a particular factor/factor group contributes to
total risk. Contribution to Risk (%) is expressed in percentage points so that Total Risk
sums up to 100%.

Convexity The second derivative of a security's price with respect to its yield, divided by the
security's price. A security exhibits positive convexity when its price rises more for a
downward move in its yield than its price declines for an equal upward move in its yield.

Correlation Correlation coefficient between the portfolio and the benchmark daily returns over the
stated timeframe. Ranges between -1.0 and 1.0.

Correlation Matrix In the Factor Transparency screen, displays a matrix of correlation between related
factors from the specified Relative to Matrix as of date.

Country of Jurisdiction Allows you to choose the tax jurisdiction of the investor when calculating portfolio and
benchmark returns:



>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>> PORTFOLIO & RISK ANALYTICS (PORT)
     

Date printed: 01/06/2015 WHAT IS PORTFOLIO & RISK ANALYTICS (PORT)? //267

Term Definition

• International: Takes the position that the investor is not entitled to tax imputation
credits offered to domestic Australian and New Zealand investors. For Australian
stocks, international investors do not receive franking credits and hence they are
not included in the gross dividend calculation. Franked dividends are not further
taxed when calculating net of tax total returns.

• Australia: The franking credit percentage as stated by the company is added back
to the declared dividend. The formula to obtain the franked up gross dividend is:
Gross = Declared Amt (net) * (1 + (Frank % / (1 - Tax Rate)) - Frank %)

• New Zealand: The gross dividend is obtained by adding to the net dividend
(declared amount) received by investors the tax credit as declared by the company.
For New Zealand stocks, the gross dividend includes the net amount plus the
bonus amount. For more information, see DVD <Go>.

• NZ & Australia: Includes both the Australian franking credit and the New Zealand
tax credit in the return calculations.

Note:  Data on tax credits, franking percentage, and tax rates can be seen on the
Dividend/Split Summary (DVD) function for the relevant dividend. For more information,
see DVD <Help>.

Country Tax Rate The highest tax rate an institutional foreign investor pays in a specific country.

CTR (+/-) Calculated as CTR (Port) – CTR (Bench).

CTR (Bench) Contribution to return of the security or grouping in the benchmark. This can generally
be interpreted as the total return of every instrument multiplied by its weight in the
benchmark. The sum of CTR (Bench) for all instruments is equal to the Total Return of
the benchmark.

CTR (Port) Contribution to return of the security or grouping in the portfolio. This can generally
be interpreted as the total return of every instrument multiplied by its weight in the
portfolio. The sum of CTR (Port) for all instruments is equal to the Total Return of the
portfolio.

Cumulative In the Factor Transparency screen, displays a line chart representing the total
cumulative return of the selected factor over the specified timeframe.

Cumulative CF In the Cash Flow Summary sub-tab, the running total of all cash flows received over
the period.

Currency Generally, Currency indicates the currency of the portfolio being analyzed. In the
Attribution Summary sub-tab, Currency indicates the active return due to currency
exposures that differ from the benchmark.

Currency Effect The active return due to currency exposures that differ from the benchmark.

Current Ratio (+/-) Calculated as Current Ratio (Port) – Current Ratio (Bench).

Current Ratio (Bench) The current ratio for the benchmark sector/security.

Current Ratio (Port) The current ratio for the portfolio sector/security.

Custom Name Allows you to override the name of a column that appears in your portfolio.

bbg://screens/DVD
bbg://screens/HELP DVD
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CV Delta Measures how much the value of a convertible changes with the underlying stock price
calculated at constant firm volatility. This field is especially used in the Characteristics
Main View sub-tab.

Debt/Equity (+/-) Calculated Debt/Com Equity (Port) – Debt/Com Equity (Bench).

Debt/Equity (Bench) The debt to common equity ratio for the benchmark sector/security.

Debt/Equity (Port) The debt to common equity ratio for the portfolio sector/security.

Decimal Allows you to select the number of decimal places to display in a selected column.

Depositary Receipts Pricing If the Use Underlying Price for Receipts option is selected, the underlying equivalent
price is calculated by multiplying the price of the underlying ticker by the receipt ratio.
The receipt ratio represents the number of underlying shares represented by one
receipt. If the underlying share is unlisted, not actively traded, or a receipt ratio is
unavailable, the receipt price continues to be used. If the underlying is not trading on a
particular day due to a holiday (for example), the underlying price from the previous day
is carried forward.

If the underlying pricing is used, the currency of the receipt will be in the underlying
share currency.

Descriptor Name Displays the Descriptors that are used to calculate the Factor Exposures.

Descriptor Table The Descriptors used to calculate the Factor.

Display In the Tracking Error Exposures sub-tab, allows you to filter the factor exposures that
appear, such as market or industry.

Div Yld The dividend yield of the security. This is another dimension of value, but is also distinct
in its behavior, which is why Bloomberg separates it, so that it remains a standalone
factor.

Div Yld (+/-) Calculated as Div Yield (Port) – Div Yield (Bench).

Div Yld (Bench) The dividend yield of the benchmark sector/security.

Div Yld (Port) The dividend yield of the portfolio sector/security.

Dividend Yield The dividend yield of the portfolio or benchmark sector/security.

Downside Risk (Annualized) Volatility of the daily returns that are lower than the mean return over the stated
timeframe, expressed as an annualized percentage. Whereas Standard Deviation is
calculated using all the returns, Downside Risk is calculated using only the returns
below the mean. Larger values suggest greater risk.

Drifting Weight In Trade Simulation, indicates the percentage (%) weights drift with changes in the
market each day. No rebalancing assumptions are made.

Duration The first order derivative measurement of the sensitivity of bond price to changes in
interest rate. In general, the higher the duration, the more sensitive the bond price is
to interest rate movements. Duration is calculated by holding the base case option
adjusted spread (OAS) constant while the par swap curve is shifted up or down 25
bps and the price is recomputed.
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Duration Times Spread (DTS) Duration Times Spread is the contribution to spread duration of a bond multiplied by
its option adjusted spread (OAS). By combining the spread level (OAS) of a bond
with its contribution to spread duration, the DTS exposure is a recognition of the
significant positive correlation between spread levels and spread volatility - bonds
with higher spreads have higher spread volatility. The DTS exposure is utilized in the
Risk tabs in PORT (VAR, Tracking Error, Factor-based Scenario Analysis) to measure
the spread exposure for fixed income instruments and is also an available field in the
Characteristics tab.

EarnVariab Analyzes how consistent the earnings, cash flows, and sales have been based on the
last several years of data.

End In trend analysis mode, the date you want to end analysis.

EQY_FUND_TICKER Specifies the ticker to access equity fundamental data for a company. The price data of
the fundamental ticker is used to compute most financial ratios which combine market
data and equity fundamental data. If a company has several listings/tickers, Bloomberg
selects the fundamental ticker based on listing dates, country of domicile, and liquidity.

Exposure A portfolio's, security's, or benchmark's sensitivity to a given risk factor.

Extra Precision Enables you to display more precise values (i.e., include more decimals).

Factor The indicator, or factor type, by which risk is measured.

Factor (+/-) In the Tracking Error Main View tab, the relative factor risk. Factors display risk factor
exposures (factor betas), as well as factor level risk statistics.

Factor Contribution to Active
Risk

The tracking error decomposition into components that sum up to the overall portfolio
tracking error. Contribution to risk expressed as a percentage of active risk.

Factor Exposure The sensitivity of your portfolio to the market. Factor exposure is also known as factor
beta.

Factor Group A factor group is a list of related factors grouped together. Depending on the risk
model that is used, the following factor groups are available:

• Market

• Style

• Industry

• Country

• Currency

Factor Marginal Risk Marginal Risk is the value by which the portfolio tracking error increases for a small
increase in exposure to a given factor, assuming that all other portfolio exposures
remained the same.

Factor Model Allows you to shock your portfolio by shifting macroeconomic factors, interest rates,
foreign exchange rates, and model factors in a scenario analysis.

Factor Vol In the Factor Transparency screen, the daily factor volatility for the selected Relative to
Matrix as of date.
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Field In trend analysis mode, the field for trend analysis. For example: # (PORT), % Wgt (+ /
-), or Mkt Val (+ / -).

Filter In the Cash Flow Summary sub-tab, allows you to filter cash flows by the currency in
which they are paid.

Fixed Weight In Trade Simulation, indicates positions are valued with a set percentage (%) weight.
This weight is rebalanced at the market close each day back to the original weight. The
default overall market value of the portfolio is 100,000,000. Fixed weights remain fixed
until you update them.

Freq Allows you to choose the frequency for trend and period analyses (Daily, Weekly,
Monthly, etc.).

Full Valuation Allows you to evaluate your portfolio on a forward horizon date by shifting interest rates,
option adjusted spreads, credit curves, and many more variables in a scenario analysis.

Fund from Cash Uses cash holdings in the portfolio to purchase the target quantity of each security as
specified in the editable column in the grid in the Add/Edit Trade Simulation Holdings
window. If the total of all targets in the portfolio exceeds the value of the portfolio, the
cash position is negative to maintain the market value of the portfolio. Analytics refresh
using the new Trade Simulation portfolio holdings.

Fund from Holdings Sells off portfolio holdings to purchase the target quantity of each security, as specified
in the Add/Edit Trade Simulation Holdings window. Securities are sold off based on
current market weight, heaviest first. If the target holdings are lower than previous
holdings, securities are purchased to compensate. Analytics refresh using the new
Trade Simulation portfolio holdings.

Graph In the Cash Flow Summary sub-tab, allows you to analyze a chart of cash flow
projections for the timeframe specified.

Graph Type In the Cash Flow Summary sub-tab, allows you to choose the cash flow payments that
appear on the chart or table. The options are:

• Interim Only: Displays only the periodic payments produced by the instrument, i.e.,
projected dividends for equities and coupons for fixed income.

• Principal Only: Displays only the principal payments produced by the instrument.
• Cash flow (Total): Displays the sum of the interim and principal cash flows for each

period.
• Cash flow (Cumulative): Displays the running total of the interim and principal cash

flows received over each period.

Gross Active Weight An absolute value of the portfolio weight for a security minus its benchmark weight.

Group By In the Tracking Error-Factors sub-tab, allows you to filter factors by the factor groups
that appear in the Summary sub-tab: All Factors, Market, Style, Industry, or Greeks.

Note:  For multi-country equity models, style factor exposures for multi-country risk
models are neutralized within a given country. For more information on factor models,
see Documents.
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Growth In the Tracking Error Exposures tab, based on historical and forward-looking
fundamental data from analysts trying to capture distinction between high- and
low-growers.

Hide zero exposures In the Tracking Error tab, allows you to show or hide factors with zero exposure values.

Histogram In the Factor Transparency screen, displays a histogram illustrating returns attributed to
the selected factor over the specified timeframe.

History A bar chart that displays historical trends for selected Factors.

Holdings As Of The last date your portfolio positions were updated, which appears at the bottom of
the Main View in every PORT tab. For public funds, the latest filing date for that fund
appears.

Horizon • In the Tracking Error Summary , refers to how the risk numbers are scaled. For
example, if Time Horizon is set to one year, the risk statistics are annualized.

• In the VaR Main View, the risk forecast in number of business days. Bloomberg
calculates a one-day VaR and scales that number by multiplying it by the square
root of the number of business days to include additional timeframes.

• In the Scenarios tab, allows you to analyze scenarios over several timeframes: one
day, one week, one month, or one year.

Hurdle Rate In the Attribution tab, the return of the benchmark in local currency. This is a key
component in the calculation of Allocation Effect. Optionally, if attribution is calculated
with Currency Effect embedded, then the Hurdle Rate is the benchmark return in the
portfolio currency. Hurdle Rate is represented in the Benchmark Total Return (Local
Currency) column in the Attribution tab.

in Allows you to choose the currency in which the portfolio and benchmark are compared.
By default, the currency under analysis is the portfolio base currency. For a complete
list of currencies, see CURR <Help>.

Inc Security Inclusion. Allows you to select securities/sectors to include in a rebalancing
scenario. Unchecked securities cannot be targeted and do not change in a sector-level
rebalance, or in a rebalance funded from holdings.

Index Method As an aggregation method, Index Method is available only for certain equity fields, such
as price ratios and growth ratios. With the Index Method, calculation of the aggregate
Price to Earnings ratio includes companies with negative earnings.

Information Ratio A risk-adjusted measure that calculates the excess return over the benchmark, per unit
of tracking error volatility. [ Annualized Mean Excess Return / Annualized Tracking Error
]. The higher the Information ratio, the better. It measures the consistency with which
the portfolio is beating the benchmark. Calculated using daily returns over the stated
timeframe.

Interaction Effect The interaction between the weighting and the selection effects, which does not
represent an explicit decision of the investment manager.

bbg://screens/HELP CURR
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Interim CF In the Cash Flow Summary sub-tab, the periodic income produced by the instrument.
For equities, this is a projected dividend; for fixed income, this is a coupon payment.

Isolated Risk (Std) The standard deviation of the distribution of returns, expressed as either a percentage
return or portfolio profit and loss (P&L). This measure represents portfolio risk
(expressed as the standard deviation of portfolio returns) or active risk (expressed as
the standard deviation of portfolio active returns).

Issuer Constraint Ensures that no single issuer has the weight of greater than Max value (default is 10%)
in the optimal portfolio.

Jensen Alpha A risk-adjusted measure that calculates the actual return of the portfolio over and
above the return predicted by the Capital Asset Pricing Model (CAPM), given the
portfolio's beta and the benchmark return. [ Portfolio Return - ( Risk Free Rate + Beta
x ( Benchmark Return - Risk Free Rate ) ) ]. Calculated using the annualized mean of
daily returns of the portfolio and benchmark over the stated timeframe.

Key Rate A measurement of the sensitivity of the portfolio to a single basis point shift at a
specific rate.

Kurtosis Kurtosis measures the peakedness or flatness of the daily return distribution over the
stated timeframe. In a flat distribution, the average value is more likely to occur.

Level In the Best & Worst sub-tab, allows you to choose to view the best or worst performing
sectors or positions against scenarios.

Leverage A composite metric of different measures of leverage.

Lot Size (Shares) Smallest increment in number of shares traded or held in optimal portfolio.

Marginal Contribution Sensitivity of active risk for small changes in active exposure.

Marginal (X100) The factor marginal risk multiplied by 100. This is the value by which the portfolio
tracking error increases for a 1% increase in the weight of a portfolio holdings
subgroup.

Marginal VaR Measures the impact of a one hundred currency unit change in the position within the
portfolio. For example, if the portfolio is denominated in U.S. dollars, Marginal VaR is
based on a one hundred dollar change.

Market Value Last The current value of your investment in or exposure to an instrument, calculated as
your position in that instrument multiplied by its current price multiplied by the current
exchange rate. At the sector and portfolio levels, this is the sum of the market values of
the individual instruments.

For a portfolio with short positions, market value at the portfolio level is calculated as
the total market value of long positions minus the total market value of the shorts, plus
cash and any margin set aside to cover the shorts.

Max In the Setup tab of the Portfolio Optimization screen, specifies a maximum constraint in
order to shape your optimal portfolio.

Max Sequence The maximum number of positive or negative return periods for the fund occurring
sequentially. For example, if the fund experiences a streak of nine days in a row of
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positive returns followed by one down day, and if this streak represents the most
number of days in a row of positive returns during the specified period, this value is the
Max Sequence.

Maximum The highest individual value in the portfolio or sector grouping.

Maximum Drawdown The largest drop from a peak to a bottom in a sub-period over the stated timeframe. It
measures the magnitude of the worst loss an investor could have incurred by investing
in the portfolio or benchmark.

Maximum Drawdown Length The length in days between the peak and the bottom of the maximum drawdown over
the stated timeframe.

Maximum Increase The largest gain from a bottom to a peak in a sub-period over the stated timeframe. It
measures the magnitude of the best gain an investor could have incurred by investing
in the portfolio or benchmark.

Maximum Range The earliest date in the portfolio that contains valid positions. The Maximum Range
timeframe option is available in the Attribution, Performance (Total Return, Period
Analysis, and Statistical Summary sub-tabs), and the Trends view in the Holdings and
Characteristics tabs.

Fixed income and balanced portfolios are limited to analysis no earlier than Dec 31,
2010. If you have included a benchmark, the shorter of the portfolio and benchmark
maximum ranges is used.

AIM Analytics customers have the additional option to set an Inception Date for each
account in the Analytics tab in the Accounts setup screen of the Firm Setup Manager
(FIRM) function. This Inception Date is used as the Start date when Maximum Range is
selected in PORT. For more information on FIRM, see FIRM <Help>.

Maximum Recovery Period The sum of maximum drawdown length and recovery period from maximum drawdown
over the stated timeframe.

Maximum Relative Drawdown The largest drop relative to the benchmark from a peak to a bottom in a sub-period over
the timeframe. It measures the magnitude of the worst relative loss an investor could
have incurred by investing in the portfolio vs. the benchmark.

Maximum Relative Drawdown
Length

The length in days between the peak and the bottom of the maximum relative
drawdown over the stated timeframe.

Maximum Relative Recovery
Period

The sum of maximum relative drawdown length and recovery period from maximum
relative drawdown.

Maximum Return The highest one-day total return over the stated timeframe, expressed as a percentage.

Mean The average of the Descriptor.

Mean Excess Return
(Annualized)

The average daily relative total return over the stated timeframe, annualized and
expressed as a percentage.

Mean Return (Annualized) The average daily total return over the stated timeframe, annualized and expressed as a
percentage.

bbg://screens/HELP FIRM
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Median The midpoint of the range of numbers that are arranged in order of value.

Methodology In the Tracking Error Trends sub-tab, allows you to specify ex-ante risk options: Current
Portfolio, Historical Risk, or Historical Risk (X100) (historical risk multiplied by 100).

Min In the Setup tab of the Portfolio Optimization screen, specifies a minimum constraint in
order to shape your optimal portfolio.

Minimum The lowest individual value in the portfolio or sector grouping.

Minimum Return The lowest one-day total return over the stated timeframe, expressed as a percentage.

MktVal (Port) The current market value of the portfolio.

Model • In the Tracking Error Summary and Trends sub-tabs, refers to multi-factor risk
model that is used to estimate the portfolio, benchmark, and active risk values. The
model version is the date on which the model was generated.

• In the VaR and Scenarios tabs, the risk model you want to apply to your portfolio,
typically the smallest geographical region that covers the holdings in your portfolio.

For more information on Bloomberg's risk factor models, see Documents.

Model Date The iteration of the risk model.

Modified Duration A measurement of the percentage change in price for a given change in yield.

Momentum Differentiates between stocks that have risen over the past year from those that fell.

Mondigliani RAP Modigliani Risk-Adjusted Performance measures how much the portfolio would have
returned if it had had the same risk as the benchmark. It is a linear transformation of the
Sharpe Ratio, but the results are expressed in terms of performance for more intuitive
interpretation. The higher the indicator, the better. Calculated using daily returns over
the stated timeframe.

MV In the VaR Comparison sub-tab, displays the VaR comparison analysis coverage by
market value.

News Heat A measure of the amount of stories currently being published on a company relative
to the flow over the previous 45 days. The data is updated in realtime. The greater the
number of bars, the more news that is being generated for that instrument.

Notional The value of the underlying asset. The notional represents the market value for
non-derivative instruments. The notional value of an options is the delta adjusted
underlying value while for a future it is the contract value.

Notional Exposure The current value of the underlying asset. For an option, notional exposure is the
delta-adjusted underlying value (calculated as number of contracts * contract size *
option delta * underlying asset price), while for a future it is the contract value. For
non-derivative instruments, the current market value is displayed.

Notional Weight The notional value of the instrument divided by the sum of the notional values of all
securities in the portfolio.

Notional Weight (Leveraged) The notional value of the instrument divided by the market value of the portfolio.
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Number On the Performance-Period Analysis sub-tab, the number of up/down or
winning/losing periods, in terms of fund return, during the analysis time frame.

Number of Buys The number of portfolio positions bought.

Number of Sells The number of portfolio positions sold.

Option Adjusted Convexity
(OAC)

A measurement of the convexity of the bond considering embedded options (e.g.
dynamic cash flows due to change rates).

Option Adjusted Duration (OAD) A measurement of the bond duration considering embedded options (e.g., dynamic
cash flows due to change rates).

Option Adjusted Spread
Duration (OASD)

A measurement of the sensitivity of price to a one percent change in option adjusted
spread.

Option Adjusted Spread (OAS) The option adjusted spread. The flat spread that must be added to the yield curve in a
pricing model to discount a security payment to match its market price.

Original The original value of the individual Descriptor's Factor Exposure.

Override N/A Values Allows you to specify a value to appear in place of N/A for a specific field. This ensures
that positions with N/A values, which were previously dropped from the aggregate, are
now included in the aggregation using that value.

P&L The portfolio's current profit or loss position. P&L is calculated as the portfolio's current
value – the portfolio's value at the prior market close.

P&L % In the Scenario Summary sub-tab, the profit or loss generated on the portfolio (or
active portfolio if a benchmark is selected) in the stated portfolio currency expressed as
a percent of market value, given the applied scenario.

P/B (+/-) Calculated as P/B Ratio (Port) – P/B Ratio (Bench).

P/B (Bench) The P/B ratio for the benchmark sector/security.

P/B (Port) The P/B ratio for the portfolio sector/security.

P/CF (+/-) Calculated as P/CF (Port) – P/CF (Bench).

P/CF (Bench) The P/CF ratio for the benchmark sector/security.

P/CF (Port) The P/CF ratio for the portfolio sector/security.

P/E (+/-) Calculated as P/E Ratio (P) – P/E Ratio (B).

P/E (Bench) The P/E ratio for the benchmark sector/security.

P/E (Port) The P/E ratio for the portfolio sector/security.

P/E Ratio The price/earnings ratio for the portfolio or benchmark sector/security.

Partial VaR Measures the impact of removing an entire position or aggregation (e.g., the entire
financial sector) on the overall portfolio VaR. This can be measured in P&L units
or in %. If viewed in percent, the partial VaR expressed in P&L is divided by the
active/difference portfolio's market value at that particular node.
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Participation Rate The percentage of the average or median daily volume of your position that you are
willing to expose into the market.

Per In the Cash Flow Summary sub-tab, allows you to specify the periodicity and
timeframe of the cash flow projection. The periodicity can be daily, monthly, quarterly,
semi-annually, and annually.

Pick Percentile In the VaR Distribution sub-tab, allows you display different scenarios for a selected
percentile (e.g., 2.5%).

Port In general, Port indicates the portfolio being analyzed. The portfolios are created and
maintained in PRTU and BBU. For more information, see PRTU <Help> and BBU
<Help>. In the Characteristics - Characteristics Summary sub-tab, however, Port
indicates the weight value of the portfolio.

Portfolio Beta A number describing the relation of its returns with that of the benchmark. If the
benchmark is up 10% and your portfolio beta is 1.2, your portfolio is expected to be up
12%. Portfolio Beta is calculated as the ratio of the covariance between the portfolio
and benchmark and the variance of the benchmark. If no benchmark is selected,
Portfolio Beta is set to zero.

Portfolio Beta (ex-ante) A number describing the relation of returns of portfolio and benchmark.

Portfolio Exposure The portfolio's sensitivity to a given factor.

Port Exposure (Absolute) The absolute value of the portfolio's sensitivity.

Portfolio Return In the Attribution - Attribution Summary sub-tab, the total return percentage of the
portfolio over the specified timeframe.

Pos (Port) The number of shares held on the portfolio security.

Position In the Best & Worst sub-tab allows you to choose to see the best or worst scenarios in
relation to GICS sector or securities.

Price Close (Port) The closing price of the portfolio security.

Principal CF In the Cash Flow Summary sub-tab, the notional repayment of the instrument. This
represents the redemption of the instrument either through maturity or call.

Principal Value Principal Value, also known as the clean Market Value, represents the current market
value of a bond excluding the accrued income. Principal = par amount * clean price.

Profit In the Tracking Error - Exposures tab, analyzes profit margins and measures such as
ROE to differentiate between money makers and money losers.

Profit & Loss The estimated amount earned or lost on positions held in the portfolio over the stated
timeframe, as of the date of analysis. P&L is calculated using end of day prices and is
expressed in the portfolio currency.

R-Squared A measure of how well the portfolio's performance correlates with the performance
of the benchmark, and thus a measure of what portion of its performance may be
explained by the performance of the benchmark. Values for R-Squared range from 0
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to 1, where 0 indicates no correlation and 1 indicates perfect correlation. Calculated
using daily returns over the stated timeframe.

Raw Data Displays the individual Components that comprise the Descriptors.

Recovery Period from Max
Drawdown

The length in days between the bottom of the maximum drawdown and a value equal to
or greater than the peak.

Recovery Period from Max
Relative Drawdown

The length in days between the bottom of the maximum relative drawdown and a value
equal to or greater than the peak.

Relative In the Setup tab of the Portfolio Optimization screen, specifies whether the
corresponding constraint is calculated relative to another portfolio, benchmark, or
nothing (none).

Relative to Matrix as of In the Factor Transparency screen, the date for the factor transparency data
calculation.

Relative Total Return Portfolio Total Return - Benchmark Total Return over the stated timeframe, expressed
as a percentage.

Relative Total Return % Portfolio Total Return - Benchmark Total Return over the stated timeframe, expressed
as a percentage.

Relative VaR The maximum expected relative loss of the portfolio vs. the benchmark, expressed as
a percentage. VaR here is calculated using the natural distribution of daily returns over
the stated timeframe and is based on a 95% confidence level.

Relative VaR Gaussian The maximum expected relative loss of the portfolio vs. the benchmark, expressed
as a percentage. Standard VaR is calculated using the natural distribution of daily
returns over the stated timeframe and is based on a 95% confidence level. By contrast,
Gaussian VaR is calculated using the mean daily return and standard deviation to
normalize the distribution of returns.

Reporting Currency The currency used in the analysis, as indicated by the selection in the Curr drop-down
menu of any Main View sub-tab. By default, the currency under analysis is the portfolio
base currency.

Reporting Units Indicates either Returns or P&L.

Residual (+/-) In the Tracking Error Main View tab, the relative residual risk.

Return (x100) In the Factor Transparency screen, the latest return for the factor for the selected
Relative to Matrix as of date. The return frequency is daily for VaR and weekly for
tracking error.

Return Calculation Type Allows you to choose your taxation calculation method:

• Gross: No tax is taken out of dividends included in return calculations.
• Net: The withholding tax is based on the country of domicile of the company, and is

taken out of the dividend in the return.
• Portfolio Gross / Bench Net: Calculates gross returns for the portfolio versus net

of tax returns for the benchmark.
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Return on Cash Allows you to determine how the portfolio handles the return on cash for foreign
investments:

• None: Excludes return on cash in the local currency for the portfolio.
• Portfolio Fixed Rate: Uses the rate of return specified for the portfolio in the

Creating & Updating Portfolios (PRTU) function.
• Pre-Defined Money Market Program: Simulates an investment in a money market

instrument to see a return on cash in your portfolio analysis. For information on
pre-defined money markets, see Return on Cash.

Note:  When setting up the portfolio in PRTU, the Return on Cash field allows you to
enter a fixed rate of return on foreign cash investments for the portfolio.

Risk Expressed as the standard deviation of portfolio returns and is used as a gauge for the
portfolio's expected volatility.

Risk Factor Vol (Std %) In the Tracking Error Factors sub-tab, the factor volatility expressed as the standard
deviation of return.

Risk Marginal (x100) In the Tracking Error Risk Bets sub-tab, the factor marginal risk multiplied by 100. This
is the value by which the portfolio tracking error increases for a 1% increase in the
weight of a portfolio holdings subgroup.

Risk Model See Model.

Risk (Tot. Active Std %) In the Tracking Error Risk Bets tab, the factor-isolated active risk expressed as the
standard deviation of return.

Rule When optimizing a portfolio, allows you to set the rule that applies to the trade
universe. The following options are available:

• No Trade List: A list of securities in your portfolio that you do not buy or sell (trade).
• No Sell List: A list of securities in your portfolio for which you do not reduce

weights (cannot sell).
• No Buy List: A list of securities in your portfolio for which you do not increase

weights (cannot buy).
• Liquidate (No Hold): Sets security weights to zero.
• No Short: A list of securities you cannot have short.
• No Long: A list of securities you cannot have long.

Sector The industry sector.

Security List The destination portfolio, equity index, benchmark, or favorite source, depending on the
Source selection.

Selection Effect The active return attributed to security selection decisions that differ from the
benchmark. When the portfolio sector returns exceed the benchmark return, a positive
number is posted.
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Semivariance (Annualized) Volatility of the daily returns that are lower than the mean return over the stated
timeframe, expressed as an annualized percentage. Whereas Standard Deviation is
calculated using all the returns, Semivariance is calculated using only the returns below
the mean. It aims to isolate the negative portion of volatility. Larger values suggest
greater risk.

Set The set (group) within which your scenario resides. Bloomberg Stress Scenarios
provides a default set of stress scenarios.

Set Outlier Maximum Allows you to set a maximum value for a specific field. If an instrument exceeds the
maximum value, it value is excluded from the calculation of the portfolio aggregate.

Set Outlier Minimum Allows you to set a minimum value for a specific field. If an instrument does not meet
the minimum value, it is excluded from the calculation of the portfolio aggregate.

Shares / Par Amount In Trade Simulation, indicates position values are defined explicitly by the number of
shares in each security.

Sharpe ratio A risk-adjusted measure that calculates the excess return over the risk free rate
(3-month yield linked to the currency), per unit of volatility. [(Annualized Mean Return
- Risk Free Rate) / Annualized Standard Deviation of Returns]. The higher the Sharpe
ratio, the better the portfolio's historical risk-adjusted performance. Calculated using
daily returns over the stated timeframe.

Show Allows you to show the valuation columns calculated for all scenarios in the set or for
one scenario as selected in the adjacent field.

Size In the Tracking Error Exposures tab, an aggregate metric distinguishing between large
and small stocks.

Skewness Skewness measures the degree of asymmetry of the daily return distribution over the
stated timeframe. If the left tail (tail at small end of the distribution) is more pronounced
than the right tail (tail at the large end of the distribution), the return is said to have
negative skewness. If the reverse is true, it has positive skewness. If the two are equal,
it has zero skewness.

Sortino Ratio Vs Index A risk-adjusted measure that calculates the excess return over the benchmark, per
unit of semivariance (volatility of negative returns). [(Annualized Mean Excess Return) /
Annualized Semivariance of Returns]. The higher the Sortino ratio, the better the
portfolio's historical risk-adjusted performance. Calculated using daily returns over the
stated timeframe.

Sortino Ratio Vs Riskfree A risk-adjusted measure that calculates the excess return over the benchmark, per
unit of semivariance (volatility of negative returns). [(Annualized Mean Excess Return) /
Annualized Semivariance of Returns]. The higher the Sortino ratio, the better the
portfolio's historical risk-adjusted performance. Calculated using daily returns over the
stated timeframe.

Source The source of trades you want to optimize, either Portfolio, Equity Index, Favorites, or
Benchmark.

Spread Change The change in OAS implied by the instruments excess return and OAS spread
duration. For credit default swaps, this represents the change in the underlying
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CDS spread and is calculated using the excess return (as shown from the seller of
protections perspective).

Standard Dev The standard deviation of the Descriptor.

Standard Deviation
(Annualized)

A measure of the volatility of the daily total returns over the stated timeframe, expressed
as an annualized percentage. It measures how widely spread the daily returns are
within the period. Larger values suggest greater risk.

Standardized The standardized value of the individual Descriptor's Factor Exposure.

Start In trend analysis mode, the date you want to begin analysis.

Status Indicates whether the optimization request is pending, failed, or a success.

Stress MV In the Scenario Summary sub-tab, the new market value of the portfolio (or active
portfolio if a benchmark is selected) taking into account any profit or loss generated,
given the applied scenario.

Table In the Cash Flow Summary sub-tab, allows you to analyze a table of cash flow
projections for the timeframe specified.

Target Price Display Type Allows you to select how you want the target price data for your custom field to
appear. If you select Price, the field displays the target price you entered in or
uploaded to the custom data field. If you select Difference, the field displays the
difference between your custom target price and the most recent closing price for the
instrument, i.e., custom target price - last close. If you select Percentage Difference,
the field displays the percentage difference between your custom target price and the
most recent closing price.

Time In trend analysis mode, the timeframe for the analysis (e.g., month-to-date [MTD] or
year-to-date [YTD]).

Timeframe In the Factor Transparency screen, allows you to select the date range illustrated in the
transparency chart.

Time Horizon Refers to how the risk numbers are scaled. For example, if Time Horizon is set to one
year, the risk statistics are annualized. For VaR, Bloomberg calculates a 1-day VaR and
scales that number to include other times frames.

Time Series In the Factor Transparency screen, displays a bar chart illustrating the weekly positive
and negative returns attributed to the selected factor over the specified timeframe.

Total Active Risk The standard deviation of portfolio active returns.

Total CF In the Cash Flow Summary sub-tab, the sum of the Interim CF and Principal CF
payments.

Total Return The total return over the stated timeframe as of the date of analysis, expressed as a
percentage.

Total Return % The total return over the stated timeframe as of the date of analysis, expressed as a
percentage.
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Total Risk Total risk is broken down into the Factor and non-factor groups. Factor groups are
model-specific.

Tracking Error Tracking errors are annualized volatilities of active returns, expressed in percentages.
Tracking error on security level shows the contribution to the portfolio level tracking
error. This would be the annualized volatility x (relative) weight x correlation. It is
important to keep in mind that there is a difference between the total tracking error and
the security level track error.

Total track error is the standard deviation of the active portfolio (which is the portfolio
minus the benchmark), and it can never be negative. However, when the tracking
error is shown broken up in securities or sectors, what is actually shown is a marginal
contribution to tracking error. Then, the security level tracking error shows how
sensitive is the total tracking error when increasing a given position. Usually that
number is positive: increasing a given position would make the returns of the portfolio
less alike the returns of the benchmark, thus increasing the total track error.

It can happen due to correlations, however, that increasing a position will make the
portfolio more similar to the benchmark (decreasing the tracking error). In that case, the
security contribution to tracking error would be negative.

Tracking Error (Annualized) The standard deviation of the daily excess returns relative to the benchmark over the
stated timeframe, expressed as an annualized percentage. It is used as a measure of
the quality of benchmark tracking.

TradeAct A turnover-based measure. Bloomberg focuses on turnover instead of trading volume
to avoid its correlation with size since ideally descriptors should be independent from
each other in the cross-section.

Trade-Off In the Setup tab of the Portfolio Optimization screen, the Trade-Off field defines how
different goal and constraint fields are evaluated relative to each other. The trade-off
can be understood in two contexts:

• Multiple Goal Terms: As an example, specifying two goal terms may look like:

— Minimize Active Total Risk (Unit: %, Trade-off = 0.2)
— Maximize Current Ratio (Unit: number, Trade-off = 1)
This means that a .2% increase in Active Total Risk is worth the same as an
increase of 1.0 in Current Ratio, and vice-versa.

• Soft Constraints: In the context of constraints, the trade-off applies to the value in
excess of the minimum and maximum bounds specified. As an example:

— Goal: Maximize Current Ratio (Trade-off = 1)
— Constraint: Active Total Risk (Maximum = 10, Trade-off = 0.5)
This means that every 0.5% that Active Total Risk goes above 10% is worth an
increase of 1 in Current Ratio. If trade-off is not specified for a constraint, then the
constraint can never be violated.

Trades Value The combined market value of the trades.
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Transaction Return The active return attributable to trading above or below a day's closing price. Reported
in local currency.

Treynor Measure A risk-adjusted measure that calculates the excess return over the risk free rate
(3-month yield linked to the currency), per unit of Beta relative to the benchmark.
[(Annualized Mean Return - Risk Free Rate) / Beta]. The higher the Treynor ratio, the
better the portfolio's historical risk-adjusted performance. This is useful for assessing
the excess return from each unit of systematic risk. Calculated using daily returns over
the stated timeframe.

Turnover The value of simulated buys plus the value of simulated sells excluding cash, divided by
the original portfolio value. This is expressed in percentage terms.

Note:  Turnover is only available within Trade Simulation and Portfolio Optimization.
In Trade Simulation mode, Turnover appears at the bottom of each tab's Main View
sub-tab. In Portfolio Optimization, Turnover can be used as either a goal or a constraint
in the Optimization Setup, and the resulting Turnover value appears on the Trades
results tab after the Optimization task has been run.

Turnover (%) The turnover, in percentage terms, incurred from the initial portfolio to the optimal
portfolio.

Unexplained In the Indicators column of the Tracking Error Factor P&L sub-tab, this indicator is used
to reconcile the difference between PORT's daily calculation of Total Active Return and
the weekly calculation of Factor and Non-Factor Return numbers.

UCITS Rule (5 sum 40 rule) The UCITS rule ensures that the sum of issuer weights greater than the specified
threshold is not greater than the Max value (default is 40%).

Unit In the VaR and Tracking Error tabs, the units to display potential portfolio loss, which
may be displayed as either a market value (P&L) or percentage return (Return %).

Use Underlying Price for
Receipts

The option for Depositary Receipts Pricing. If selected, the underlying equivalent price
is calculated by multiplying the price of the underlying ticker by the receipt ratio. The
receipt ratio represents the number of underlying shares represented by one receipt.
If the underlying share is unlisted, not actively traded, or a receipt ratio is unavailable,
the receipt price continues to be used. If the underlying is not trading on a particular
day due to a holiday (for example), the underlying price from the previous day is carried
forward.

If the underlying pricing is used, the currency of the receipt will be in the underlying
share currency.

Value The value of specific components. In various tables, this is the percentage weight of
the security in the portfolio.

InTracking Error Exposures , a composite value metric that differentiates between “rich”
and “cheap” stocks. Bloomberg combines fundamental and analyst consensus data for
this factor.
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Value at Risk Abbreviated as VaR. Measured in currency units or as a % of market value, VaR
measures the maximum loss projected given inputs for the time horizon and confidence
level. The can be measured on the portfolio, benchmark, or active/difference portfolio.

Value of Buys The buy values associated with the Trades Value (in the reporting currency).

Value of Sells The sell values associated with the Trades Value (in the reporting currency).

VaR Measured in currency units or as a % of market value, VaR measures the maximum loss
projected given inputs for the time horizon and confidence level. VaR can be measured
on the portfolio, benchmark, or active/difference portfolio.

VaR% VaR divided by portfolio market value. For leveraged portfolios, such as long-short or
portfolios with derivative instruments, portfolio VaR can be greater than the portfolio
market value, and thus greater than 100%.

VaR (ex-post) The maximum expected loss of the portfolio, expressed as a percentage. VaR here is
calculated using the natural distribution of daily returns over the stated timeframe and is
based on a 95% confidence level.

VaR Gaussian The maximum expected loss of the portfolio, expressed as a percentage. Standard VaR
is calculated using the natural distribution of daily returns over the stated timeframe and
is based on a 95% confidence level. By contrast, Gaussian VaR is calculated using the
mean daily return and standard deviation to normalize the distribution of returns.

VaR Ratio Measures the ratio of the portfolio's VaR in the underlying currency with the benchmark
VaR as the same underlying currency. A ratio of 2 would indicate that the portfolio VaR
is twice as large as the benchmark VaR. This measure will only display if a benchmark is
selected, despite it being included in the existing view.

VCV Matrix In the Factor Transparency screen, displays a matrix of variance/co-variance values
between related factors from the specified Relative to Matrix as of date.

Version The dated version of the portfolio under analysis.

View The fields to display for the scenario, either all fields for a specific scenario or a single
field for all scenarios.

Volatility In the Tracking Error Exposures sub-tab, distinguishes between more volatile and less
volatile stocks by measuring volatility from several different angles.

Volume History The length of trade history used to calculate the median or average volume.

vs Indicates the benchmark against which you are comparing your portfolio, which can
be an index, portfolio, or fund. You can create and maintain custom benchmarks in the
Creating/Updating Portfolios (PRTU) function. For more information on using PRTU to
maintain benchmarks, click here .

Waterfall A hierarchy of sources used to specify the priority of pricing sources you want to
use. For each day in the analysis, instruments are priced by checking for a price
from the first source in the hierarchy. If not found, the next price source on the list is
checked. The process continues until a price is found. For historical analysis such as
performance attribution, PORT looks back up to 10 business days to find prices for the
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start date of the analysis. From that day forward, if the price source hierarchy fails to
find a price for a given day, the last known price is carried forward.

Weight % The weight of the Descriptor used to calculate the Factor Exposure.

Weight Bounds (%) In the Portfolio Optimization screen, the portfolio weights in the optimal portfolio
between a specified range (minimum and maximum).

Weighted Average The mean of the instruments' values weighted by the market value weight of each
instrument in the portfolio or sector grouping. If any instrument is missing the value
(shows "blank" or N/A), that instrument is excluded from the aggregate calculation.

Weighted Harmonic Average The reciprocal of the weighted average of reciprocal values. For example, the harmonic
weighted average of P/E is calculated as [1 / (Weighted Average of E/P)]. This option is
sometimes preferred to Weighted Average for price ratios, because it prevents excess
weighting of higher values.

Workout Conv In the Cash Flow Summary sub-tab, allows you to choose the cash flow projection
methodology, which provides an assumption as to when you are going to recover your
principal. The options are:

• To Worst: Selects a workout date that produces the worst yield based on the price
of the bond. The date may be a maturity or call date.

• To Next Call: Assumes the bond is called at its next call date.
• To Maturity: Assumes the bond is called on its maturity.
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